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1. Welcome to Revoice Pro 5
Toggle navigation
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Welcome to Revoice Pro 5

 

Click Here for PDF Version of this Revoice Pro Manual
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What is Revoice Pro ?
Revoice Pro is a revolutionary and unique audio processing program for manipulating audio signals'

time, pitch and loudness.

It is designed to work primarily with voice and monophonic instruments but may be tried creatively to

work with other types of audio signals.

It provides the main unique processes listed below.

Match

Automatically, gives a target audio signal (Dub) the selected timing, pitch and/or loudness

characteristics of a "Guide" audio signal.

Match is powered by the most advanced version of VocALign.

Realistic Doubler
Instantly creates natural-sounding double tracks from one input signal. It can also provide creative time

and pitch modulation effects.

Adjust

Provides fast and easy-to-use manual and automatic tools to change the timing and pitch of voice or

monophonic instrument recordings with unbeatable quality and transparency.

What is Revoice Pro used for?
Revoice Pro is designed to reduce hours of tedious manual editing of audio signals' timing, pitch, vibrato

or loudness and create extremely high-quality results in a fraction of the normal time.

Applications include:

· Automatically creating "tight" double (or multiple) tracks from multiple takes

· Modifying the inflection of spoken phrases from one actor's takes to match another take or

even a different actor

· Creating one or more realistic double tracks from a single input track

· Tightening the time and pitch of "stacks" of lead and harmony parts in a fraction of the

time previously required
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Stand-alone, not a plug in!
Revoice Pro has been deliberately developed as a program and not a plug-in, because there are

significant speed and operational advantages over the restrictions of plug-in environments. These

advantages include providing:

· The ability to implement multi-input processes.

· A novel and effective “region-based processing" approach to audio processing in which

inputs to processing modules are inserted where required along the timeline in Process

Control Tracks.

· A simple, intuitive control of an “process-based preview” system for rapidly auditioning

combinations of input and output signals and quality checking modifications.

· Multiple processes with different parameters can use the same tracks for inputs and/or

outputs.

· Processes for audio signal manipulation can be more powerful and more controllable.

· A consistent working environment inside Revoice Pro for audio from any DAW.

 

Check for the latest updates of this manual and software.

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.
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2. What's New

Next

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.
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3. Getting started
Toggle navigation

Revoice Pro 4.3 Help
·

· Contents

· Index

· Search

If you're new to Revoice Pro, we recommend checking out the video below. If you prefer, we've placed a

few useful links below the video.

If you're new to Revoice Pro

Welcome to Revoice Pro introduces the features and purposes of the application.

Visit our quick online introductions to using Revoice Pro with supported DAWs.

Introduction gives an overview of the major topics covered in this user guide.

Quick Start will explain in very basic terms how you can begin using Revoice Pro, with links to relevant

topics.

Workflows needs to be looked at, to determine the best way to get audio in and out of Revoice Pro, in

your working situation.

Processes will explain Revoice Pro's powerful automatic time, pitch and level alignment algorithms, and

how to use them
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Getting started with specific DAWs
The links below will take you to DAW-specific introductions and resources on the Synchro Arts website.

Ableton Live

Adobe Audition CC

Bitwig

Cubase

Cubase Elements

Cubase LE

Digital Performer

Final Cut Pro

FL Studio

Logic Pro

Logic Pro X

Nuendo

Pro Tools

Pyramix

Reaper

Reason

Samplitude
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SONAR PROFESSIONAL

Sony Vegas

Studio One Professional

If you do not see your DAW / Editor listed here, you might find it is compatible using audio import and

export methods described for other DAWs in videos and User Manuals. If you do find methods that work

with unlisted DAWs, please let us know by contacting us here.

Next

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.
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4. Introduction
Introduction

This User Guide is structured under a number of major topics that explain the principal features and

operations of Revoice Pro.

Introduction

Information to get you started, together with a Quick Start overview. This section explains the different

ways you can get help using Revoice Pro, explains some conventions used in this Guide, and tells you

how to contact us for support or anything else.

Audio setup, monitoring and playback

How to set up the audio monitoring, play audio, set up rendering options and deal with mutes and solos.

Also Playback Ranges.

Sessions, tracks and files

An introduction to Revoice Pro's Session window, menus, track operations, templates and file locations.

Workflows

How to get audio into and out of Revoice Pro, either stand-alone, or in conjunction with various DAWs.

Processes

How to use Revoice Pro's powerful automatic processes for manipulating audio signals' time, pitch and

loudness.

Manually adjust timing, pitch and level

How to do detailed manual edits of time, pitch and loudness.

Keyboard shortcuts and operations summary

How to use and customise keyboard shortcuts
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Topics in this section:

Getting help

Software installation

Software authorization

Quick Start

Preferences

Contact and support information

Trademarks and notices

Control devices

Previous                     Next

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.
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4.1. Getting help

Introduction » Getting help

There are four sources of help:

This User Guide
Topics in the Contents at the left can be clicked to present individual sections describing the selected

topic. Opening each major heading will show the sub-headings of that topic.

Topics in this section: links to major headings in that section

Related topics: other topics in the user guide and externally that may be relevant

In application pop-ups
Brief item-dependent explanations of main controls and areas in the Revoice Pro application will

automatically appear by positioning the cursor over an item in the Revoice Pro program and waiting a

second.

Shortcut keys are also documented within the application itself, and can be modified.

Tutorial videos
On-line videos are being created and updated to help users quickly understand the general and detailed

operation of Revoice Pro.

Links to videos are identified in this manual using the icon.

Go to the Synchro Arts YouTube channel to see numerous explanations of how to use the application in

a variety of creative situations.

Synchro Arts website
There is a comprehensive collection of downloads, tips and tricks for using Revoice Pro with different

DAWs on the Synchro Arts website.

https://www.youtube.com/@synchro_arts
https://www.youtube.com/@synchro_arts
https://www.youtube.com/@synchro_arts
https://www.youtube.com/@synchro_arts
https://www.youtube.com/@synchro_arts
https://www.youtube.com/@synchro_arts
https://www.youtube.com/@synchro_arts
http://www.synchroarts.com/compatibility/editors
http://www.synchroarts.com/compatibility/editors
http://www.synchroarts.com/compatibility/editors
http://www.synchroarts.com/compatibility/editors
http://www.synchroarts.com/compatibility/editors
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Previous        Next
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4.2. Software installation and authorisation

· License Overview

· How to Redeem your Synchro Arts product (if you obtained via a third party)

· How to activate your Synchro Arts plug-in

License Overview

· You can obtain trial Licenses for any Synchro Arts

product from www.SynchroArts.com or purchase perpetual (non-expiring) from

Synchro Arts directly or its resellers.

· Trial licenses will run the software fully-functional for the number of days stated

in the information provided with the licence.

· Each license includes 2 activations

· All licenses will authorise both macOS and Windows versions

Please note: Previously the PACE iLok system was used to license Synchro Arts

products but iLok was replaced with a new and easier system in April 2024.

If you already own Synchro Arts products that were activated before April 2024 with

iLok and would like to download the latest builds, please create an account and login

to the Synchro Arts website and connect your iLok account. This will add your products

to your Synchro Arts website account and then you can follow the activation steps

below.

https://www.synchroarts.com/
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How to Redeem your Synchro Arts product (if you

obtained via a third party)

If you obtained your Synchro Arts product from a third party, you will need to redeem

your product before you can begin the activation process. 

1. Start by copying your Synchro Arts product redeem code

2. Go to redeem.synchroarts.com which will ask you to sign up / login before

you can proceed

3. Once logged in, you will be prompted to redeem your product 

https://redeem.synchroarts.com/
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4. Paste your redeem code and click the ‘Redeem’ button

5. Success! Your product should now show being visible in your Synchro Arts

account 
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6. Didn’t work for you? Contact the Synchro Arts’ support team. 

How to activate your Synchro Arts plug-in

1. Download the relevant installer for your Synchro Arts product.

The latest version(s) of the product(s) you own will always be available in your account

on the Synchro Arts website.

https://synchroarts.zendesk.com/hc/en-us
https://synchroarts.zendesk.com/hc/en-us
https://synchroarts.zendesk.com/hc/en-us
https://synchroarts.zendesk.com/hc/en-us
https://synchroarts.zendesk.com/hc/en-us
https://synchroarts.zendesk.com/hc/en-us
https://synchroarts.zendesk.com/hc/en-us
https://synchroarts.zendesk.com/hc/en-us
https://synchroarts.zendesk.com/hc/en-us
https://synchroarts.zendesk.com/hc/en-us
https://synchroarts.zendesk.com/hc/en-us
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2. Click the 'Copy' button next to your product license in your Synchro Arts account or

select and copy the license key

3. Install your Synchro Arts product

When you run the installer on your Mac or PC, it will install the Revoice Pro application

and the following link plug-ins:

· AAX (Audio Suite) for Pro Tools

· VST3 and VST3 (ARA) for Cubase, Nuendo, Studio One, Ableton Live and other

DAWs supporting VST3 plug-ins

· AU (Audio Units) and AU (ARA) for Logic Pro X and other DAWs supporting AU

plug-ins
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4. Launch the Revoice Pro application

5. Click the 'Paste' button as shown below and your license key should appear in the

box, then click 'Activate'
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6. Congratulations, Revoice Pro should now be activated and ready to use
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4.3. Quick Start

Introduction » Quick Start

The following is a very basic guide to the steps needed to get started with Revoice Pro. Step-by-step

guides are included in each of the linked sections.

The below video includes an overview of Revoice Pro's newest functionality as well as descriptions of

common workflows. Continue down this page for some useful links, including DAW specific guides.

The first port of call should be our quick online introductions to using Revoice Pro with supported DAWs.

· Make sure you have installed and authorised Revoice Pro.

· Revoice Pro is a stand-alone program started by double-clicking on its program icon.

o Revoice Pro will first open showing an empty three-track Session.

· Choose what means of audio monitoring you want to use.

· Load audio into Revoice Pro, either by one of the DAW-specific methods, importing files in

stand-alone mode, or using a DAW Link Plug-in.

· Process the audio by creating and running one of Revoice Pro's Processes.

o Right click in the Process Control Track of an audio track that will form the basis for the

Process, or press B on your keyboard if your audio is already selected

o Select a New Match/Doubler/Adjust/etc either from the contextual menu or the New

Process window, depending on the process you want to apply        

o Check/set the input/output tracks of the Process and whether or not multiple processes

will be applied, using the New Process window

o Create the New Process, by pressing New Process in the Process Control Panel, or N

on your keyboard, which will generate the processed audio block in the selected output

track(s)

· Play back the processed audio to listen and check it.

· Adjust the Process if necessary by using its Process Control Panel.

· Export the audio from Revoice Pro, either as a file, or directly to your DAW.

http://www.synchroarts.com/compatibility/editors/Revoice%20Pro+5
http://www.synchroarts.com/compatibility/editors/Revoice%20Pro+5
http://www.synchroarts.com/compatibility/editors/Revoice%20Pro+5
http://www.synchroarts.com/compatibility/editors/Revoice%20Pro+5
http://www.synchroarts.com/compatibility/editors/Revoice%20Pro+5
http://www.synchroarts.com/compatibility/editors/Revoice%20Pro+5
http://www.synchroarts.com/compatibility/editors/Revoice%20Pro+5
http://www.synchroarts.com/compatibility/editors/Revoice%20Pro+5
http://www.synchroarts.com/compatibility/editors/Revoice%20Pro+5
http://www.synchroarts.com/compatibility/editors/Revoice%20Pro+5
http://www.synchroarts.com/compatibility/editors/Revoice%20Pro+5
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Next
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4.4. Preferences

Introduction » Preferences

Various preferences for audio processing, file locations, display colours and editing are set in the

Preferences control panel.

Select Revoice Pro > Preferences...  from the main menu at the top of your screen when Revoice Pro is

the active application. You will see this window:



Revoice Pro 5 Manual Publication8

29

General

Audio Processing
Processing: sets the internal precision of audio signal processing operations to 32 or 64 bit

Output File Format: sets the file format (WAVE or AIFF) of exported audio files, and their resolution

(16/24 bit fixed point, 32/64 bit floating point)

Set Playback Range track to top of window: see Setting screen position of Playback Range track

Audio Output: sets the sound output destination that you want to use with Revoice Pro

Follow DAW Playback: if checked, Revoice Pro playback will follow replay operations on a connected

DAW

Enable Tuning Preview: see Tuning Preview

Centre Horizontal Zoom: when enabled, if the playhead is not visible the zoom function will be centred

about the centre of the display. If not enabled it will be centred around the left hand end of the display

Disable Track Scroll Wheel: when set stops individual tracks from scrolling vertically

Audio Drawing: sets the resolution of audio waveform drawing for different screen types (automatic,

retina or non-retina)

Auto render before playing: toggle automatic rendering of processing before playback

Show Editing Strength: shows a line of varying intensity/opacity at the bottom of a track to show how

much processing is being done to the audio

Automatically Save Sessions: automatically saves sessions periodically

Send Reports to Synchro Arts: sends reports on the features you have used in Revoice Pro. Does not

send any audio.

Create tracks automatically in ARA link plug-ins: automatically creates the tracks needed for plug-in

processes when using ARA link plug-ins with a DAW

Split Audio into Pitch Blocks: this option determines whether the audio waveform gets divided and

moved to match the Pitch Blocks, or remains connected on one horizontal plane.

Show additional processing options: show or hide extra processes (Volume, Analyser) when creating a

new process

Temporary File Location
See Locations of files
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Allows the user to set a specific location for temporary files, or choose automatic and allow Revoice Pro

to use it's default path.

Version
Shows the installed version and the most recent/current version available. Click the 'Update' button to

update when needed. Uncheck the 'Check for updates when the application starts' box if you need to

remain at a specific version.

Colours
On the Colours tab you can set the display colours for various different features and elements displayed

in Revoice Pro. Note this is only available on macOS.
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Editing
On the Editing tab you can set various options that apply when Manually adjust timing, pitch and level.
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Show frequency in Hz: when pitch editing, shows note frequency in Hz as well as musical pitch and

cents

Label Size: 

Anchor on Note Start & End Pitch: determines the point in a note used to reference any tilt or shift in

pitch when editing. See Note Block Controls

Anchor on Note Pitch Center: (default) determines the point in a note used to reference any tilt or shift in

pitch when editing. See Note Block Controls
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4.5. Support information

Introduction » Support information

Please visit this page to submit a support request and our team will get back to you as soon as

possible. 

Next
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4.6. Trademarks and notices

Introduction » Trademarks and notices

Trademarks and notices
Revoice and VocALign are registered trademarks of Synchro Arts Limited.

Pro Tools is a registered trademark of Avid Technology, Inc.

All other trademarks are the property of their respective holders.

Next
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4.7. Control devices

Introduction » Control devices

Control devices
A range of positioning and control devices can be used with Revoice Pro including a mouse with one

button, two-button mouse, Magic Mouse, track pads, track balls etc.

In this Guide, we have used the familiar terms "left click" and "RIGHT CLICK" which might not be

appropriate for the user's control device. What is meant is this:

· Left click - device operation that selects an item

· RIGHT CLICK - device operation that brings up a menu of selectable items in a "short-cut"

or "context-dependent" pop-up window.

For detailed information on your device controls or setting it up, look in any of the following:

· MAC and Windows System Preferences - Mouse

· Mac and Windows Help for "mouse"

· Your control/pointing device in the device's User Guide

 

Next
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5. Audio setup, monitoring and
playback

Audio setup, monitoring and playback
Audio from Revoice Pro can be monitored in various different ways, depending on whether you want to

use the audio outputs connected to your computer or those used by your DAW.

Audio rendering concerns when and how processed audio from Revoice Pro is created and stored in

tracks.

Playback controls determine how and when audio is played back from Revoice Pro.

Track mute and solo determines which tracks will be heard when auditioning from Revoice Pro.

Audio layers allow up to four audio regions to be placed in a stack on any track, with only the top one

being heard.

Playback ranges determine time regions for auditioning, process creation and export.

Next 

Topics in this section:

Audio monitoring

Playback controls

Track mute and solo

Audio layers

Playback ranges

Related topics:

Audio format requirements
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5.1. Playback controls

Audio setup, monitoring and playback » Playback controls

A playback control section is at the bottom of the Revoice Pro window.

From left to right:

· The orange link symbol controls whether or not audio can be transferred from a DAW using one

of theLink Plug-Ins

· The "Start" and "End" displays show the displayed Revoice Pro Session's start and end times.

Rewind control, if ON will make a stopped playback return to start again from where the playback was

last started.

Loop control ON works with a Playback Range set. It will allow the playback to loop within the current

Playback Range.

· The time position of the Playhead can be shown in Time, Samples, Timecode, or Bars & Beats

in the large display window. The display format is controlled by the dropdown selection switch to

the right of the time display. The time position can be manually edited from version 3.2, with the

play head moving to the entered position.

· The Scroll Control Drop down offers No Scroll, Page Scroll, or Continuous Scroll of the Window

relative to the Playhead during playback.

· The Master Volume control adjusts the audition level of the mixed tracks output, or the Tuning

Preview audition level, selected by means of the drop-down.
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If a Playback Range has been created the behaviour of these playback features might be modified and

the playback will generally stay within the defined Playback Range).

When toggled on, the 'Snap to scale' button will cause notes to snap to the selected scale, chosen from

the drop down menu to the right.

Clicking on "Scales..." will open the "Scales Settings menu" shown below.

Its main purpose is to let you add and delete scales in the Active Scales list.
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Positioning playback start
Double clicking in any waveform window will position the “Playhead” (the vertical white line that spans all

the tracks) at the time position of the cursor.

When the Scroll control (see below) is in Continuous Scroll mode, when you Double click the cursor to

position the Playhead to the right of the centre of Revoice Pro's window, it will place the cursor where

you double click, and then immediately move that time position to the centre of the Revoice Pro window.

A useful way to go to the start or end of blocks of audio is to press the Up Arrow or Down Arrow keys.

This will step the playhead backward and forward (respectively) through time-related "events" in the

tracks.

Playing audio
Pressing the keyboard SPACE BAR will toggle between starting and stopping audio playback from all

playback-enabled tracks.
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If any process requires rendering first, that will be done automatically (as long as the "Auto render before

playing" or background processing Preference is active).

Changes to enabled tracks can be made at any time, even while playing, using any of the above

methods.

Following DAW playback
If your DAW is playing, and "Follow DAW" is checked in Preferences, Revoice Pro follows the DAW

playback position, but the DAW does not follow Revoice playback.

Scrubbing
Centring the mouse cursor anywhere over the Playback Position Indicator will change the cursor to a

Scrub Cursor (double yellow arrows). To scrub the playback - hold down the LEFT mouse button and

move the mouse left and right (or use equivalent actions on other input devices).

With other devices, instead of using the scrub cursor, you can scrub by pressing the ALT key and

"swiping" (moving your finger) left and right on the surface of an Apple Magic Mouse or on a trackpad,

using ALT plus moving two fingers left and right.

Next
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5.2. Audio monitoring

Audio setup, monitoring and playback » Audio monitoring

Because Revoice Pro is a stand-alone program, the audio playback needs to be directed to a monitoring

system to be heard.

Revoice Pro can route its stereo mix of enabled tracks in two ways:

· Directly - to audio hardware supported by your computer's operating system.

· Indirectly - by feeding Revoice Pro's stereo output to a track Insert in your DAW (if it

supports RTAS, VST3 or AU insert plug-ins) and routing the output of that track to your

DAW monitor system. This method uses the Revoice Pro Monitor plug-in.

 

Both of these methods can be set up at the same time, but only one at a time can be used, depending

on whether the Monitoring switch, for Revoice Pro Monitor is ON or OFF in Revoice Pro. 

The Audio Output settings are controlled in the Revoice Pro Preferences menu.

Next

Topics in this section:

Audio Monitoring Options Advantages / Disadvantages / Comments
Directly · Simple

· Plays all Revoice Pro audio playback functions:
scrub and loop

· Not slaved to playback in DAW

Indirectly via:
Revoice Pro Monitor Plug-
in

· The output of Revoice Pro is fed to a stereo Insert in
a DAW track which can be routed through the
DAW's audio monitoring hardware.

· Works with Pro Tools HD, Nuendo, Cubase, Logic
Pro, Studio One and other DAW hardware (via
supported RTAS, VST3 and AU inserts).

· If DAW is playing, and "Follow DAW" is checked in
Preferences, Revoice Pro follows the DAW playback
position and replays enabled tracks through the
DAW's audio hardware.

· Revoice Pro Monitor ONLY- When DAW is not
playing, the output of Revoice Pro play, scrub and
looping functions are played through the DAW's
audio hardware.
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Setting audio output options

Revoice Pro Monitor Plug-in
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5.2.1. Setting audio output options

Audio setup, monitoring and playback » Audio monitoring » Setting audio output options

macOS
To set the Directly-connected audio hardware, in the Revoice Pro menu bar, under Revoice Pro, select

Preferences and then the General tab.

The menu similar to that in the first image below should appear and the user can select the Audio Output

Device drop-down menu to chose Built-in Output or other directly connected audio hardware listed as

shown in the second image below (in this example, a Scarlett 18i20 USB is being selected).
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This does NOT apply to Pro Tools HD hardware, for which see Monitoring through Pro Tools HD

hardware.

Set up monitoring via the Revoice Pro Monitor plug-in

 

Windows
To set the Directly-connected audio hardware, in the Revoice Pro menu bar, in the Edit menu, select

Preferences.

The menu similar to that shown below should appear and the user can select the Audio Output drop-

down menu to chose Speakers as shown, or any other directly connected audio hardware that appears

in the list.

Set up monitoring via the Revoice Pro Monitor plug-in

Next 
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5.2.1.1. Monitoring through Pro Tools HD hardware

Audio setup, monitoring and playback » Audio monitoring » Setting audio output options » Monitoring

through Pro Tools HD hardware

There is currently a range of Pro Tools HD audio hardware that does not allow 3rd party audio inputs

when Pro Tools is running. All versions of Pro Tools HD currently do not offer a 'release audio' function.

The DAE engine in HD takes over the computer, and while Pro Tools is open, only allows PT to pass

audio through the Pro Tools hardware.

In this case, using the Revoice Pro Monitor plug-in is a good option, but another option the user can try

is a Digital Audio Link between the Mac and the HD hardware.

Digital Audio Link
(This has been reported working with Pro Tools HD 10.1.2 with HDX hardware and multiple HD

interfaces on a MacPro 2008 8-core running Mac OS 10.7.3).

A simple HOSA TOSlink to AES-converter can be connected between the TOSlink digital output of the

Mac and one of the AES inputs on an AVID HD interface. Also, the sample rate converter on that AES

input can be used to integrate the asynchronous digital output signal of the Mac. Or you can clock the

Mac to a TOSlink SPDIF signal on the digital input (you need to use an "Aggregate device" using just the

stereo digital input and output of the Mac in the AudioMIDI setup of OS X to achieve this). Most lower-

end audio interfaces have a TOSlink SPDIF input.

Then, in Pro Tools you need an open aux input for the stereo AES input signal.

[Thanks to Tobias Eichelberg for this information]

Next
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5.2.2. Revoice Pro Monitor plug-in

Audio setup, monitoring and playback » Audio monitoring » Revoice Pro Monitor plug-in

You can listen to Revoice Pro's playback through Pro Tools, VST3 or Logic (AU)-based DAW hardware.

The Preferences control panel contains a "Follow DAW Playback" checkbox. If this is checked Revoice

playback will start and follow the DAW in sync whenever the DAW is played. If turned off, Revoice replay

will not follow the DAW.

The main functions are:

1. If the DAW is not playing, Revoice Pro controls the playback in Revoice Pro.This method also

plays back scrubbing and looping within Revoice Pro.

2. If the DAW starts to play and "Follow DAW Playback" is checked in Preferences, Revoice Pro

also plays back, following the DAW's play head location. (Audio synchronization is sample

accurate on the systems we have tested).

3. Starting Revoice Pro playback does not put the DAW into play mode.
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Next

Related topics:

Pro Tools monitor plug-in

VST3 monitor plug-in

AU monitor plug-in
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5.2.2.1. Pro Tools Monitor plug-in

Audio setup, monitoring and playback » Audio monitoring » Revoice Pro Monitor plug-in » Pro Tools

Monitor plug-in

Pro Tools Monitor plug-in
Add a stereo Aux track into your DAW session. (The Monitor plug-in only works with stereo tracks).

Insert the Revoice Pro Monitor plug-in into the track as shown below in the example for Pro Tools.

The plug-in in Pro Tools is under multichannel plug-in / Other / Revoice Pro Monitor (stereo)

The Revoice Pro Monitor plug-in (as shown for Pro Tools below) has no controls.
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To enabling the Monitor, switch it on using the Monitor Enable button shown ON below

If you switch this Monitor switch OFF, then the output will be sent to the directly connected device set up

as the Audio Output.

 

PRO TOOLS 11 WARNING: In Pro Tools 11 you must disable (untick) Dynamic Plug-In Processing in

the Playback Engine window shown below. Otherwise, Pro Tools will stop getting audio from the plug-in

after a period of silence.

See also: Monitoring through Pro Tools HD hardware

Next

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.



Revoice Pro 5 Manual Publication8

52

5.2.2.2. VST3 Monitor plug-in

Audio setup, monitoring and playback » Audio monitoring » Revoice Pro Monitor plug-in » VST3 Monitor

plug-in

VST3 Monitor plug-in
The VST3 Monitor plug-in enables you to listen to Revoice Pro's output through the DAW's audio

outputs. It will work with Cubase, Nuendo and Studio One, and may also work with other VST3-

compatible applications.

VST3 Monitor plug-in (Nuendo example)

VST3 Monitor plug-in (Cubase example)

Next
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5.2.2.2.1. VST3 Monitor plug-in (Nuendo example)

Audio setup, monitoring and playback » Audio monitoring » Revoice Pro Monitor plug-in » VST3 Monitor

plug-in » VST3 Monitor plug-in (Nuendo example)

In Nuendo (Cubase), open the Devices Menu and select VST Instruments

The window below will open. Left click on Track Instruments.

A window similar to the one below will appear.
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If required, left click Add Track. Then left click on No VST Instrument and select Revoice Pro Monitor

from the menu list that will be similar to the one below

The Revoice Pro Monitor will be displayed in a window

In Revoice Pro check that the Monitor swich (shown in red box below) is enabled as shown.

You should now be able to start playing audio from Revoice Pro through the Nuendo system and

Revoice Pro will also follow Nuendo's playback.

NOTE: In Nuendo make sure that the Release Driver when Application is in Background option is not

checked. If this option is checked when you try and start playing from Revoice Pro the operation will fail

because Nuendo is in the background.
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If you want to stop Revoice Pro from playing audio when you are playing audio in Nuendo you can click

the Monitor switch to OFF. Alternatively you can mute the Nuendo  track which has the Revoice Pro

monitor plug-in, but this will not stop Revoice Pro from following the Nuendo timecode.

Next
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5.2.2.2.2. VST3 Monitor plug-in (Cubase example)

Audio setup, monitoring and playback » Audio monitoring » Revoice Pro Monitor plug-in » VST3 Monitor

plug-in » VST3 Monitor plug-in (Cubase example)

These instructions are for Cubase but should also apply to other VST3 hosts.

In Cubase select the Devices -> VST Instruments menu item.

 

The VST Instruments dialog will be displayed.
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Select one of the entries in the dialog and a menu will be displayed showing the available instruments.

Select Revoice Pro Monitor.
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You will be asked if you want to create a MIDI track you can select Cancel.

The Revoice Pro Monitor will be displayed in a window.

In Revoice Pro check that the monitor button is enabled.
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In Cubase check the Release Driver when Application is in Background option is not checked.

If this option is checked when you try and start playing from Revoice Pro the operation will fail because

Cubase is in the background.

You should now be able to start playing from Revoice Pro or from Cubase.

 

Next
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5.2.2.3. AU Monitor plug-in

Audio setup, monitoring and playback » Audio monitoring » Revoice Pro Monitor plug-in » AU Monitor

plug-in

AU Monitor plug-in
The AU Monitor plug-in enables you to listen to Revoice Pro's output through the DAW's audio outputs.

In Logic, create a New Software Instrument Track.

The track will be added to the list of existing tracks in the session, here shown as Track 4 (Inst 1):
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Make sure the track is selected, then click on the the Inst button on the  strip for that track, to show the

menu of available instruments, and selected AU Generators > Synchro Arts > Revoice Pro Monitor >

Stereo:

The Inst button now shows "Revoice Pro":
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To enabling the Monitor via this track in Logic, switch it on using the Monitor Enable button in Revoice

shown ON below:

If you switch this Monitor switch OFF, then the output will be sent to the directly connected device set up

as the Audio Output.

Next
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5.3. Track mute and solo

Audio setup, monitoring and playback » Track mute and solo

Toggle navigation

Revoice Pro 4.3 Help
·

· Contents

· Index

· Search

Tracks have Mute and Solo buttons which can be ON (lit up) or OFF

and a Track Monitor display in one of two states:

· Green - when track playback is Enabled (output heard)

· Red - when track playback is Disabled (output not heard)

 

Enabling a Track's output can be controlled in several ways:

1. If no Solo button is on in the Session, then all Track monitors will be Enabled.

2. LEFT Clicking the Track's Solo button will toggle it ON and OFF. If ON, the track is Enabled.

3. Pressing any of the keyboard's 10 numeric keys – one or more at a time will toggle the numbered

Tracks' Solo button(s).

Each of the 10 numeric keys is mapped to a corresponding Track, counting from the top of the

Revoice Pro window (top track=1, second track = 2 … etc to 10th track= 0).

NOTE: If the tracks are re-arranged, the correspondence counting from the top track remains –

i.e. the mapping to keys does not stay with a specific track – only the count from the top - which

the updated number will show.

4. Exclusive Solo:

o Holding down ALT key and LEFT CLICKing a track's Solo button to turn it ON will Enable

that track exclusively and toggle all other track's Playback enable controls OFF.

o Holding ALT and pressing a numeric key (1 to 0) to turn Solo ON for that track, will

Disable all other Tracks.

5. Process-dependent keyboard short-cuts (see Match Track Soloing, below) will Enable specific

tracks of the selected process.
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Match track soloing

Each Match process has two inputs and one output – and the user might wish to audition different

combinations of these tracks, one or two at a time.

To make auditioning the tracks of a process consistent – no matter which tracks the process inputs and

outputs are in, the user must first ensure the process of interest is selected i.e. the Input Process Control

Blocks are blue. If they are not, click either the Guide or Dub Process Control Blocks to select the

Process you wish to audition, and all the corresponding inputs and outputs to that specific process will

turn blue.

In that state - the keys shown in the picture above will Solo the tracks of the selected Match Process

according to the diagram. For example, pressing A will play only the Output, and E will play both the

Guide and the Output together.

Additional Tracks not related to that Process can also be enabled to play with the Processed tracks by

left clicking the Track's Solo button ON or, if the Track is numbered, pressing the Track's number key to

turn its Solo ON.

Doubler track soloing
For consistency, if a Doubler's Process Control Block or output is selected, pressing G will play the

Doubler's input, pressing A will play the Doubler's Output, and E will play both the Doubler's Input and

Output together.

Disabling a track's output
Tracks can be Muted in several ways so the output is Disabled (not heard):

1. If a Track has Mute ON, that Track will be Disabled, even if Solo is ON:

o If a Track has Solo ON, clicking that Track's Mute button ON will Disable the Track
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o Similarly, if that track is Numbered, pressing CTRL plus the Track number will toggle

Mute ON and OFF - and, as above, if Mute is ON, then the Track will be Disabled.

2. Using the Match Keyboard Shortcuts will automatically Disable the Tracks that are not selected

by the shortcut.

Track groups
Tracks can be grouped together so that monitoring controls affect all the tracks in a group. This is

described in the separate section Grouping Tracks.

 

Next
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5.4. Audio layers

Audio setup, monitoring and playback » Audio layers

The purpose of providing an optional set of audio layers in each track is to allow the construction of

assembled pieces of audio that can have their playback relationships changed easily. To enable audio

layers right click any empty area in the Track Information box on the left side of the screen. 

Audio layers behave a bit like opaque graphics layers in visual editing applications. There are four

available layers provided in each track. 

 The Show/Hide Layers button will switch between seeing only the resulting assembled audio, or

seeing the four layers.



Revoice Pro 5 Manual Publication8

67

To import audio, right click one of the layers and select 'Add Audio Files...' or by dragging audio from

other tracks over the layers.

The four layers each contribute to the main track according to the following simple rule. Any audio in a

higher layers that is "visible" from the top of the stack will be heard. No audio beneath audio in another

layer will add to the output. 

One simple two-layer example is that a small section of audio in a layer on top of a longer section in a

layer beneath the top layer, would act like a "moveable drop-in" and "cover up" whatever audio was

below it. This would allowing a word or phrase to be replaced by the drop in, but not destructively.
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5.5. Playback range

Audio setup, monitoring and playback » Playback range

The Playback Range Track lets the user insert one or more blocks highlighting regions of the timeline for

setting a specific range for:

· Auditioning (with optional repeat)

· Process creation (with one click)

· Exporting one or more tracks of audio

Using the Playback Range for auditioning helps the user:

· Find the start and/or stop of an audio event of interest

· Set areas for repeated or looped listening to:

o

o

Playback ranges are particularly useful when the Rewind and Loop controls are activated (as shown in

picture left).

 

When used for Process Creation, once a Match or Doubler process control has been set up, a Playback

Range can allow a new process to be created with as little as one keystroke.

Next

Topics in this section:

Setting screen position of Playback Range track

Inserting a Playback Range

The Playback Range menu

Create Processes using Playback Range
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Use Process Range to set Playback Range

How to use Playback Ranges during playback
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5.5.1. Setting screen position of Playback Range track

Audio setup, monitoring and playback » Playback range » Setting screen position of Playback Range

track

When Revoice Pro is first started, the Playback Range Track initially appears at the top of the Revoice

Pro window with the text "Click and Drag to Insert a Playback Range".

However, the user can optionally set the screen position of this Track to the bottom of the Revoice Pro

window in the Preferences control of Revoice Pro.

 

macOS: Select Revoice Pro in the Revoice Pro menu bar, select Preferences, and open the General tab

to open the window shown below. The selection is under Window layout
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Windows OS: Select Edit in the Revoice Pro menu bar then click Preferences to open the window shown

below.

For both Mac and Windows, tick the box to select Set Playback Range Track to top of window.

In the image below, the Playback Range track is shown at the top of the Revoice Pro window, with the

current Playback Range represented by a horizontal blue bar book-eneded by inward facing arrows.

 

Next
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5.5.2. Inserting a Playback Range

Audio setup, monitoring and playback » Playback range » Inserting a Playback Range

To set a Playback Range, click and hold down the Left Mouse button in the Playback Range Track and

drag cursor to the right (or left) to create the Playback Range - shown in the picture below as the blue

bar with inward pointing arrows on either side. 

The resulting Playback Range block can be adjusted by clicking and holding the left mouse boutton on

either inward facing arrow and dragging to the desired start or end locations.

By clicking and dragging in an empty area of the Playback Range track, a new playback range will be

created, replacing the previous range.
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Playback Ranges can also be created by 

A Playback Range can also be inserted by highlighting a group of notes or pitch blocks in Adjust or

Match output displays and pressing the Y key on the computer keyboard.

 

Next
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5.5.3. Create Processes using Playback Range

Audio setup, monitoring and playback » Playback range » Create Processes using Playback Range 

Setting a Playback Range to define the limits of a Match or Doubler process is one of the fastest and

most efficient means for breaking up the signal into processing sections. In this section we will show

how to quickly create two processes for different sections of audio.

The New Process window has been improved in Revoice Pro 5. 
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The new process window can be opened by right-clicking in the Process bar directly below an audio

region, or by pressing the B key. With the New Process window open, set a new playback range by

clicking and dragging along the Playback Range track (as in the blue Playback Range below), or by

right-clicking an audio region and selecting "Set Playback Range".
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When a Playback Range is created or modified, it will automatically be selected in the New Process

window.
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The Selected Playback Range is selected automatically in the New Process window and displayed

under Initial Input Start & End, with the correct range set as shown within the red box in the above

screenshot.

Once the process range is set, a preset can be chosen and the Guide Track and Dub Tracks can be

assigned as shown below.
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The user can now press the N key on the keyboard (or the New Process button in the New Process

window) to create the new Process Control Blocks.
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Processes created this way will use the selected preset settings. Changing Settings are discussed

further in the Processes chapters.

To quickly create Process Blocks that start where the previous process ended, the user can drag the

Playback Range start point (the left most arrow) directly to a new end point for the Playback Range. In

doing so, the new Playback range will begin exactly where the previous range ended. The red arrow in

the below image begins at the previous start point, and shows the path along which the mouse was

dragged.
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Pressing N once again will create the new Process Block.
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5.5.4. The Playback Range menu

Audio setup, monitoring and playback » Playback range » The Playback Range menu

Right clicking on a Playback Range will bring up the menu shown below.

When entries in this menu are left clicked the following additional useful functions will occur.

Delete: Removes the selected Playback Range block.

Permanent: Makes a Playback Range remain visible (in greyif unselected and light green if selected)

even if other Playback Ranges are created. Permanent Playback Ranges can be edited.

The entire Permanent Playback Range can be dragged by putting the cursor in the green block region

between the end markers and the hand icon will appear as shown in image below. Left click and drag

right or left as required.
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Locked: Makes a Playback Range Permanent and not changeable (unless it is first unlocked or deleted).

A Lock icon will appear in the Playback Range.

In the image below, we show a Permanent Playback Range (selected), a Locked Playback Range and a

"normal" unselected Playback Range.

When multiple Playback Ranges are used, the Up and Down arrow keys can be used to step along from

the starts to the ends of each of these sequentially.

The last two menu items above allow the user to set the Playback Start or End from the cursor position.

This is particularly useful if a Playback Region extends beyond the screen edges.

Set Start to Playhead: Will reset the start of the Playback Region to the position of the Playhead.

Set End to Playhead: Will reset the end of the Playback Region to the position of the Playhead.

Next
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5.5.5. Use Process Range to set Playback Range

Audio setup, monitoring and playback » Playback range » Use Process Range to set Playback Range

One way to quickly set a Playback Range is to set it to the same range as a Process Control Block. For

example, a short Playback Range is shown below in blue at the top of the screenshot and

a Match Process Control Block is shown in the blue bar at the bottom of the screenshot.

Right clicking on the Process Control Block, and selecting "Set Playback Range" shown in blue in the

menu shown below, will cause the Playback Range to be set to the same length as the Process Control

Block. 
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This is shown in the image below.

 

Next
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5.5.6. How to use Playback Ranges during playback

Audio setup, monitoring and playback » Playback range » How to use Playback Ranges during playback

Playback- When the space bar is pressed to start or stop playback, the playback (shown by the

Playhead motion) will start at the start of the last-selected Playback Range block.

If the Rewind switch is ON, then pressing the spacebar will toggle stop and then start playback from the

Block start, unless the user manually resets the playhead before starting. Then, that new starting

position will be used.

If the Loop switch is on, when the Playhead reaches the end of the block, it will automatically jump to the

start of the block.

The start and end of the blocks can be moved while playing, and the new positions will be used

immediately.

The up arrow and down arrow keys on the keyboard will send the Playhead stepping to the start or end

of successive Playback Region blocks or other "events" defined by the start and stop of any audio

waveform sections loaded in the tracks.

While playing back, the user can select tracks to hear or mute by pressing the various monitor enable,

mute and solo switches.

Next
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6. Sessions, tracks and files

Toggle navigation

Revoice Pro 4.3 Help
·

· Contents

· Index

· Search

When Revoice Pro starts, it opens an empty two-track Session window as shown below. However,

Revoice Pro supports multiple windows which can contain either different Sessions or additional

independent views of the same Session.

In addition, Revoice Pro can contain an unlimited number of Tracks. But, unlike traditional audio editors,

each Revoice Pro Track contains a large area for displaying the audio and optionally energy, pitch and

loudness, and a smaller area under the main area that holds the Process Control Blocks.



Revoice Pro 5 Manual Publication8

89

The multi-track view can be switched to view a full-height single track by using Single/Multi Track display

control in the Track Control Panel.

Next

Topics in this section:

Using Sessions

Session settings

Track operations

Grouping Tracks

Marker Tracks

Tempo grids

Process identification in multitrack sessions

Session templates and default sessions

Locations of files
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6.1. Using Sessions

Sessions, tracks and files » Using Sessions

Revoice Pro Sessions contain, display and retain all the audio and process control settings.

The session name is shown at the top of the Revoice Pro Window. The name remains "Untitled" until the

session is saved with a name.

Sessions are saved with a .rvp extension.

Multiple sessions can be open simultaneously, and you can open multiple windows on the same

Session if needed.

File menu
Like other audio editing systems, you can save and load Revoice Pro Sessions using the “File” menu

shown below for Mac (left) and Windows (right) or the Quick Key Shortcuts following each command.

 

The File menu actions are:

New - Create a new Session

Open and Open Recent - Opens previously saved Sessions.
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Close – Closes current Session

Save – Saves current Session

Duplicate - Saves a duplicate of the current Session

Rename - allows you to rename the current Session

Move To - allows you to move the current Session to a new location

Save Copy in - allows you to save a copy of the Session in a new location

Save As Default Session ... - Saves the track layout, names and settings of the current Session

(including audio, if any) to be opened when next select "New".

Clear Default Session - deletes the current default Session

Export Audio - Opens a window for selecting audio to write to files. See Export Audio function

Auto Save can be turned on in the Preferences, to save sessions periodically.

These menu options will vary slightly depending on the version of OS that you are using.

If you save a session that has temporary audio files associated with it, such as those generated by plug-

ins using Revoice Pro, you will be asked for a location to save the associated audio. If you have loaded

audio manually into Revoice Pro, it knows where this is located and so will not ask you for a location to

save it.

Window menu
Using the “Window” top menu item, You can also open multiple windows on the same Session (for

example if you want to examine two time-separated areas of the tracks at the same time. )

Next
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6.2. Session settings

Sessions, tracks and files » Session settings

Session settings
The Settings window has various options for adjusting the way in which timing and DAW import works

within a particular Revoice Pro session.

Select View > Settings from the menus at the top of the screen. This will display the Settings window.
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Audio Sample Rate is fixed automatically. The Revoice Pro Session's Sampling Rate is set and fixed

automatically to the settings of the first audio signal imported into the session. After that, Revoice Pro

will offer to resample any non-matching audio file that is imported, to match that Session's Sampling

Rate.

Timecode Rate sets the frame rate of any timecode display or synchronisation options.

DAW Time Offset can be used to set the start time relationship between audio from a DAW session or

MIDI file import and Revoice Pro's assumed time. Depending on the DAW in question and any



Revoice Pro 5 Manual Publication8

94

associated Revoice Pro plug-in, this will usually be used to establish the correct offset between the

session start time in the DAW and that in Revoice Pro. This is in order that material displays and replays

at the correct time when copied between DAW and RP, and so that playback synchronizes correctly.

SMPTE Time and Real Time are essentially the same time value displayed differently.

Bar Beat Position can be used to match the Bat Beat Position set in Logic Pro X projects.

Beats Per Minute controls the assumed tempo of the bars and beats display.

Copy & Paste DAW selects, in situations that support it, which DAW is to be used for copy and paste

operations.

Bar & Beats Display selects whether this is according to a fixed time signature and tempo, or uses an

imported tempo map

Next
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6.3. Track operations

Sessions, tracks and files » Track operations

Track menu
The Tracks menu contains a number of functions for adding, clearing and viewing tracks.

A contextual menu of some Track-based functions can be accessed by RIGHT CLICKing in an "empty"

area of the Track Control panel as shown at right. The selectable items includes Insert Track and Delete

Track, which are self explanatory.

The last menu items, Add Markers and Enable Layers, provide further useful functionality. See Marker

Tracks, Audio Layers.

Rearrange tracks
Tracks can be re-arranged in the Session window by holding down the LEFT Mouse button in an empty

area in the Track Control Panel and, with the Hand icon, dragging the Track's "ghost" up or down and

dropping it in another "destination" Track Control Panel.

If the "ghost" is dropped in the top half of the destination track's window - the dragged track will be

placed above the destination track.

If the "ghost" is dropped in the bottom half of the destination track's window - the dragged track will be

placed below the destination track.
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Insert tracks
Tracks can be inserted with the Tracks menu Add Tracks... command: CMD SHIFT N (Mac) /CTRL 

SHIFT N (Windows). The number of new tracks and their base name can be entered in the window

subsequently displayed. Each consecutive track so created will have an incremented number in

brackets after the name, e.g. Audio, Audio(2), Audio(3), ... Audio(n).

Duplicate tracks
Tracks can be duplicated by pressing ALT key (Mac) / CTRL key (Windows) and left click and hold down

mouse button and dragging a Track Control panel to another track. The dragged track control panel will

be duplicated and an auto-incremented number will be added to the end of the current name, if the

source track is labelled "Audio n" or "Output n" (where n is a number). (This only duplicates the basic

track settings, such as level, pan, but not the content or processes.)

Track height
Track heights can be resized by selecting anywhere on the thick horizontal separator line between

tracks and when the up/down arrow icon appears, hold down a left click and drag the line up or down to

increase or decrease the Track height.

If the SHIFT key is held down, ALL the track heights will be adjusted at the same time.

A Full height view of a single Track in the multi-track display can be displayed by pressing this button in

the Track Control Panel

Pressing it again will restore the multi-track display.

Track processes
Tracks can be "Cleared" of all Audio and Processes by selecting Clear Tracks command in Tracks

menu. The Tracks layout and Track Control Panels will be preserved. This command can be used to

create Session Templates.
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To show only Tracks used by the selected Process, press the Z key. To show all the tracks, press X key.

To toggle hiding the Displays of processes that are not selected, press the C key.

See tracks menu below for Mac (left) and Windows (right)
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6.4. Grouping Tracks

Sessions, tracks and files » Grouping Tracks

Track Groups provide a way of controlling multiple tracks at a time when you perform actions such as

mute and solo.

A track can be in any Group and in more than one Group at a time. Any "groupable" action performed on

one track of the Group will affect the others that it is grouped with.

Next

Topics in this section:

Managing groups

Group controls

How to manage Track Groups using Revoice Pro
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6.4.1. Group controls

Sessions, tracks and files » Grouping Tracks » Group controls

The group controls are shown at the rightmost side of the main Revoice Pro window. You can show or

hide this column by pressing the rightmost arrow button at the top of the column.

You will see four buttons for each group, A, V, M, S.

A = active (group is enabled)

V = visible (tracks in that group are made visible)

M = mute (tracks in that group are muted)

S = solo (tracks in that group are soloed)

When the button is green that function is "on". These are not duplicated by keys on your computer

keyboard.

Pressing any of these group controls for a group will affect all the tracks in that group. Similarly, pressing

M or S on the left-hand track controls of any track in an active group will affect all the tracks in the group.
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Activating and viewing Groups
When you activate a group by pressing A in that group's controls, the button lights up with the colour of

the group (the colour is selected in the Manage Groups function described at the start of this section),

and (as long as they are visible) the tracks in that group show a vertical bar of that colour down the left

side of the Revoice Pro window. In this example, Group 1 is red and affects the first two tracks, while

Group 2 is green and affects track 3.

If a track is in more than one group, the vertical bar on the left of the track controls will be split between

the colours of the different groups to which it is assigned. Here Audio 3 is assigned to both red and

green groups:

Tracks in a group can be made visible or invisible by pressing the V control.
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ALT V is an exclusive visibility control, which makes only that group of tracks visible.

Control behaviour when tracks assigned to
multiple Groups
Because tracks can be assigned to more than one group, sometimes a function will affect tracks in

multiple groups at the same time. If all the tracks in a group are affected by a function then the group

control for that function will be affected too. So, for example, if group 2 contains all the tracks that are

also in group 1, muting group 2 will also cause group 1's mute button to go red.

 

Next

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.



Revoice Pro 5 Manual Publication8

103

6.4.2. Managing groups

Sessions, tracks and files » Grouping Tracks » Managing groups

Creating a new Group
Select the top menu item Tracks > Manage Groups.

A window similar to that below will appear:

Adding Tracks to Groups
Highlight the group name in the Groups window top right. Highlight tracks in the list on the left by clicking

them (shift or command/ctrl click to add to the selection), and press 'Add >>' to put them in the group

selected. In the example below, the first two tracks from the track list shown above have been added to

a single group. You can choose a colour to identify the group from the Group Colour drop down.
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Alternatively, you can select multiple tracks (by left-clicking the first one in its control panel at the left of

the Revoice Pro window, then shift-clicking others) and drag them to the Track Groups area at the top

right of the Revoice Pro application window as shown below.
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Removing Tracks from Groups
Tracks can be removed from a group by selecting the group name in the Groups window top right,

highlighting the tracks concerned in the Group Members list below it, and clicking <<Remove.

Deleting Groups
A group can be deleted by highlighting it in the Groups list and pressing Delete Group.

Naming Groups
You can name a group by double clicking on its name in the Groups list and typing. (This can also be

done by typing in the group name above the group controls on the main Revoice Pro window, shown

below.)

 

Next

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.



Revoice Pro 5 Manual Publication8

106

6.5. Marker Tracks

Sessions, tracks and files » Marker Tracks

A "Marker Track" is a track below an Audio Track in Revoice Pro that can be loaded with user-defined

moveable blocks of text. Each track can have any number of these Marker Tracks added.

Uses for these include putting down words describing the sections of a musical composition (e.g. Verse

1, Chorus 2, etc.), the words of a song in time with the audio, or the script of the dialogue for an ADR

track in time with the actors corresponding words.

Adding a Marker Track

By right clicking an area in the Track Control panel, the above menu will appear, and if Add Markers is

selected, the additional small track highlighted in red below will appear.
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By right clicking in this area, the following menu will appear:

If New Word is selected, an area will be reserved at the location of the Playhead and the user can type

directly into that track. (Here the words "New Words Can Be Typed Directly Into This Track" have been

entered.)
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The next step is usually to bring up the same menu and select Auto Split.

This will break each word into it's own moveable block as shown below.

The selected block is shown in blue and the edges of words can be dragged either direction to make the

start and/or stop coincide with the related audio, as shown below.
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In addition, groups of words can be made with a SHIFT selection, as shown below.

Additional operations in the menu can merge groups of words, Delete them, and copy and Paste into

empty areas of sufficient length.

The purpose of these operations is to adjust the starts and/or ends of the words and blocks of words to

provide visual cues as to the content of the audio throughout the track.

Next
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6.6. Tempo grids

Sessions, tracks and files » Tempo grids

It's possible to display a tempo grid of bars and beats behind an audio track. This can either be at a fixed

rate or at a variable performance rate dictated by tempo information in a MIDI file. Using this it's possible

to see how audio aligns with a tempo map.

If you are using ARA 2 plug-ins the tempo grid may be automatically transferred from the host DAW.

Next

Topics in this section:

Setting a fixed tempo

Importing a tempo map from a MIDI file
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6.6.1. Setting a fixed tempo

Sessions, tracks and files » Tempo grids » Setting a fixed tempo

Using the upper drop-down to the

right of the current time display in the transport area of the main display, select Bars & Beats. This sets

the timing units of the horizontal scale above an audio track.

Select View > Settings from the menus at the top of the screen. This will display the Settings window.
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Enter the time at which you want the bars and beats count to begin, either in the SMPTE or Real Time

box under DAW Time Offset, and press Return or Tab. This should normally match the start time of the

related audio. Enter the number of Beats Per Minute in the BPM box. Select Fixed Time Signature &

BPM in the Bars and Beats Display drop-down at the bottom, and choose a Time Signature to match

your music. Close the Settings window, and you should now see a fine grid on the audio track, with

bar/beat numbers along the top edge, as shown below. The bar lines are shown stronger than the beats.
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6.6.2. Importing a tempo map from a MIDI file

Sessions, tracks and files » Tempo grids » Importing a tempo map from a MIDI file

If you have a MIDI file containing meta-events with time signature and tempo information for a piece of

music, it can be imported into a Revoice track to display the bar/beat information. The simplest way to

do this is to drag and drop a suitable MIDI file onto an audio track, as shown below. Alternatively you

can use the Import MIDI File option in the File menu.

When you import such a MIDI file, Revoice Pro will ask where you want it to start on the timeline.

You will only see the tempo grid from the MIDI file if the start time is visible on the audio track display.

Either scroll to it (if possible) or load some audio that starts at the same time. If it's not visible you will

see "Bars and Beats start at ..." above the first track, as shown below.

In the picture below you will see the bar/beat grid of the imported MIDI file against an audio click track

that conforms to the same pattern. The tempo varies from 100 to 160 BPM up to bar 13.
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You can switch between the fixed tempo map and the one from the imported MIDI file using the Bar &

Beat Display drop-down in the View > Settings window, as shown below.

Next
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6.7. Process identification in multitrack sessions

Sessions, tracks and files » Process identification in multitrack sessions

Revoice Pro has a display in the session window's right hand border which shows what is currently

editable in the tracks related to a selected Process or waveform. This is particularly useful as more

tracks get added to a session, as in the image below.

The selected process' information is also displayed in the Selected Item Display at the right of the image

which identifies the selected tracks and editable items in the selected process. Even if the selected

process scrolls horizontally out of the main window's time view, the item shown in this special area

remain displayed. The drop down menus in this display can be used to make items editable and the

display scalable.

If we then click on another Process Control Block, then the Selected Item Display will switch to show that

process's details on the appropriate tracks.

Next
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6.8. Session templates and default sessions

Sessions, tracks and files » Session templates and default sessions

Session Templates
If you find you repeatedly use the same track layouts in Revoice Pro Sessions, you can create an empty

Session, insert and name the required tracks and then save the Session with a descriptive name such

as "Lead with 2Harm and doubles" before loading any audio to serve as a "Template". Then, for future

Sessions, you can open the Template Session, populate it with audio, and save it with a different name

so you can use the empty Template again.

This saved Session will also contain any existing Track Control settings, including pan, solo, mute and

volume controls.

Default Session
If you are constantly creating Sessions with the same specific track names and track arrangements that

remain roughly the same from Session to Session, you can save a great deal of time by creating a

Default Session (without audio) that will open every time you use the File menu New command.

This session will contain not only the Track information, but Session information including timecode

offsets.

To create a Default Session, we recommend the following steps:

1. When you have a Session with Track names, orders of Tracks, pan, solo and volume controls

that you want to reuse, if it contains audio, you can first remove all the audio and processes by

using the Clear Tracks command in the Tracks menu.

2. When the Tracks are cleared, then use the command Save as Default Session in the Revoice

Pro File menu.

To delete the Default Session template, use Clear Default Session in the File menu.

Next
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6.9. Locations of files

Sessions, tracks and files » Locations of files

This section contains information about important file locations.

Temporary audio files
You can choose where Revoice Pro stores its temporary audio files. If your DAW is not copying files

created by Revoice during drag-and-drop export into a folder under its control, the audio files may be

lost when the default temporary folder is cleared out. If you set the temporary files location yourself, you

can ensure they are not deleted automatically.

Towards the bottom of the Preferences dialog, select Set Location... to choose a folder where temporary

audio files will be stored. Files are stored in a logical and clearly named hierarchy, with dates taken into

account. Choose Automatic to store them in the place chosen by the current session.

macOS
All Revoice Pro files can be deleted if start-up problems occur that seem file related.

~ at the start of a path indicates the user home directory.

/ indicates the root directory

The Library folder is hidden on OS X 10.7 and later. An easy way to make the folder visible in the Finder

is to select the Help -> Search menu and enter Library and follow the instructions.

Sessions Recent File List

~/Library/Preferences/com.synchroarts.Revoice-Pro.LSSharedFileList.plist

User Preferences

Contains preference settings including interface colours and operation warnings.
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~/Library/Preferences/com.synchroarts.Revoice-Pro.plist

Match Presets

~/Library/Application Support/SynchroArts/RevoicePro/Match

Doubler Presets

~/Library/Application Support/SynchroArts/RevoicePro/Doubler

Session templates

~/Library/Application Support/SynchroArts/RevoicePro/SessionTemplate

The file "Default.RPPreset" is the Default template for new sessions.

You can delete this file to restore the "Factory Default" parameters for new sessions.

Shared Presets

To add a shared preset you should save the preset into your user preset folder. Then, using the Finder,

copy the preset into the shared folder.

To do this you will need an Admin password and you may have to create the folders in the path.

 

Match Presets Location

/Library/Application Support/SynchroArts/RevoicePro/Match

Doubler Presets Location

/Library/Application Support/SynchroArts/RevoicePro/Doubler

Windows OS
Default Presets and Templates

If you paste the following path into Windows Explorer: %APPDATA%\SynchroArts\RevoicePro\Presets

the file system will show the folders with names in bold below.

Match - contains default and user Match presets

Doubler - contains default and user Doubler presets

Session Template - contains default and Session Template file.
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The file "Default.RPPreset" is the Default template for new sessions.

You can delete this file to restore the "Factory Default" parameters for new sessions.

Deleting the files in each of those folders will restore that template to the "Factory Setting"

Next
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7. Workflows
Toggle navigation

Revoice Pro 4.3 Help
·

· Contents

· Index

· Search

Revoice Pro is a stand-alone program. You can either use it in a stand-alone fashion (importing and

exporting audio files), or in one of a number of customised modes with a DAW.

In all cases the workflow steps are:

· Import or transfer audio to Revoice Pro

· Process the audio in Revoice Pro and check it

· Export or transfer the audio from Revoice Pro

First look to see if there is an online guide related to your DAW.

Otherwise look in the DAW-specific methods section of this manual, use a Revoice Pro Link Plug-in or

use one of the stand-alone options.

Here is a Summary of transfer methods that might be employed.

You can do basic editing of audio waveforms within Revoice Pro if necessary.

Next
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DAW-specific methods

Revoice Pro Link plug-ins

Stand-alone operation

Related topics:

Audio setup, monitoring and playback
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7.1. Summary of transfer methods

Workflows » Summary of transfer methods

The audio transfer methods are summarised in two tables below and there should be at least one that

works with your brand of DAW, including Pro Tools, Logic Pro, Ableton, Cubase, Nuendo, Reaper,

Studio One, etc. Which method(s) you choose for transferring audio will depend on your DAW, the

methods it supports, and the amount of audio you want to transfer. You should be able to follow the links

below to skip to the sections related to the DAW, plug-in type, or specific operation you are interested in.

Visit our quick online introductions to using Revoice Pro with supported DAWs.

The table below provides a summary of the main methods, with links to sections in the manual

describing these.

Transfer audio
from your DAW to Revoice Pro
Method DAW or Plug-In Interface Notes
Drag and Drop audio files
into Revoice Pro

· Stand-alone and
most DAWs

· Files can be existing .wav
or .aiff, bounced or
Exported from DAW to disk

· Faster than real-time
· Transfer multiple tracks

and regions
simultaneously

· Uses Timecode (if present)
· Uses file names

Revoice Pro Link Plug-ins · Audio Suite/AAX
(Pro Tools)

· AU (e.g. Logic
Pro)

· VST3 (e.g.
Cubase, Nuendo)

· Audio Suite/AAX: one or
more regions from one
track instantly, with
optional automatic process
creation, and rendering
back to Pro Tools. Pro
Tools "entire selection"
creates a continuous file,
even if multiple regions

· AU, VST3: multiple tracks
simultaneously, in real
time

Selection-Based Processing · Logic Pro (from v
10.3)

· Faster than real time
· Multiple regions
· Auto-trims silence from the

end of the captured audio
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"Quick" Match Plug-in
and
"Quick" Doubler Plug-in

· Audio Suite and
AAX

· (Pro Tools only)

· High-speed, simplified
workflow: captures,
processes and returns
audio to Pro Tools (like
VocALign)

· Simple temporary session
only

· Limited session tools
available

DAW Region Drag and Drop
DAW Region Copy and
Paste

· Nuendo 5 (and up)
and Cubase 5
(and up)

· Logic Pro
· Studio One

· Faster than real-time
· Multiple regions
· Uses Timecode (if present)
· Maintains region names
· Does not duplicate audio

Quick Match/Doubler/Adjust
(Intelligent Cut/Paste)

· Studio One (from
v3.3.2.4)

· High-speed, simplified
workflow: captures,
processes and returns
audio to Studio One

· Tracks, groups and
processes are created
automatically

ARA · Studio One (from
v4.0)

· Reaper (from
v5.97)

· Cubase (from
v10.1)

· Logic Pro (from
10.6.1)

· Immediate transfer and
updating of linked tracks or
audio regions.

· Maintains names of
regions

· Saving and loading of
projects

*In Logic Pro with Apple Silicon, ARA
only when running Rosetta 2

 

Transfer processed audio
from Revoice Pro to your DAW
Method DAW or Plug-In Interface Notes
Drag and Drop directly into
DAW track

· Nuendo 5 (and up)
and Cubase 5
(and up)
[from Revoice Pro
2.6]

· Logic Pro
· Studio One

· Instantaneous
· One processed region at a

time
· Spot to timecode (might

require extra DAW
command)

· Normally keeps name of
region
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Next

Related topics

Audio format requirements 
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Export audio to files and
drag files into DAW

· Most DAWs · Multiple tracks, multiple
regions simultaneously

· Spot to timecode
· Automatic creation of file

names from user-specified
elements

Revoice Pro Link and Quick
Match and Doubler

· Audio Suite and
AAX Plug-ins (Pro
Tools only)

· One or more region from
one track spotted instantly
to timecode in DAW

Quick Match/Doubler/Adjust
(Intelligent Cut/Paste)

· Studio One (from
v3.3.2.4)

· [from Revoice Pro
3.3]

· Copy Revoice process
outputs

· Paste back to original
position in DAW

· Selected or all process
outputs at once

ARA · Studio One (from
v4.1)

· Reaper (from
v5.97)

· Cubase (from
v10.1)

· Logic Pro (from
10.6.1)

· [from Revoice Pro
4.0]

· Automatic seamless
updating from all linked
processes

· Create permanent hard
copies using  DAW's
render function

· Saving and loading of
projects

*In Logic Pro with Apple Silicon, ARA
only when running Rosetta 2
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7.2. Bouncing audio from DAWs

Workflows » Bouncing audio from DAWs

One way to get audio out of your DAW and into Revoice Pro (then used in "stand-alone" mode) is to

"bounce" a rendered section of certain tracks (perhaps containing multiple regions), creating audio files

of those track sections. Multiple named audio files are created, one for each track of audio to be

processed.

Bounced files can be mono, stereo or multichannel (generally less useful) files.

Bounced files can then be loaded into Revoice Pro using drag and drop. 

For detailed information on exporting or bouncing audio, check the DAW's User Guides.

 Next 

Related topics:

Online guides for a range of DAWs
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7.3. Editing signal waveforms

Workflows » Editing signal waveforms 

In many cases, the way Revoice Pro works will mean you can bring long audio signals into Revoice Pro

and not need to edit the waveforms. You can, in effect, create edits by inserting several Process Control

Blocks to start and stop at specific points in each track of the input audio waveforms. This is usually the

most effective and efficient way of working.

There are situations, though, in which it is helpful to edit audio waveforms in Revoice Pro and this

section explains the range of waveform editing operations available.

Related topics:

Process identification in multitrack sessions

Select a waveform for editing 

Because Revoice Pro supports editing of either the process controls or the waveforms in the same track,

sometimes you must switch Revoice Pro from Process Editing to Waveform editing. There are several

"one-click" ways to do this.

In many cases, a waveform is selected for editing by just left clicking it once, and it will be displayed in

light grey indicating it is selected. The image on the left below shows an unselected audio waveform,

and the image on the right shows a selected audio waveform. In both cases, the Match Process in their

Process tracks at the bottom of the image is greyed out to show that it is not selected.
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Once a waveform is selected, then two familiar types of editing are available: screen-based and menu-

based.

Selecting waveforms in process editing mode
If the user is in a Match Process Editing mode, then left clicking a waveform will not select it. You must

first switch that mode OFF before a waveform can be selected for editing. Either:

· Hold down CMD key on keyboard and left click on a selected (blue) Process Control Block to de-

select that Process.

or

· Right click in a waveform area and select the 'Select Audio' menu item as shown below in blue.
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Either will exit the Match Process Editing mode and turn formerly blue Process Control Blocks grey,

indicating that mode was successfully turned off. You can then click on waveforms to select and edit

them.

Click and drag waveform editing

Audio regions can be edited within Revoice. Regions can be trimmed for their start or end, and they can

be moved to reposition them in time.

To trim a waveform, position the cursor at the end of an audio region, shown by a thin blue line. Left click

and hold, then drag to adjust the regions start or end. Regions cannot be made longer than their original

file length.

To move an audio region left or right, left click and hold near the centre of the region, then drag the

region to the desired position. Audio can also be dragged to another Revoice track if required.
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Menu-based waveform editing
If no process has been assigned to a waveform, a RIGHT CLICK on a selected waveform will pop up the

waveform editing options window, shown to the right for macOS. 

If you have positioned the Playhead at a useful point before bringing up this window, then the three (self-

describing) menu options can be used either to shift the selected waveform's start or end, or split it into

regions.



Revoice Pro 5 Manual Publication8

132

A further group of "standard" menu options allow the entire selected waveform to be Cut, Copied,

Deleted or (if a prior operation copied a waveform and "Paste Audio ..." is not greyed out), the copied

waveform can be Pasted to start at the Playhead.

If you do not see these menu items, it may be because you have an active and selected Process on this

audio region. In order to Select the audio region and see these options, right click the region and select

the 'Select Audio' menu item as shown below.

Next
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7.4. Audio format requirements

Workflows » Audio format requirements 

Input file formats: .WAV (normal and BWF) and .AIFF. (AIFF does not contain timecode stamps)

AIFC is supported on Mac OSX for 32-bit floating point exports from Logic (from version 3.3)

Output format: .WAV (BWF with timecode stamps)

Sample rates: from 44.1 to 192 kHz

16 to 32 bit audio samples

Multi-channel audio files: with up to 8 channels are supported in some cases

You cannot use waveforms with different bit depths and/or different sampling rates in the same Revoice

Pro Session. Each Revoice Pro Session's Sampling Rate and Resolution (Bit Length) are set and fixed

automatically to the settings of the first audio signal imported into the session. After that, Revoice Pro

will offer to resample any non-matching audio file that is imported, to match that Session's Sampling

Rate and Resolution.

 

Next
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7.5. How to work with your DAW

Workflows » How to work with your DAW 

There are simple and fast methods and workflows for getting audio from your DAW into Revoice Pro for

processing, and from Revoice Pro back to your DAW.

Online guides for all supported DAWs

Instructions for specific DAWs included in this manual

Pro Tools

Studio One

Cubase/Nuendo

Reaper

Logic Pro

Revoice Pro Link plug-ins (a more generic alternative)

Audio Suite and AAX

AU

VST3

Revoice Pro audio monitoring for specific DAWs

You can listen to Revoice Pro audio through the DAW outputs, and optionally replay Revoice Pro audio

in sync with DAW playback.

Revoice Pro Monitor plug-in

Next
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7.5.1. Pro Tools

Workflows » How to work with your DAW » Pro Tools 

There are three ways of working with Pro Tools:

· ARA Mode: this is the default workflow, available in Pro Tools as of version 2024.6 and

Revoice 5.1.9. We encourage you to use this workflow when available.

· Quick Mode: for simple operations, uses a temporary Revoice Pro session containing one

Match or Doubler process at a time.

· Link mode: for more complex sessions, uses the Audio Suite/AAX link plug-in.

Also, a Pro Tools monitor plug-in is included with Revoice Pro that, once installed, allows you to hear

audio playback from Revoice Pro through the DAW's audio outputs. It also lets Revoice Pro optionally

lock to the DAW's playback with sample-accurate sync. This lets you check processed audio "in place"

with DAW audio and video before you transfer it from Revoice Pro back to the DAW.

Next topic

Related topics:

Latest information on Revoice Pro with Pro Tools

Next
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7.5.1.1. ARA (Audio Random Access) in Pro Tools

Workflows » How to work with your DAW » Pro Tools » ARA (Audio Random Access) in Pro Tools

From version 2024.6 of ProTools and Revoice 5.1.9, there is a new, more versatile way of processing

audio in Revoice Pro. The Audio Random Access (ARA for short) interface allows plug-ins and DAWs to

integrate much more thoroughly with each other. Revoice Pro supports the new ARA 2 standard that

allows a better and much faster exchange of information. 

This section describes how to work with the ARA plugin accessed via the Revoice Pro Link ARA plugin.

It can be followed as a step-by-step guide.

When working with Revoice Pro and Pro Tools, ARA has the following advantages:

· There is immediate transfer of audio between the DAW and Revoice Pro.

· It keeps the names and timings of all linked audio events. 

· Linking the output of any process in Revoice Pro to an audio event allows immediate

replay in the DAW of Revoice Pro's processing.

· You can open and save the whole project using the DAW's commands Open, Save, Save

as..  Not only will these commands save and load DAW data but they will also save and

load the Session data from Revoice Pro. Revoice Pro Session data is usually stored in the

same folder as DAW data, making any project with ARA much more portable and re-

editable.

Previous      Next
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7.5.1.1.1. ARA Basics in Pro Tools

Workflows » How to work with your DAW » Pro Tools » ARA (Audio Random Access) in Pro Tools »

ARA Basics in Pro Tools

· Important: Compatibility

· Guide and Dub Tracks

· Instantiating Revoice Pro 5 on a Clip

· Adding Revoice Pro Link to a Track

· Docking and Undocking the Plugin Window

· Revoice Pro Link Plugin Window

· Removing Revoice Pro 5 plugin instances

This section describes basic use of the Revoice Pro 5 plugin with ARA2 in Pro Tools. You can follow this

section and the next section as a step-by-step guide.

Important: Compatibility
In order to use ARA and this section of the guide with Pro Tools and Revoice, you must have:

· Pro Tools 2024.06 or newer

· Revoice 5.1.9 or newer

Please update your software as needed. Should you be unable to update, please refer to the other

workflows provided for Pro Tools in the following sections.

Guide and Dub Tracks

In the below screenshot, we can see two audio clips.

· Lead Vocal GUIDE is our main vocal track, which we will refer to as our Guide.

· Double Vocal DUB is the track that we will align to our Guide, refered to as our Dub.
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Instantiating Revoice Pro 5 on a Clip

To access Revoice Pro 5 in Pro Tools, we can either:

· Right Click the clip we would like to work on, and then select 'Revoice Pro Link -> Edit'

from the drop down menu

· Select the Clip menu, and then select 'Revoice Pro Link -> Edit' 
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 ..... or ..... 
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Adding Revoice Pro Link to a Track

Revoice Pro Link can also be added to an entire track using the Elastic Audio/ARA Plugin Selector

menu indicated below, or the File -> Track menu or Track right click menu.

Any of the above methods will add Revoice Pro ARA and open the plugin window.

Docking and Undocking the Plugin Window
The Revoice Pro Link plugin will first appear docked in the Pro Tools Edit Window at the bottom of the

DAW.
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If you do not see the plugin window, click the Revoice Pro edit window tab shown below.

To undock the plugin window, click the undock button in the edit window tab list shown below.
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For the remainder of the guide, we will be working with the plugin window undocked. This is a personal

preference and has no effect on functionality.

Revoice Pro Link Plugin Window

If Revoice Pro is not yet running, you will see the below plugin window. If this is the case, click Start Rv

in the top of the window to open Revoice Pro.

Once Revoice is running, or if it was already running, the plugin window will appear as in the below

image.
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The 'Mode' dropdown menu will be discussed in the next section, but for now we will work with the

Capture Only mode. Select Capture Only from the mode drop down menu.

Removing Revoice Pro 5 plugin instances

Revoice Pro Link, like other ARA plugins in Pro Tools, can only be removed from the entire Track.

To remove Revoice Pro Link from a track, click the ARA symbol in the corresponding track's controls,

indicated by the red arrow below.
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Then select 'None' from the menu that appears.

Previous       Next
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7.5.1.1.2. Capturing and Processing Audio

Workflows » How to work with your DAW » Pro Tools » ARA (Audio Random Access) in Pro Tools »

Capturing and Processing Audio

· Capturing Audio

· Capture and Process Modes

· Applying a Process in Revoice Pro

· Rendering Audio

This section shows you how to transfer audio from a project in Pro Tools to Revoice Pro 5 using the

ARA Link plug-in. 

Capturing Audio

First, select the audio clips that you would like to import into Revoice Pro. In this case, we will import our

two clips from the Lead Vocal track and the Double Vocal track. Once you have selected the regions,

click Capture Audio in the plugin window as indicated in the below image. Remember, both clips or

tracks must have Revoice instantiated as in the previous section.
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If you open your Revoice Pro project window, or click the Show Rv button in the top right of the plugin

window, you should see something similar to the below. Revoice has created two new tracks, one called

Lead Vocal and the other called Double Vocal. The tracks are ready to be processed further within

Revoice.
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Any tracks that Pro Tools has created in Revoice Pro are automatically locked. The red padlock  in the

track's status area indicates this. Although you cannot edit any of the linked audio directly in Revoice Pro

(as the track is locked), the ARA interface synchronizes each audio segment in Revoice Pro with its

linked audio in Pro Tools.

Capture and Process Modes
As of Revoice Pro 5, the Link plugin has a Mode menu item. The Mode allows the user to both Capture

audio and apply a Process immediately within Revoice, and helps to make standard workflows more

efficient. Here, we will discuss how to use the Mode menu feature, and then discuss creating a process

in Revoice after using Capture Only.

In the Revoice Pro Link plugin window, click the Mode dropdown menu and select Capture & Match

Timing / Pitch / Level.
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The Revoice Pro Link plugin window will change to give you some new options.

In the above image we can see we now have a few new options.

· Preset will allow us to choose any of our presets to apply to this new process.

· Select Guide and Select Dub will allow us to capture our audio regions into Revoice Pro.

·

First, select your Guide audio region in Pro Tools, in this case 'Lead Vocal GUIDE' and then click

Capture Guide in the Revoice Pro Link plugin window.
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Repeat the same process but select the 'Double Vocal DUB' region in your DAW, and click Capture Dub,

just below Capture Guide.

Now in your Revoice project window, you can see the process that has been created as shown below.

You can listen back in Revoice or in your DAW to hear the Matched audio.
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Applying a Process in Revoice Pro
If you have used the Capture only Mode, as done in the previous topic, you can continue with the

following instructions to apply a process within Revoice

In this example we are going to use a Match (see Match Process for more details) to align the Dub

signal 'Lead Vox High Chorus' to the Guide signal 'Lead Vocal'.

First, in Revoice Pro select the Guide signal 'Lead Vocal' in the first audio track. The audio waveform will

turn light grey to indicate it is selected.
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Next, right click in the Process Control track and select Match Timing / Pitch / Level. This will open the

New Process Window.

Below we can see the New Process window that opens upon selecting Match Timing / Pitch / Level.
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Revoice has made a few automatic choices for us, and for standard use these defaults will typically work

well.



Revoice Pro 5 Manual Publication8

153

· Our Initial Input Start & End is set to Selected Audio, meaning that his process will apply

to all audio within the selected region.

· Revoice has also selected 'Lead Vocal' as our Guide track, and 'Double Vocal' as our Dub

track. We can use the 'Add >>' and '<< Remove' buttons to change this if needed.

· Our output is set to Automatic. With this setting, Revoice will create a new track for our

output aligned audio.

Click the 'New Process' button or press the N key to add the Match...

..., which generates the following output on track 'Double Vocal [OUT]'. To audition the quality of the

aligned output in Revoice Pro, press the key E and press the space bar.

The ARA interface will automatically map the output of the Match process for the Dub signals back to the

corresponding audio items in Pro Tools.

In Pro Tools you can listen to the quality of alignment by listening to the Lead Vocal and Lead Vox High

Chorus tracks together.
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Rendering Audio

If  you need to create a permanent version of the aligned signals, select the Render option in either the

Clip right-click menu, or in the Clip file menu under Revoice Pro Link -> Render.
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7.5.1.2. Audio Suite/AAX (Pro Tools)

Workflows » How to work with your DAW » Pro Tools » Audio Suite/AAX (Pro Tools) 

Revoice Pro 4 & Pro Tools – your guide to getting started

The Pro Tools AudioSuite/AAX Link plug-in can capture audio tracks from Pro Tools (PT) to Revoice Pro

(RVP), optionally create RVP processes automatically, then transfer (render) the processed audio back

to a selected PT track. Basic instructions are shown in plug-in control window. You can build up complex

RVP sessions and make manual adjustments to RVP processes before rendering the processed tracks

one-by-one back to selected PT tracks.

Pro Tools setup
Before using the AudioSuite/AAX Link plug-in, make sure in Pro Tools that the Session Setup window

shown below (found in the Pro Tools Setup menu under Session) is set either to 00:00:00:00 or to a

desired timecode offset.

This Pro Tools Session Start offset will be added to the captured audio start timecode and be used as

the timecode start in Revoice Pro.

The Sample Rate settings for the Pro Tools Session and the Revoice Pro Session need to be the same.
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Opening the Link plug-in
Select Revoice Pro Link in the Pro Tools Audio Suite > Other plug-in menu, shown below.

Once selected, you will see the Revoice Pro Link plug-in control window (below). At the top are the

standard plug-in controls. Detailed information about header controls is available in the Pro Tools Help

system.
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The only plug-in settings that are reliably supported for transfer of audio are "create continuous file" and

"entire selection", which essentially grabs everything you have selected and makes one continuous

audio file for use in RVP. (From PT 12.6 no other modes of operation can be selected with Revoice Pro

Link.)

"Use in Playlist" must be turned on (blue) if processed audio from RVP is to be successfully rendered

back to Pro Tools and appear in the session playlist (as opposed to the list of available clips).
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Opening and showing Revoice Pro
There is a button in the plug-in window that enables you to Start Revoice if it is not already open, or to

Show RVP if it is open and you want to reveal its session window:

Creating and pairing sessions
The Link plug-in works by pairing your Pro Tools (PT) session with a new or existing Revoice Pro (RVP)

session. This way, you can build up a complex RVP session and save it for subsequent use alongside

the related PT session. It does this by saving the full file path of the PT session in the RVP session. If

you rename or move the PT session the RVP session will need to be paired with it again.

New session
To create a new Revoice session, paired with the current PT session, press New in the plug-in window:
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Existing session
To link to a previously saved and paired RVP session, go to RVP and open the saved RVP session.

Re-pairing sessions
To re-connect to an existing RVP session (in case the pairing has been lost for some reason), open the

session in RVP, turn on the green Link button in RVP, then select Pair in the plug-in window:

Plug-in control window
Once an RVP session has been created or paired, you will see the audio capture and rendering

functions in the Link plug-in control window, shown below, which are described in detail in the following

sections. Essentially, audio from PT has first to be captured by RVP, a process created in RVP (plug-in

Functions can do this automatically), and the processed audio rendered (transferred) back to a selected

PT track.
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Revoice Pro Link Switch

To transfer audio using any of the Link Plug-ins to Revoice Pro, the Revoice Pro Link Switch must be

ON (green as shown above) in the destination Revoice Pro Session window.

Otherwise, the Link plug-ins will display an error message.

Only one Revoice Pro Session can have this switch ON at a time.

Next

Topics in this section: 

Capturing audio from Pro Tools using the link plug-in

Apply a Process

Transferring the audio back to ProTools using the link plug-in
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Revoice Pro 4 & Pro Tools – your guide to getting started
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7.5.1.2.1. Capturing audio from Pro Tools using the link plug-in

Workflows » How to work with your DAW » Pro Tools » Audio Suite/AAX (Pro Tools) » Capturing audio

from Pro Tools using the link plug-in 

From Revoice Pro 4.3, the Pro Tools Link plug-in has a number of capture modes to choose from, in a

drop-down menu labelled Mode. The controls lower down the plug-in control window will change

depending on the mode selected.

· Capture Only: only captures audio to a selected RVP track. You can then create processes as

normal within Revoice.

· Capture & Make Match/Doubler/Adjust: captures audio to selected RVP tracks and creates a

new RVP process using the selected Preset.

If you only want to capture audio, and create your own processes in RVP, select Capture Only from the

drop-down Mode, select source audio in a PT track, choose an RVP track to send it to, and press

Capture Audio.

· This capture process can be repeated a number of times to capture various chunks of source

audio to different RVP tracks.

· Now go to RVP and Apply a Process. 

· To return audio to PT see Transferring the audio back to ProTools using the link plug-in.
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Capture audio and create a process
automatically
The description below refers to capture of audio, and the automatic creation of a Match process. Similar

points apply when using the Doubler or Adjust processes, but only one PT track is captured.

From the Mode drop-down menu, select Capture & Match Timing / Pitch / Level.

Select a suitable RVP preset from the drop-down Preset menu.

Select the audio in Pro Tools to be used as the Guide (if you haven't already done so) as shown below.
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In the plug-in window, select the RVP audio track to which the Guide should be captured (the orange 2

arrow shown below).

Click Capture Guide in the plug-in window (the orange 3 arrow shown above). This will send the

selected audio to the Revoice Pro (RVP) Session.

Select the audio in Pro Tools to be used as the Dub.
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In the plug-in window shown above, select the RVP audio track to which the Dub should be captured

(the orange 4 arrow shown in the plug-in window above).

Click Capture Dub in the plug-in window to load the Dub audio into RVP (the orange 5 arrow shown in

the plug-in window above).

A Match Process track is automatically created with the Preset settings you chose.

If desired, you can then make any adjustments in RVP, see Apply a Process. 

To return processed audio to PT see Transferring the audio back to ProTools using the link plug-in.

Previous        Next
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7.5.1.2.2. Apply a Process

Workflows » How to work with your DAW » Pro Tools » Audio Suite/AAX (Pro Tools) » Apply a Process 

If the plug-in capture mode was set only to Capture Only, you will now need to go to the RVP session

and create your own RVP processes using the detailed instructions described in the Processes section.

With any of the other Link plug-in capture modes, a Revoice Pro process is created automatically after

the audio has been captured from Pro Tools.

You can optionally ignore, inspect, or audition the processing that has taken place in the Revoice Pro

session. However, nothing further has to be done in the Revoice Pro window.

Detailed aspects of the various RVP Processes are described in Processes.

If you do need to change the detailed processing settings, you can open the Process Control Panel

(Match, Doubler or Adjust, depending on the capture mode in question) by selecting the Revoice Pro

window and, with the Process Control Blocks selected, press P to open the Process Control Panel. Then

change the settings and press the Space Bar, if necessary, to re-process and audition the audio. If it is

OK, you can optionally save the new settings as a Preset for the next process or simply go to the next

step.

You can also change the RVP Preset, either in the Process Control Panel, or using the drop-down menu

in the Pro Tools plug-in window. The processing will change accordingly, but the processed audio will

need to be rendered again to Pro Tools, as described in the next step.

Previous         Next
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7.5.1.2.3. Transferring the audio back to ProTools using the link plug-in

Workflows » How to work with your DAW » Pro Tools » Audio Suite/AAX (Pro Tools) » Transferring the

audio back to ProTools using the link plug-in 

The AudioSuite/AAX Link plug-in can instantly transfer a single processed audio region at a time from

RVP to the correct timecode in a designated PT track. This is an extremely quick method for transferring

processed regions individually.

If you have captured audio from PT to RVP using a Preset and one of the automatic process creation

modes (Match/Double/Adjust), and not subsequently done anything to change selected audio in RVP,

the processed output will be automatically selected in RVP and you can render the result directly back to

PT.

Otherwise, you may need to make sure that the desired processed output is selected in RVP before

rendering it back to PT.

Use one of the methods described below before pressing Render Aligned in the plug-in window, upon

which the selected processed audio will be sent back to PT.

· Do nothing if you want the processed audio to return to PT into the track and position of any

audio that is still selected in PT.

· Use the plug-in's track selection to select another track (Audio 3 is shown below in this

example). You must have a time period or clip selected/highlighted in Pro Tools, but it doesn't

seem to matter what, as the audio will be rendered to the track selected in the plug-in window,

and in sync with the original content).

· If “no track selected” is displayed in the plug-in header, instead of a track, manually select an

area in any Pro Tools track. The audio will be rendered to that track, but in sync with the original

content.
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"Use in Playlist" must be turned on (blue) if processed audio from RVP is to be successfully rendered

back to Pro Tools and appear in the session playlist (as opposed to the list of available clips).

Press Render Aligned. The processed audio will be sent to the Pro Tools track selected.

Previous         Next
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7.5.1.3. Quick Mode

Workflows » How to work with your DAW » Pro Tools » Quick Mode 

The Pro Tools "Quick" AudioSuite plug-ins can be used to apply a single Revoice Pro (RVP) process

(Match or Doubler) to selected audio, and return the processed result to Pro Tools (PT). 

When using these plug-ins, a temporary Session is created in Revoice Pro named >Quick

Match/Doubler<. This session can only contain one process and one piece of audio in each track. When

you add new audio to a track, the previous audio is removed. In many cases, because the actions taking

place in the Revoice Pro program are totally automated, using the preset selected in the plug-in window,

the Revoice Pro window can actually be ignored. 

Once audio is captured, you have the option to modify any of Revoice Pro's settings to change or

improve the results, but you must render the result again using the quick plug-in button in order to return

the audio to Pro Tools. The temporary Revoice Pro session will lose any changes once new audio is

captured or the temporary session is closed, except for changes saved to the User Presets.

Pro Tools setup
Check the Pro Tools session setup before using the plug-in, using the same principles as described in

the AudioSuite/AAX Link plug-in section.

Opening the Quick plug-in
Select Revoice Pro Quick Match (or Doubler) from the PT Audio Suite > Other plug-in menu,

shown below.
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Once selected, you will see the Revoice Pro Link plug-in control window (below). At the top are the

standard plug-in controls. Detailed information about header controls is available in the Pro Tools Help

system.
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"Use in Playlist" must be turned on (blue) if processed audio from RVP is to be successfully rendered

back to Pro Tools and appear in the session playlist (as opposed to the list of available clips).

Opening and showing Revoice Pro
There is a button in the plug-in window that enables you to Start RVP if it is not already open, or to Show

RVP if it is open and you want to reveal its session window:
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Basic steps
The following simple approach will work in many cases (Match example). More detailed instructions are

given in the next sections.

With the Quick Match Plug-in window open in Pro Tools:

1. Select a suitable RVP preset from the drop-down menu in the plug-in window.

2. Select the Guide Audio in Pro Tools and press Capture Guide.

3. Select the Dub Audio in Pro Tools and press Capture Dub.

4. Return the RVP-processed audio to Pro Tools by pressing Render Aligned.

(Depending on the current Pro Tools track and region selection, the audio can replace the selected Dub

audio or be placed into a separate track, in which case an appropriate region needs to be selected.

RVP, though, will always attempt to render the aligned audio in appropriate sync with the original

material.)

Topics in this section:

Capturing audio

Apply a Process

Transfer the audio back to Pro Tools



Revoice Pro 5 Manual Publication8

174

 

Using Revoice Pro 4's Quick Match plug-in for super-fast alignment of timing and pitch

Using Revoice Pro 4's Quick Doubler plug-in with Pro Tools

Related topics:

Setting up Revoice Pro Monitor plug-in Pro Tools

Latest information on Revoice Pro with Pro Tools

Previous           Next
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7.5.1.3.1. Capturing audio

Workflows » How to work with your DAW » Pro Tools » Quick Mode » Capturing audio 

This description refers to the Match process. Similar points apply when using the Doubler process, but

only one Pro Tools track is captured.

Select a suitable Revoice preset from the drop-down Preset menu.

Select the audio in Pro Tools to be used as the Guide (if you haven't already done so) as shown below.
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Click Capture Guide in the plug-in window (orange arrow 2 shown below). This will send the selected

audio to the Revoice Pro Session.

Select the audio in Pro Tools to be used as the Dub.
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Click Capture Dub in the plug-in window (orange arrow 4 in the plug-in window above) to load the Dub

audio into Revoice.

A Match process track is automatically created in the Revoice session, with the preset settings you

chose.

Previous        Next

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.



Revoice Pro 5 Manual Publication8

178

7.5.1.3.2. Apply a Process

Workflows » How to work with your DAW » Pro Tools » Quick Mode » Apply a Process

With the Pro Tools "Quick" plug-ins, a Revoice Pro process is created automatically after the audio has

been captured from Pro Tools.

You can optionally ignore, inspect, or audition the processing that has taken place in the Revoice Pro

session. However, nothing further has to be done in the Revoice Pro window.

Detailed aspects of the various RVP Processes are described in Processes.

If you do need to change the detailed processing settings, you can open the Process Control Panel

(Match or Doubler) by selecting the Revoice Pro window and, with the Process Control Blocks selected,

press P to open the Process Control Panel. Then change the settings and press the Space Bar to re-

process and audition the audio. If it is OK, you can optionally save the new settings as a Preset for the

next process or simply go to the next step.

You can also change the RVP Preset, either in the Process Control Panel, or using the drop-down menu

in the Pro Tools plug-in window. The processing will change accordingly, but the processed audio will

need to be rendered again to Pro Tools, as described in the next step.

Previous        Next
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7.5.1.3.3. Transfer the audio back to Pro Tools

Workflows » How to work with your DAW » Pro Tools » Quick Mode » Transfer the audio back to Pro

Tools

Use one of the methods below before pressing Render Aligned, upon which the processed audio will be

sent to the Pro Tools track selected.

· Do nothing if you want the processed audio to return to Pro Tools into the track and position of

the Dub audio in Pro Tools (if it is still selected).

· Use the Quick Match Audio Suite plug-in track selection to select another track (Audio 3 is

shown below in this example). You must have a time period or clip selected/highlighted in Pro

Tools, but it doesn't seem to matter what, as the audio will be rendered to the track selected in

the plug-in window, and in sync with the original content).

· If “no track selected” is displayed instead of a track, manually select an area in any Pro Tools

track. The audio will be rendered to that track, but in sync with the original content.

"Use in Playlist" must be turned on (blue) if processed audio from RVP is to be successfully rendered

back to Pro Tools and appear in the session playlist (as opposed to the list of available clips).

Press Render Aligned. The processed audio will be sent to the Pro Tools track selected.

We can see the output here below the Guide and Dub track as the red audio region titled 'Revoice

Output-Match_01'
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Previous         Next
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7.5.2. Ableton Live

Workflows » How to work with your DAW » Ableton Live

Ableton Live

With Revoice Pro 5, we suggest using the VST3 non-ARA Link plugin discussed in the Revoice Pro Link

Plug-ins section.

Next
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7.5.3. Studio One

Workflows » How to work with your DAW » Studio One 

With Revoice Pro 5 there are two efficient ways of working with Studio One:

Copy and Paste, which is simple to use and fast to set up. 

ARA, which uses a plug-in to synchronize audio regions between Studio One and Revoice Pro.

    

· The current ARA drag-and-drop from the right-hand Browse -> Effects menu

· ARA (Legacy) accessed via the Edit with Revoice Pro command in the Audio menu

Once Studio One releases an update to modify the Edit with Revoice Pro command, both methods will

apply the most up to date workflow described in the non-Legacy section.

Alternatively you can try the VST3 Link plug-in.

Next

Topics in this section:

Copy and Paste

ARA (Audio Random Access)

Related topics:

Latest information on Revoice Pro with Studio One
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7.5.3.1. ARA (Audio Random Access)

Workflows » How to work with your DAW » Studio One » ARA (Audio Random Access)

From version 4.1 of Studio One, there is a new, more versatile way of processing audio in Revoice Pro.

The Audio Random Access (ARA for short) interface allows plug-ins and DAWs to integrate much more

thoroughly with each other. Revoice Pro supports the new ARA 2 standard that allows a better and

much faster exchange of information. 

This section describes how to work with the ARA plugin accessed via the Event FX menus. You can also

Drag-and-Drop from the Effects menu in the Browse section of the Studio One UI.

Once Studio One releases an update to modify the Edit with Revoice Pro command, both methods will

apply the most up to date workflow described in this section.

When working with Revoice Pro and Studio One, ARA has the following advantages:

· There is immediate transfer of audio between the DAW and Revoice Pro.

· It keeps the names and timings of all linked audio events. 

· Linking the output of any process in Revoice Pro to an audio event allows immediate replay in

the DAW of Revoice Pro's processing.

· You can open and save the whole project using the DAW's commands Open, Save, Save as..

 Not only will these commands save and load DAW data but they will also save and load the

Session data from Revoice Pro. Revoice Pro Session data is usually stored in the same folder

as DAW data, making any project with ARA much more portable and re-editable.

Previous           Next
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7.5.3.1.1. Capturing Audio

Workflows » How to work with your DAW » Studio One » ARA (Audio Random Access) » Capturing

Audio

This section shows you how to transfer audio from a project in Studio One to Revoice Pro 5 using the

ARA Link plug-in. As shown below, we have a session with two tracks:

· GUIDE: The yellow Lead Vocal track

· DUB: The orange Double Vocal track

In your own session, decide which track is your GUIDE, and which is your DUB. Your GUIDE is the

audio to which your DUB will be aligned. For example, your Lead Vocal will typically be your Guide

track, while a back up vocal would be the Dub. 

In order to use the newest ARA workflow in Studio One, right click your GUIDE event as shown below,

and select 'Event FX -> Revoice Pro Link'. You can also access Event FX from the Clip menu in the
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Studio One top bar, or with your guide region selected, from the Audio sub-menus. See Studio One's

documentation on Event FX for more information.

This will add Revoice Pro as an Event FX on the region, and open the plugin window. Add the Revoice

Pro Link Event FX to all of the regions/events that you would like to work with in Revoice Pro.

If Revoice Pro is not yet running, you will see the below plugin window. If this is the case, click Start Rv

in the top right hand corner to open Revoice Pro.
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Once Revoice is running, or if it was already running, the plugin window will appear as in the below

image.

The 'Mode' dropdown menu will be discussed in the next section, but for now we will work with the

Capture Only mode.

First, select the region that you would like to import into Revoice Pro. In this case, we will import Lead

Vocal GUIDE. Once you have selected your Guide region, click Capture Audio in the plugin window as

indicated in the below image.
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Repeat this process with your DUB region, in our case Double Vocal DUB.

If you open your Revoice Pro project window, or click the Show Rv button in the top right of the plugin

window, you should see something similar to the below. Revoice has created two new tracks, one called

Lead Vocal GUIDE and the other called Double Vocal DUB. The tracks are ready to be processed

further within Revoice.
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Any tracks that Studio One has created in Revoice Pro are automatically locked. The red padlock  

  in the track's status area indicates this. Although you cannot edit any of the linked audio directly in

Revoice Pro (as the track is locked), the ARA interface synchronizes each audio segment in Revoice

Pro with its linked audio in Studio One.

Previous       Next
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7.5.3.1.2. Applying a Process

Workflows » How to work with your DAW » Studio One » ARA (Audio Random Access) » Applying a

Process

As of Revoice Pro 5, the Link plugin has a Mode menu item. The Mode allows the user to both Capture

audio and apply a Process immediately within Revoice, and helps to make standard workflows more

efficient. Here, we will discuss how to use the Mode menu feature, and then discuss creating a process

in Revoice after using Capture Only.

Capture and Process Modes
In the Revoice Pro Link plugin window, click the Mode dropdown menu and select Capture & Match

Timing / Pitch / Level.

The Revoice Pro Link plugin window will change to give you some new options.

In the above image we can see we now have a few new options.
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· Preset will allow us to choose any of our presets to apply to this new process.

· Select Guide and Select Dub will allow us to capture our audio regions into Revoice Pro.

First, select your Guide audio region in Studio One, in this case Lead Vocal GUIDE, and then click

Capture Guide in the Revoice Pro Link plugin window.

Repeat the same process but select the DUB region, here Double Vocal DUB, in your DAW and click

Capture Dub, just below Capture Guide.
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Now in your Revoice project window, you can see the process that has been created as shown below.

You can listen back in Revoice or in your DAW to hear the Matched audio.
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Applying a Process in Revoice Pro
If you have used the Capture only Mode, as done in the previous topic, you can continue with the

following instructions to apply a process within Revoice

In this example we are going to use a Match (see Match Process for more details) to align the Dub

signal Double Vocal DUB to the Guide signal Lead Vocal GUIDE.

First, in Revoice Pro select the Guide signal (Lead Vocal GUIDE) in the first audio track by clicking the

waveform area. The audio waveform will turn light grey to indicate it is selected.
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Next, right click in the Process Control track and select Match Timing / Pitch / Level. This will open the

New Process Window.

Below we can see the New Process window that opens upon selecting Match Timing / Pitch / Level.
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Revoice has made a few automatic choices for us, and for standard use these defaults will typically work

well.
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· Our Initial Input Start & End is set to Selected Audio, meaning that his process will apply

to all audio within the selected region.

· Revoice has also selected Lead Vocal GUIDE as our Guide track, and Double Vocal DUB

as our Dub track. We can use the 'Add >>' and '<< Remove' buttons to change this if

needed.

· Our output is set to Automatic. With this setting, Revoice will create a new track for our

output aligned audio.

Click the 'New Process' button or press the N key to add the Match...

..., which generates the following output on track Double Vocal DUB [OUT].To audition the quality of the

aligned output in Revoice Pro, press the key E and press the space bar.

The ARA interface will automatically map the output of the Match process for the Dub signals back to the

corresponding audio items in Studio One.

In Studio One you can listen to the quality of alignment by listening to the Guide and Dub tracks

together.
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If  you need to create a permanent version of the aligned signals, use Studio One's 'Bounce Selection'

option by right-clicking the audio region in Studio One and going to the 'Event' sub-menu, then selecting

'Bounce Selection'

Previous        Next
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7.5.3.2. ARA (Legacy)

Workflows » How to work with your DAW » Studio One » ARA (Legacy) 

From version 4.1 of Studio One, there is a new, more versatile way of processing audio in Revoice Pro.

The Audio Random Access (ARA for short) interface allows plug-ins and DAWs to integrate much more

thoroughly with each other. Revoice Pro supports the new ARA 2 standard that allows a better and

much faster exchange of information. 

This section describes how to work with the ARA (Legacy) plugin accessed via Edit with Revoice Pro

in the Audio menu.

Once Studio One releases an update to modify the Edit with Revoice Pro command, both methods will

apply the most up to date workflow described in the non-Legacy section.

When working with Revoice Pro and Studio One, ARA has the following advantages:

· There is immediate transfer of audio between the DAW and Revoice Pro.

· It keeps the names and timings of all linked audio events. 

· Linking the output of any process in Revoice Pro to an audio event allows immediate replay in

the DAW of Revoice Pro's processing.

· You can open and save the whole project using the DAW's commands Open, Save, Save as..

 Not only will these commands save and load DAW data but they will also save and load the

Session data from Revoice Pro. Revoice Pro Session data is usually stored in the same folder

as DAW data, making any project with ARA much more portable and re-editable.

Previous       Next

Topics in this section:

Capturing Audio

Apply a Process

Studio One Professional 4.1 & Revoice Pro 4 - getting started using ARA2

https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started
https://www.synchroarts.com/videos/studio-one-professional-4-1-revoice-pro-4-getting-started


Revoice Pro 5 Manual Publication8

198

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.



Revoice Pro 5 Manual Publication8

199

7.5.3.2.1. Capturing Audio

Workflows » How to work with your DAW » Studio One » ARA (Legacy) » Capturing Audio 

This section shows you how to transfer audio from a Song in Studio One 6 to Revoice Pro using the

ARA link (Legacy) plug-in. 

Once you have loaded (or created) your song, select the Audio Events in Studio One that you want to

transfer to Revoice Pro. In this example we've selected the Lead Vocal GUIDE to be our Guide audio,

and Double Vocal DUB to be our Dub audio. 
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You can select all the audio events with which you would like to work at once. For the sake of simplicity,

we are only working with two tracks.

Next, from Studio One's Audio Menu, select Edit with Revoice Pro.

This will add the Revoice Pro Link (Legacy) plugin to all of the events.

Each Audio Event in Studio One will show a small "Fx" its lower left corner. Clicking the "Fx" will show

you the name of the Fxs that you have added. 
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Clicking a name of the plug-in will reveal that plug-in's window. 

Once you have added Revoice Pro Link, Studio One will display each plug-in labelled with the name of

its associated audio event. In this example its label is  'Lead Vocal GUIDE'. 

If Revoice Pro is not running, you will see the message "Press the Start button to run Revoice Pro" at the

bottom of the plug-in's window. 

If Revoice Pro is not running, press in the plug-in's window.
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When Revoice Pro is running the Start button becomes a Show button. Press Show in the plug-in to

bring Revoice Pro to the foreground on your screen.

The plug-in will also show ARA 2 in its lower left corner to confirm that it has been configured as an ARA

plug-in.

As soon as Revoice Pro is running, Studio One will open a new session in Revoice Pro, create any new

tracks (if needed) and copy the linked Audio Event(s) to Revoice Pro. The new session in Revoice Pro

will have the same name as the Song's, which in this example is Revoice Pro with Studio One Start.

Each track in Revoice Pro will have the same name (and colour) as the corresponding track in Studio

One.
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Once Studio One has opened a session in Revoice Pro, Link icon in each plug-in's window will glow

green. This indicates that Revoice Pro will try to mirror the position  and audio content of all linked Audio

Events (Lead Vox 1 and Lead Vox 2 in this example). In other words if you change the Audio Event Lead

Vox 2 in Studio One, any changes will be transferred across to the session in Revoice Pro. 

Any tracks that Studio One has created in Revoice Pro are automatically locked. The red padlock in

Revoice Pro's track status area indicates this. Although you cannot edit any of the linked audio directly in

Revoice Pro (as the track is locked), the ARA interface will synchronize each audio segment in Revoice

Pro with its linked Audio Event in Studio One.

For example, moving the first Dub audio event a few seconds earlier...  
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...results in the linked Dub audio in Revoice Pro also being moved to the new time.

Notes:

1. To unlock a track, it is necessary to remove the Revoice Pro Link plug-in from all the Audio

Events in the corresponding track in Studio One. For example, if you need to unlock track Audio

1 in Revoie Pro, in Studio One you will need to remove the Revoice Pro Link plug-in from Audio

Event LEAD VOX 1.

In Studio One use the menu function Audio->Remove Revoice Pro to remove the plug-ins from selected

Audio Events  efficiently.
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2. You may want to stop a track in Revoice Pro from automatically following changes in Studio

One. To stop the automatic updating in Revoice Pro, click Link click the Link icon , in the Link

plug-in's window. The icon will turn grey and the track in Revoice Pro will no longer follow

any changes that you make in Studio One.

Previous        Next
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7.5.3.2.2. Applying a Process

Workflows » How to work with your DAW » Studio One » ARA (Legacy) » Applying a Process 

This topic shows you how to apply a Process to the captured (transferred) audio in Revoice Pro and how

to replay the processed audio seamlessly in Studio One.

We start from the end of the previous topic (Capturing Audio) where we created a simple project by

transferring two simple (short) tracks to Revoice Pro from Studio One.

In this example we are going to use a Match (see Match Process for more details) to align the Dub

signal (Double Vocal DUB)  to the Guide signal (Lead Vocal GUIDE).

First, in Revice Pro select the Guide signal by clicking in the waveform area of the Lead Vocal GUIDE

track. The audio waveform will turn light grey to indicate it is selected.
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Right click in the Process Control Track and select Match Timing / Pitch / Level.

This will open the New Process Window shown below. It can be shown and hidden with the B keyboard

shortcut.
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Revoice has made a few automatic choices for us, and for standard use these defaults will typically work

well.

· Our Initial Input Start & End is set to Selected Audio, meaning that his process will apply

to all audio within the selected region.

· Revoice has also selected Lead Vocal GUIDE as our Guide track, and Double Vocal DUB

as our Dub track. We can use the 'Add >>' and '<< Remove' buttons to change this if

needed.
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· Our output is set to Automatic. With this setting, Revoice will create a new track for our

output aligned audio.

Click the 'New Process' button or press the N key to add the Match...

..., which generates the following output on track Double Vocal DUB [OUT].To audition the quality of the

aligned output in Revoice Pro, press the key E and press the space bar.

The ARA interface will automatically map the output of the Match process for the Dub signals back to the

corresponding audio items in Studio One.

In Studio One you can listen to the quality of alignment by listening to the Guide and Dub tracks

together.

If  you need to create a permanent version of the aligned signals, you use the Bounce Selection function

of Studio One on the Dub audio region/event. The rendered output has the advantage of showing

accurate waveforms in Studio One's Audio Events. 
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7.5.3.3. Copy and Paste

Workflows » How to work with your DAW » Studio One » Copy and Paste 

From version 3.3.2.4 of Studio One, there are new, faster ways of capturing and processing audio. We

will call these "Quick Match, Quick Doubler and Quick Adjust for Studio One".

In this high-speed simplified work flow, you select the regions to be processed in Studio One, then paste

them using a special function into Revoice Pro. Tracks, Groups and basic Processes are created

automatically, and you can then tweak the settings for Match, Doubler or Adjust operations as you wish.

You then copy either selected or all process outputs using a special function and paste them back into

the Studio One session at the original positions.

Next

Topics in this section:

Capturing audio

Apply a Process

Transfer the audio back to Studio One

Studio One and Revoice Pro 3.3 – your guide to getting started

Using Revoice Pro’s Quick Match and Quick Doubler in Studio One
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7.5.3.3.1. Capturing audio

Workflows » How to work with your DAW » Studio One » Copy and Paste » Capturing audio 

Ensure that Copy & Paste DAW in Revoice Pro's View > Settings menu is set to Studio One.

Select the regions to be captured in Studio One either by...

(a) Clicking the first region, and shift-clicking subsequent ones (the first to be selected becomes the

Guide, the rest the Dub tracks).

(b) Highlighting the regions by dragging across them (the top track becomes the Guide).

In Studio One, Copy the selected regions to the Clipboard
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7.5.3.3.2. Apply a Process

Workflows » How to work with your DAW » Studio One » Copy and Paste » Apply a Process 

Paste the regions into Revoice Pro using the special Paste - Quick Match/Doubler/Adjust function in the

Revoice Pro Edit menu. In this case Quick Match is chosen.

Keyboard shortcuts are:

· Quick Match Cmd + Shift + A

· Quick Doubler Cmd + Shift + D

· Quick Adjust Cmd + Shift + W

Cmd = ctrl for Windows.
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The regions appear in Revoice Pro tracks, and the processed tracks are automatically created with

basic settings.

You can now adjust the settings of the processes if you wish, as explained in the Processes chapters.

Previous          Next 
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7.5.3.3.3. Transfer the audio back to Studio One

Workflows » How to work with your DAW » Studio One » Copy and Paste » Transfer the audio back to

Studio One 

Once you are satisfied with the sound of the process, in Revoice Pro Edit menu, Copy - All Process

Outputs (to transfer everything processed in Revoice) or Copy - Selected Process Output (to transfer

only the process you have selected).

Keyboard shortcuts are Cmd + Shift + L or Cmd + Shift + O respectively.

In Studio One, use Paste at Original Position in the Edit menu to put the processed audio back into the

Dub tracks, starting at the original time.

The name of the processed region has "Match" (in this case) before it to denote that processing has

been applied. (Note that the original regions will still be there underneath the pasted processed versions,

so you may need to delete them if they extend beyond the boundaries of the processed region.)
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7.5.4. Cubase/Nuendo

Workflows » How to work with your DAW » Cubase/Nuendo 

Cubase/Nuendo

From Revoice Pro 4.1 there are two efficient ways of working with Cubase or Nuendo:

Drag and Drop , which is simple to use and fast to set up. 

ARA (Audio Random Access), which uses a plug-in to synchronize audio regions between Cubase Pro

and Revoice Pro.     

Alternatively you can try the VST3 Link plug-in.

Also, a VST3 Revoice Pro Monitoring plug-in is included with Revoice Pro that, once installed, allows

you to hear audio playback from Revoice Pro through the DAW's audio outputs. It also lets Revoice Pro

optionally lock to the DAW's playback with sample-accurate sync. This lets you check processed audio

"in place" with DAW audio and video before you transfer it from Revoice Pro back to the DAW.

Previous         Next 
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7.5.4.1. ARA (Audio Random Access)

Workflows » How to work with your DAW » Cubase/Nuendo » ARA (Audio Random Access)

As of Revoice Pro 5, the ARA Revoice Pro Link plugin has been updated with a new workflow. If you

prefer to use the older workflow, it is still available and covered in the ARA (Legacy) section.

From version 10.0.30 of Cubase Pro and from version 10.1 of Nuendo, there is a new, more versatile

way of processing audio in Revoice Pro. 

The Audio Random Access (ARA for short) interface allows plug-ins and DAWs to integrate much more

thoroughly with each other. Revoice Pro supports the new ARA 2 standard that allows a better and

much faster exchange of information. 

When working with Revoice Pro and Cubase Pro, ARA has the following advantages:

· There is immediate transfer of audio between the DAW and Revoice Pro.

· It keeps the names and timings of all linked audio events. 

· Revoice Pro remains synchronised with all linked audio events. For example, if you change the

starting time of an audio event in the DAW, the corresponding audio region in Revoice Pro will

move to the new starting time.

· Linking the output of any process in Revoice Pro to an audio event allows immediate replay in

the DAW of Revoice Pro's processing.

· You can open and save the whole project using the DAW's commands Open, Save, Save as..

 Not only will these commands save and load DAW data but they will also save and load the

Session data from Revoice Pro. Revoice Pro Session data is usually stored in the same folder

as DAW data, making any project with ARA much more portable and re-editable.

Next
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7.5.4.1.1. Capturing Audio

Workflows » How to work with your DAW » Cubase/Nuendo » ARA (Audio Random Access) » Capturing

Audio

This section shows you how to transfer audio from a project in Cubase to Revoice Pro 5 using the

ARA Link plug-in. 

We will work with two example tracks:

· Lead Vocal GUIDE: This will function as our Guide track

· Double Vocal DUB: This will function as our Dub track, or the track which will be aligned to

the Guide

Choose two pieces of audio to be your Guide and Dub. A comman example would be a Lead Vocal as

the Guide and a Backup Vocal as a Dub track.

In order to use the newest ARA workflow in Cubase, we will first select the audio regions that we want to

work with. In this case, Lead Vocal GUIDE and Double Vocal DUB.
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Next, we will select the Revoice Pro Link VST3 plugin from the Cubase Extensions in the Audio menu,

shown below. We could also right-click or ctrl-click a region and select the Revoice Pro Link VST3 plugin

from the Extensions menu item.
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This will add Revoice Pro as an Extension on each region, and open the plugin window docked in the

edit panel. If Revoice Pro is not yet running, you will see the below plugin window. If this is the case,

click Start Rv in the top right hand corner to open Revoice Pro.
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Once Revoice is running, or if it was already running, the plugin window will appear as in the below

image.
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The 'Mode' dropdown menu will be discussed in the next section, but for now we will work with the

Capture Only mode. Click the Mode drop down and switch to Capture Only if that mode is not already

selected.

First, make sure your Guide and Dub regions are selected. Here, we will select Lead Vocal GUIDE and

Double Vocal DUB. Then click the Capture Audio button in the Revoice Pro Link plugin window.
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If you open your Revoice Pro project window, or click the Show Rv button in the top right of the plugin

window, you should see something similar to the below. Revoice has created two new tracks, one called

Lead Vocal GUIDE and the other called Double Vocal DUB. The tracks are ready to be processed

further within Revoice.
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Any tracks that Cubase has created in Revoice Pro are automatically locked. The red padlock     in

the track's status area indicates this. Although you cannot edit any of the linked audio directly in Revoice

Pro (as the track is locked), the ARA interface synchronize each audio segment in Revoice Pro with its

linked audio in Cubase.

Previous Next
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7.5.4.1.2. Applying a Process

Workflows » How to work with your DAW » Cubase/Nuendo » ARA (Audio Random Access) » Applying

a Process

As of Revoice Pro 5, the Link plugin has a Mode menu item. The Mode allows the user to both Capture

audio and apply a Process immediately within Revoice, and helps to make standard workflows more

efficient. Here, we will discuss how to use the Mode menu feature, and then discuss creating a process

in Revoice after using Capture Only.

Capture and Process Modes
In the Revoice Pro Link plugin window, click the Mode dropdown menu and select Capture & Match

Timing / Pitch / Level.

The Revoice Pro Link plugin window will change to give you some new options.

In the above image we can see we now have a few new options.

· Preset will allow us to choose any of our presets to apply to this new process.
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· Select Guide and Select Dub will allow us to capture our audio regions into Revoice Pro.

First, select your Guide audio region in Cubase, in this case Lead Vocal GUIDE and then click Capture

Guide in the Revoice Pro Link plugin window.

Repeat the same process but select the Double Vocal DUB region in your DAW, and click Capture Dub,

just below Capture Guide.
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Now in your Revoice project window, you can see the process that has been created as shown below.

You can listen back in Revoice or in your DAW to hear the Matched audio.
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Applying a Process in Revoice Pro
If you have used the Capture only Mode, as done in the previous topic, you can continue with the

following instructions to apply a process within Revoice

In this example we are going to use a Match (see Match Process for more details) to align the Dub

signal (Double Vocal DUB) to the Guide signal (Lead Vocal GUIDE).

First, in Revoice Pro select the Guide signal in the first audio track. To do so, click in the waveform area

of the Lead Vocal GUIDE track. The audio waveform will turn light grey to indicate it is selected.

Next, right click in the Process Control track and select Match Timing / Pitch / Level. This will open the

New Process Window.

Below we can see the New Process window that opens upon selecting Match Timing / Pitch / Level.
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Revoice has made a few automatic choices for us, and for standard use these defaults will typically work

well.

· Our Initial Input Start & End is set to Selected Audio, meaning that his process will apply

to all audio within the selected region.

· Revoice has also selected Lead Vocal GUIDE as our Guide track, and Double Vocal DUB

as our Dub track. We can use the 'Add >>' and '<< Remove' buttons to change this if

needed.

· Our output is set to Automatic. With this setting, Revoice will create a new track for our

output aligned audio.

Click the 'New Process' button or press the N key to add the Match...
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..., which generates the following output on track Double Vocal DUB [OUT].To audition the quality of the

aligned output in Revoice Pro, press the key E and press the space bar.

The ARA interface will automatically map the output of the Match process for the Dub signals back to the

corresponding audio items in Cubase.

In Cubase you can listen to the quality of alignment by listening to the Lead Vocal GUIDE and Double

Vocal DUB tracks together.

If  you need to create a permanent version of the aligned signals, use Cubase's 'Bounce Selection'

option by selecting the audio region and selecting 'Bounce Selection' in the Audio menu.
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7.5.4.2. ARA (Legacy)

Workflows » How to work with your DAW » Cubase/Nuendo » ARA (Legacy)

As of Revoice Pro 5, the ARA Revoice Pro Link plugin has been updated with a new workflow. This

section of the manual covers the Legacy Link plugin which is still available, should you prefer the older

workflow.

From version 10.0.30 of Cubase Pro and from version 10.1 of Nuendo, there is a new, more versatile

way of processing audio in Revoice Pro. 

The Audio Random Access (ARA for short) interface allows plug-ins and DAWs to integrate much more

thoroughly with each other. Revoice Pro supports the new ARA 2 standard that allows a better and

much faster exchange of information. 

When working with Revoice Pro and Cubase Pro, ARA has the following advantages:

· There is immediate transfer of audio between the DAW and Revoice Pro.

· It keeps the names and timings of all linked audio events. 

· Revoice Pro remains synchronised with all linked audio events. For example, if you change the

starting time of an audio event in the DAW, the corresponding audio region in Revoice Pro will

move to the new starting time.

· Linking the output of any process in Revoice Pro to an audio event allows immediate replay in

the DAW of Revoice Pro's processing.

· You can open and save the whole project using the DAW's commands Open, Save, Save as..

 Not only will these commands save and load DAW data but they will also save and load the

Session data from Revoice Pro. Revoice Pro Session data is usually stored in the same folder

as DAW data, making any project with ARA much more portable and re-editable.

Previous         Next
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7.5.4.2.1. Capturing Audio

Workflows » How to work with your DAW » Cubase/Nuendo » ARA (Legacy) » Capturing Audio 

This section shows you how to transfer audio from a Project in Cubase Pro to Revoice Pro using the

ARA link plug-in. We will be working with the session shown in the below image. 

We will work with two example tracks:

· Lead Vocal GUIDE: This will function as our Guide track

· Double Vocal DUB: This will function as our Dub track, or the track which will be aligned to

the Guide

Choose two pieces of audio to be your Guide and Dub. A comman example would be a Lead Vocal as

the Guide and a Backup Vocal as a Dub track.
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Once you have loaded (or created) your project, select the Audio Events in Cubase Pro that you want to

capture, that is transfer to Revoice Pro. In this example we've selected the vocal audio from the first two

tracks (see below). 

 

Note: It is possible to select all the audio in a project at once. To keep this example simple, we will work

with only two tracks.

Next, from Cubase's Audio Menu, select Extensions then from the list of extensions choose

RevoiceProLink. This will add the RevoicePro Link plug-in to all the selected audio events. You could

also right-click or ctrl-click the region, and select Revoice Pro Link from the Extensions menu item.
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(Similarly, selecting Remove Extension from selected Events from the Audio Menu will remove Revoice

Pro Link from all selected Audio Events.) 
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Each Audio Event in Cubase Pro will display a small symbol in its upper right corner and show its

ARA filename between parentheses. If you select your Guide Audio Event Cubase's information bar will

show RevoiceProLink under the heading 'Extension'.  

Once you have added Revoice Pro Link to an Audio Event  Cubase will display each plug-in in its lower

editor window. If Revoice Pro is not running, you will see the message "Press the Start button to run

Revoice Pro" at the bottom of the plug-in's window. 

If Revoice Pro is not running, press in the plug-in's window.
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When Revoice Pro is running the Start button becomes a Show button. Press Show in the plug-in to

bring Revoice Pro to the foreground on your screen.

The plug-in will also show ARA 2 in its lower left corner to confirm that it has been configured as an ARA

plug-in.

As soon as Revoice Pro is running, Cubase Pro will open a new session in Revoice Pro, create any new

tracks (if needed)  and copy the Audio Event(s) to Revoice Pro.  The new session in Revoice Pro will

have the same name as Cubase's project, which in this example is Revoice Pro with Cubase Start. Each

track in Revoice Pro will have the same name (and colour) as the corresponding track in Cubase.
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Once Cubase Pro has opened a session in Revoice Pro, Link icon in each plug-in's window will glow

green. This indicates that Revoice Pro will try to mirror the position  and audio content of all linked Audio

Events (Lead Vox 1 (...) and Lead Vox 2 (...) in this example). In other words if you change the Audio

Event Lead Vox 2 (...) in Cubase Pro, any changes will be transferred across to the linked session in

Revoice Pro. 

 

Any tracks that Cubase Pro has created in Revoice Pro are automatically locked. The red padlock  

 in the track's status area indicates this. Although you cannot edit any of the linked audio directly in

Revoice Pro (as the track is locked), the ARA interface will synchronize each audio segment in Revoice

Pro with its linked Audio Event in Cubase Pro.

Notes:

1. To unlock a track, it is necessary to remove the Revoice Pro Link plug-in from all the Audio

Events in the corresponding track in Cubase Pro. For example, if you need to unlock track Audio

1 in Revoice Pro, in Cubase Pro you will need to remove the Revoice Pro Link plug-in from

Audio Event Lead Vox 1 (...).

In Cubase Pro, use the menu function Audio->Extensions->Remove Extensions from Selected Events to

remove the link plug-ins from selected Audio Events  efficiently.

2. You may want to stop a track in Revoice Pro from automatically following changes in Cubase

Pro. To stop the automatic updating in Revoice Pro, click the Link icon , in the  plug-in's

window. The icon will turn grey and the corresponding track in Revoice Pro will no longer

follow any changes that you make in Cubase Pro.

Previous        Next
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7.5.4.2.2. Applying a Process

Workflows » How to work with your DAW » Cubase/Nuendo » ARA (Legacy) » Applying a Process 

Applying a Process in Revoice Pro
If you have used the Capture only Mode, as done in the previous topic, you can continue with the

following instructions to apply a process within Revoice

In this example we are going to use a Match (see Match Process for more details) to align the Dub

signal (Double Vocal DUB) to the Guide signal (Lead Vocal GUIDE).

First, in Revoice Pro select the Guide signal in the first audio track. To do so, click in the waveform area

of the Lead Vocal GUIDE track. The audio waveform will turn light grey to indicate it is selected.

Next, right click in the Process Control track and select Match Timing / Pitch / Level. This will open the

New Process Window.
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Below we can see the New Process window that opens upon selecting Match Timing / Pitch / Level.
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Revoice has made a few automatic choices for us, and for standard use these defaults will typically work

well.

· Our Initial Input Start & End is set to Selected Audio, meaning that his process will apply

to all audio within the selected region.

· Revoice has also selected Lead Vocal GUIDE as our Guide track, and Double Vocal DUB

as our Dub track. We can use the 'Add >>' and '<< Remove' buttons to change this if

needed.

· Our output is set to Automatic. With this setting, Revoice will create a new track for our

output aligned audio.

Click the 'New Process' button or press the N key to add the Match...
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..., which generates the following output on track Double Vocal DUB [OUT].To audition the quality of the

aligned output in Revoice Pro, press the key E and press the space bar.

The ARA interface will automatically map the output of the Match process for the Dub signals back to the

corresponding audio items in Cubase.

In Cubase you can listen to the quality of alignment by listening to the Lead Vocal GUIDE and Double

Vocal DUB tracks together.

If  you need to create a permanent version of the aligned signals, use Cubase's 'Bounce Selection'

option by selecting the audio region and selecting 'Bounce Selection' in the Audio menu.
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7.5.4.3. Drag and Drop

Workflows » How to work with your DAW » Cubase/Nuendo » Drag and Drop 

For a general description of using Drag and Drop in Cubase or Nuendo please see: Main rules for drag

and drop audio files.

To move multiple processed tracks (or a portion of multiple tracks) from Revoice Pro back to Nuendo or

Cubase at the same time, the Export Audio command [CMD E (Mac)/CTRL E (Windows)] can be used.

The files transferred from Nuendo or Cubase are not duplicated (saving storage space and

housekeeping) and clip names are maintained in both directions.

In this section, we explain how to set up Revoice Pro's Session variables to match the Nuendo/Cubase

project, and how to use the simple audio transfer methods and the monitoring plug-in.

NOTE: In the following instructions, the pictures shown are using Nuendo 6, but there are similar

windows and controls in Nuendo 5 and up and Cubase 5 and up that will match these instructions.

Previous         Next 
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Setting up Revoice Pro Monitor plug-in VST3

Latest information on Revoice Pro with Nuendo and Cubase
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7.5.4.3.1. Capturing audio

Workflows » How to work with your DAW » Cubase/Nuendo » Drag and Drop » Capturing audio 

You can transfer audio from Nuendo/Cubase to Revoice Pro using drag and drop. If there isn't room in

one computer screen to see multiple program windows, you can also Copy the audio in Nuendo/Cubase

and Paste into a Revoice Pro track.

· For a Match process, you will need to transfer two input signals (a Guide and a Dub) to Revoice

Pro. For a Doubler or Adjust process you only need one input signal.

· When copying the Guide and Dub audio, it doesn't normally matter which you do first, but you

should name the tracks in Revoice Pro so you put the audio into the right tracks.

· Also, we advise transferring the longer of the Guide or Dub second, for reasons that will be

explained below.

In Nuendo/Cubase select one or more audio clips in a single track that you want to transfer to Revoice

Pro to process.

We will show first transferring one Region from Cubase to Revoice Pro and processing that. When

transferring multiple regions from Cubase to Revoice Pro, the regions will be transferred, but before

processing, one extra action will be required which will be explained below.

You can use any of the Cubase selection commands including clicking on a single region, or use

Shift+click to select multiple regions, or Shift+double click at the first event of the track to select all

following events of the track. Below, we have selected the Lead Vocal GUIDE region in purple.
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Transfer the audio to Revoice Pro: If you can see both the Cubase and Revoice Pro windows, you can

easily drag the selected region(s) from Cubase to a Revoice Pro track and drop it by releasing the

mouse button. Or, you can use the Copy command in Cubase and then go to the Revoice Pro window,

put the mouse over the destination track, right click and select the Paste Audio command shown below.

Copy and Paste keyboard shortcuts also work (CMD+C and CMD+V on Mac, Ctrl+C and Ctrl+V on

Windows).
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These approaches will deposit the audio at the correct timecode, as shown for the selected Guide audio

below. (Normally, the first Guide audio is placed into Track 1.)

If using a Match process, select the audio clip(s) in the Cubase Project that are to be aligned (only in

one track) as shown below. This is your Dub track, in our case Double Vocal DUB.



Revoice Pro 5 Manual Publication8

251

Drag & Drop (or Copy and Paste) the clip(s), to the next Revoice Pro track as shown below.

Notes:

· The first audio region imported into a Revoice Pro Session window automatically sets the values

of the Revoice Pro session's Audio Sample Rate and Audio Bit Depth settings. Revoice Pro

Sessions require all audio regions to have the same Sample Rates and Bit Depths.

· If the audio regions are empty in Revoice Pro or at the wrong locations, check that you have set

the correct DAW version and BPM rate.

· If you have transferred more than one region for the Guide or Dub, you should click here to read

what additional operations you might need to take.

Previous         Next
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7.5.4.3.2. Apply a process

Workflows » How to work with your DAW » Cubase/Nuendo » Drag and Drop » Apply a process

Applying a Process in Revoice Pro
If you have used the Capture only Mode, as done in the previous topic, you can continue with the

following instructions to apply a process within Revoice

In this example we are going to use a Match (see Match Process for more details) to align the Dub

signal (Double Vocal DUB) to the Guide signal (Lead Vocal GUIDE).

First, in Revoice Pro select the Guide signal in the first audio track. To do so, click in the waveform area

of the Lead Vocal GUIDE track. The audio waveform will turn light grey to indicate it is selected.

Next, right click in the Process Control track and select Match Timing / Pitch / Level. This will open the

New Process Window.
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Below we can see the New Process window that opens upon selecting Match Timing / Pitch / Level.



Revoice Pro 5 Manual Publication8

255

Revoice has made a few automatic choices for us, and for standard use these defaults will typically work

well.

· Our Initial Input Start & End is set to Selected Audio, meaning that his process will apply

to all audio within the selected region.

· Revoice has also selected Lead Vocal GUIDE as our Guide track, and Double Vocal DUB

as our Dub track. We can use the 'Add >>' and '<< Remove' buttons to change this if

needed.

· Our output is set to Automatic. With this setting, Revoice will create a new track for our

output aligned audio.

Click the 'New Process' button or press the N key to add the Match...
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..., which generates the following output on track Double Vocal DUB [OUT].To audition the quality of the

aligned output in Revoice Pro, press the key E and press the space bar.

The ARA interface will automatically map the output of the Match process for the Dub signals back to the

corresponding audio items in Cubase.

In Cubase you can listen to the quality of alignment by listening to the Lead Vocal GUIDE and Double

Vocal DUB tracks together.

If  you need to create a permanent version of the aligned signals, use Cubase's 'Bounce Selection'

option by selecting the audio region and selecting 'Bounce Selection' in the Audio menu.
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7.5.4.3.3. Setup Revoice Pro for audio transfers

Workflows » How to work with your DAW » Cubase/Nuendo » Drag and Drop » Setup Revoice Pro for

audio transfers 

Before doing any audio transfers, it is necessary to make sure that the Revoice Pro Session variables

match those of the Nuendo/Cubase project. This is generally only done once per session (but the

settings can also be saved as a default).

Open Cubase and the required project.

Set Cubase's Tranport Panel Tempo to "FIXED" and note the Bar/Beats value as shown below.

In Nuendo's Project menu, open Project Setup and note the Frame Rate and Start time as shown below.
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Open Revoice Pro and in the View menu in macOS or the Window menu in Windows,  select Settings to

open the Project Settings window. The image on the  right shows the settings dialogue box for Windows

OS.

The four fields listed below must be set to match the Nuendo/Cubase project settings. The picture on the

 right shows the settings for the example Nuendo project above.

o Set Timecode Rate to the Nuendo/Cubase project frame rate.

o Set the DAW Timecode Offset to the Nuendo/Cubase project start time. (Revoice Pro

does not support negative project start times.)

o Set the DAW setting to "Nuendo 5.5 & Later" ("Cubase 6 & Later" or other appropriate

setting)

o Set the DAW BPM value to Nuendo's/Cubase's Tempo value.

o Click OK when all settings have been made.
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If you wish to reuse these Project settings for futher Revoice Pro sessions, open the Revoice Pro File

menu and select Save As Default Session.

 

Previous            Next
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7.5.4.3.4. Transfer the audio back to Cubase/Nuendo

Workflows » How to work with your DAW » Cubase/Nuendo » Drag and Drop » Transfer the audio back

to Cubase/Nuendo 

There are two main methods for transferring processed audio from Revoice Pro to Nuendo/Cubase.

Which one you chose depends on whether you want to transfer a single clip or many clips from

optionally many tracks at the same time.

· For transferring a single audio region from Revoice Pro to Nuendo/Cubase, drag and drop is

simple and fast.

· For transferring many audio files to Nuendo/Cubase, use Revoice Pro's Export Audio command

in the File menu.

You cannot copy and paste audio from Revoice Pro to Nuendo/Cubase.

Drag and drop
Use the standard drag and drop action to return the processed audio from Revoice Pro to the DAW.

The audio returned to Cubase/Nuendo will probably not end up at the correct time as shown below.
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In the DAW, ensure the imported clip is still selected and select Move > Events to Origin found in the

Edit menu (as shown below) or operate its corresponding key command.
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The clip will now be at the correct time-code and aligned with the Guide audio.

You can repeat the above capture, process and import steps along the timeline or from any other tracks.

Export Audio
Use the standard Export Audio method. This will allow exporting one or more complete tracks or a

specified range (using the Playback Range) all at once.

Select the exported and relevant audio files in the operating system and drag and drop them into the

Nuendo (Cubase) project window to the desired track.

A dialogue window in Nuendo (Cubase) will appear asking whether to insert the objects either to one or

different tracks. Select "Different tracks".

If all imported event are still selected in Nuendo, apply Nuendos (Cubase) "Move to > Origin" found in

the Edit Menu or use its corresponding key command.

Optionally, keep all events selected, and apply "Detect Silence" to be found in Audio menu > Advanced.
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Adjust the values to separate the file(s) back into the relevant lines/takes again.

The result will appear with the same structure of audio events/takes in the Nuendo project as before the

aligning process.

 

Previous          Next
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7.5.5. Reaper

Workflows » How to work with your DAW » Reaper 

For Revoice Pro 5 there are two efficient ways of working with Reaper:

  

Drag and Drop, which is simple to use and is fast to set up. 

ARA, which uses a plug-in to synchronize audio regions between Reaper and Revoice Pro. There are

two versions of the ARA plugin available:

· Revoice Pro Link which features a new workflow as of Revoice Pro 5 that allows for

Capturing and Processing audio in one action

· Revoice Pro Link (Legacy) which maintains the workflow from Revoice Pro 4

Previous           Next

Related topics:

Latest information on Revoice Pro with Reaper
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7.5.5.1. ARA (Audio Random Access) in Reaper

Workflows » How to work with your DAW » Reaper » ARA (Audio Random Access) in Reaper 

The Audio Random Access (ARA for short) interface allows plug-ins and DAWS to integrate much more

thoroughly with each other. ARA allows plug-ins to:

· Have direct access to the DAW's audio data. This means that a plug-in can read audio at rates

much faster than real-time.

· Read the names of the audio regions. Plug-ins will be able to display the correct name of each

region, making it much easier for users to associate audio in a plug-in to the audio in the DAW.

· Read the timing information of each region of audio directly. Plug-ins will automatically know the

starting time of each region within a track

From version 5.97 of Reaper, there is a new, more versatile way of processing audio in Revoice Pro.

Revoice Pro supports the new ARA 2 standard that allows a better and much faster exchange of

information between DAWS and plug-ins.

When working with Revoice Pro and Reaper, ARA has the following advantages:

· Immediate transfer of audio between the DAW and Revoice Pro.

· Keeps the names and timings of all linked audio items. 

· Revoice Pro remains synchronised with all the linked audio items. For example,  if you change

the starting time  of an audio item in Reaper, the corresponding audio region in Revoice Pro will

move to the new starting time.

· Linking the output of any process in Revoice Pro to an audio item  allows immediate replay in

Reaper of Revoice Pro's processing.

· Load and saving of projects allows subsequent editing of previous work.  

Previous          Next
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7.5.5.1.1. Capturing Audio

Workflows » How to work with your DAW » Reaper » ARA (Audio Random Access) in Reaper »

Capturing Audio 

This section shows you how to transfer audio from a project in Reaper to Revoice Pro 5 using the

ARA Link plug-in. 

Note: For Reaper to work reliably with the RevoicePro, we recommend that in Reaper you deselect

(disable) the option "Preferences->Media->Set media items offline when application not active".

We will work with two example tracks:

· Lead Vocal GUIDE: This will function as our Guide track

· Double Vocal DUB: This will function as our Dub track, or the track which will be aligned to

the Guide

Choose two pieces of audio to be your Guide and Dub. A comman example would be a Lead Vocal as

the Guide and a Backup Vocal as a Dub track.

Capturing Audio
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For each track that you want to transfer to Revoice Pro, follow these steps in Reaper:

1. Click the track's "Show Track Fx Window" button.

2. In the "Add FX to:" dialogue box, choose VST3 in the column on the left.

3. From the list of VST3  plug-ins in the "Add FX to:" window, select Revoice Pro Link and then press the

OK button. You will see the plugin window shown below. If you see the first plugin window, it means that

Revoice is not yet running, so click Start Rv in the top right of the plugin window to open Revoice. If

Revoice is open, you will see the second plugin window.
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Once Revoice is running, select the audio region Lead Vocal GUIDE and click Capture Audio in the

plugin window, as shown below. This will import the selected audio region into Revoice Pro.
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Repeat this process for your Dub audio, in our case Double Vocal DUB. Add the Revoice Pro Link plugin

to the track, then select the audio region and click Capture Audio.

Once this is done, your Revoice window will look like the below image. We can see that our Revoice

project now has two tracks, one called Lead Vocal GUIDE and the other called Double Vocal DUB.
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Any tracks that Reaper has created in Revoice Pro are automatically locked. The red padlock    in

the track's status area indicates this. Although you cannot edit any of the linked audio directly in Revoice

Pro (as the track is locked), the ARA interface synchronize each audio segment in Revoice Pro with its

linked audio in Reaper.

Previous        Next 
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7.5.5.1.2. Applying a Process

Workflows » How to work with your DAW » Reaper » ARA (Audio Random Access) in Reaper »

Applying a Process

As of Revoice Pro 5, the Link plugin has a Mode menu item. The Mode allows the user to both Capture

audio and apply a Process immediately within Revoice, and helps to make standard workflows more

efficient. Here, we will discuss how to use the Mode menu feature, and then discuss creating a process

in Revoice after using Capture Only.

Capture and Process Modes
In the Revoice Pro Link plugin window, click the Mode dropdown menu and select Capture & Match

Timing / Pitch / Level.

The Revoice Pro Link plugin window will change to give you some new options.

In the above image we can see we now have a few new options.

· Preset will allow us to choose any of our presets to apply to this new process.
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· Select Guide and Select Dub will allow us to capture our audio regions into Revoice Pro.

First, select your Guide audio region in Reaper, in this case Lead Vocal GUIDE, and then click Capture

Guide in the Revoice Pro Link plugin window.

Repeat the same process but select the DUB region, here Double Vocal DUB, in your DAW and click

Capture Dub, just below Capture Guide.
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Now in your Revoice project window, you can see the process that has been created as shown below.

You can listen back in Revoice or in your DAW to hear the Matched audio.
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Applying a Process in Revoice Pro
If you have used the Capture only Mode, as done in the previous topic, you can continue with the

following instructions to apply a process within Revoice

In this example we are going to use a Match (see Match Process for more details) to align the Dub

signal Double Vocal DUB to the Guide signal Lead Vocal GUIDE.

First, in Revoice Pro select the Guide signal (Lead Vocal GUIDE) in the first audio track by clicking the

waveform area. The audio waveform will turn light grey to indicate it is selected.
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Next, right click in the Process Control track and select Match Timing / Pitch / Level. This will open the

New Process Window.

Below we can see the New Process window that opens upon selecting Match Timing / Pitch / Level.
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Revoice has made a few automatic choices for us, and for standard use these defaults will typically work

well.
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· Our Initial Input Start & End is set to Selected Audio, meaning that his process will apply

to all audio within the selected region.

· Revoice has also selected Lead Vocal GUIDE as our Guide track, and Double Vocal DUB

as our Dub track. We can use the 'Add >>' and '<< Remove' buttons to change this if

needed.

· Our output is set to Automatic. With this setting, Revoice will create a new track for our

output aligned audio.

Click the 'New Process' button or press the N key to add the Match...

..., which generates the following output on track Double Vocal DUB [OUT].To audition the quality of the

aligned output in Revoice Pro, press the key E and press the space bar.

The ARA interface will automatically map the output of the Match process for the Dub signals back to the

corresponding audio items in Reaper.

In Reaper you can listen to the quality of alignment by listening to the Guide and Dub tracks together.

Previous        Next
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7.5.5.1.3. Load & Save

Workflows » How to work with your DAW » Reaper » ARA (Audio Random Access) in Reaper » Load &

Save 

One of the advantages of using the Revoice Pro Link ARA plug-in is that it allows you to save the whole

project using Reaper's commands Open, Save, Save as..  Not only will these commands save and load

Reaper's project data but they will also save and load  the session data from Revoice Pro.

All the ARA data (in this example derived from Revoice Pro's processes and sessions) is stored in

Reaper's project folder, making any project with ARA much more portable and re-editable.

 

Previous             Next
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7.5.5.2. ARA (Legacy)

Toggle navigation

Revoice Pro 4.3 Help
·

Workflows » How to work with your DAW » Reaper » ARA (Legacy) 

The Audio Random Access (ARA for short) interface allows plug-ins and DAWS to integrate much more

thoroughly with each other. ARA allows plug-ins to:

· Have direct access to the DAW's audio data. This means that a plug-in can read audio at rates

much faster than real-time.

· Read the names of the audio regions. Plug-ins will be able to display the correct name of each

region, making it much easier for users to associate audio in a plug-in to the audio in the DAW.

· Read the timing information of each region of audio directly. Plug-ins will automatically know the

starting time of each region within a track

From version 5.97 of Reaper, there is a new, more versatile way of processing audio in Revoice Pro.

Revoice Pro supports the new ARA 2 standard that allows a better and much faster exchange of

information between DAWS and plug-ins.

When working with Revoice Pro and Reaper, ARA has the following advantages:

· Immediate transfer of audio between the DAW and Revoice Pro.

· Keeps the names and timings of all linked audio items. 

· Revoice Pro remains synchronised with all the linked audio items. For example,  if you change

the starting time  of an audio item in Reaper, the corresponding audio region in Revoice Pro will

move to the new starting time.

· Linking the output of any process in Revoice Pro to an audio item  allows immediate replay in

Reaper of Revoice Pro's processing.

· Load and saving of projects allows subsequent editing of previous work.  

Previous          Next
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7.5.5.2.1. Capturing Audio

Workflows » How to work with your DAW » Reaper » ARA (Legacy) » Capturing Audio 

This section shows you how to transfer audio from a project in Reaper to Revoice Pro 5 using the ARA

(Legacy) link plug-in. 

Note: For Reaper to work reliably with the RevoicePro, we recommend that in Reaper you deselect

(disable) the option "Preferences->Media->Set media items offline when application not active".

We will work with two example tracks:

· Lead Vocal GUIDE: This will function as our Guide track

· Double Vocal DUB: This will function as our Dub track, or the track which will be aligned to

the Guide

Choose two pieces of audio to be your Guide and Dub. A comman example would be a Lead Vocal as

the Guide and a Backup Vocal as a Dub track.

For each track that you want to transfer to Revoice Pro, follow these steps in Reaper:

1. Click the track's "Show Track Fx Window" button.

2. In the "Add FX to:" dialogue box, choose VST3 in the column on the left.
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3. From the list of VST3  plug-ins in the "Add FX to:" window, select Revoice Pro Link (Legacy) and then

press the OK button.

4. Once you have added RevoicePro Link to the track, Reaper will display each plug-in labelled with the

name of its associated track. In this example its label is "Track 1: Lead Vocal GUIDE". 

If Revoice Pro is not running, you will see the message "Press the Start button to run Revoice Pro" at the

bottom of the plug-in's window. If Revoice Pro is not running, press in the plug-in.

5. When Revoice Pro is running the Start button becomes a Show button. Press Show in the plug-in

to bring Revoice Pro to the foreground on your screen.

6. Similarly, add the RevoiceProLink plug-in to Reaper's track "LEAD VOX 2". 



Revoice Pro 5 Manual Publication8

284

As soon as Revoice Pro is running, Reaper will open a new session in Revoice Pro, create any new

tracks (if needed)  and copy the audio in each linked track to Revoice Pro.  The new session in Revoice

Pro will have the same name as Reaper's, which in this example is Revoice Pro with Reaper. Each track

in Revoice Pro will have the same name (and colour) as the corresponding track in Reaper.

Once Reaper has opened a session in Revoice Pro, Link icon in each plug-in's window will glow

green. This indicates that Revoice Pro will try to mirror the position and audio content of all linked linked

tracks (LEAD VOX 1 and LEAD VOX 2 in this example). In other words if you change the audio in track

 LEAD VOX 2 in Reaper, any changes will be transferred across to the corresponding track in Revoice

Pro. 

 

Any tracks that Reaper has created in Revoice Pro are automatically locked. The red padlock    in

the track's status area indicates this. Although you cannot edit any of the linked audio directly in Revoice

Pro (as the track is locked), the ARA interface synchronize each audio segment in Revoice Pro with its

linked audio in Reaper.

Notes:

1. To unlock a track, it is necessary to remove the Revoice Pro Link plug-in from  the

corresponding track in Reaper. For example, if you need to unlock track Audio 1 in Revoice Pro,

in Reaper you will need to remove the Revoice Pro Link plug-in from track 1, LEAD VOX 1.

2. You may want to stop a track in Revoice Pro from automatically following changes in Reaper. To

stop the automatic updating in Revoice Pro, click Link click the Link icon , in the Link plug-in's
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window. The icon will turn grey and the track in Revoice Pro will no longer follow any

changes that you make in Reaper.

Previous         Next
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7.5.5.2.2. Applying a Process

Workflows » How to work with your DAW » Reaper » ARA (Legacy) » Applying a Process 

This topic shows you how to apply a process to the captured audio in Revoice Pro and how to replay the

processed audio seamlessly in Reaper.

Note: For Reaper to work reliably with the RevoicePro, we recommend that in Reaper you deselect

(disable) the option "Preferences->Media->Set media items offline when application not active".

We start from then end of the last topic (Capturing Audio) where we created a simple project by

transferring two simple (short) tracks to Revoice Pro from Reaper.

In this example we are going to use a Match (see Match Process for more details) to align the Dub

signal (Double Vocal DUB) to the Guide signal (Lead Vocal GUIDE).

First, in Revoice Pro select the Guide signal Lead Vocal GUIDE by clicking in the waveform area of the

first track. The audio waveform will turn light grey to indicate it is selected.
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Next, right click in the Process Control track and select Match Timing / Pitch / Level. This will open the

New Process Window.
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Below we can see the New Process window that opens upon selecting Match Timing / Pitch / Level.
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Revoice has made a few automatic choices for us, and for standard use these defaults will typically work

well.

· Our Initial Input Start & End is set to Selected Audio, meaning that his process will apply

to all audio within the selected region.

· Revoice has also selected Lead Vocal GUIDE as our Guide track, and Double Vocal DUB

as our Dub track. We can use the 'Add >>' and '<< Remove' buttons to change this if

needed.

· Our output is set to Automatic. With this setting, Revoice will create a new track for our

output aligned audio.

Click the 'New Process' button or press the N key to add the Match...

..., which generates the following output on track Double Vocal DUB [OUT].To audition the quality of the

aligned output in Revoice Pro, press the key E and press the space bar.

The ARA interface will automatically map the output of the Match process for the Dub signals back to the

corresponding audio items in Reaper.
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If  you need to create a permanent version of the aligned signals, you use Reaper's "Item->Apply

track/take Fx as new take" function on the Dub audio items. The newly rendered items  have the

advantage of showing accurate waveforms. 

Previous        Next
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7.5.5.2.3. Load & Save

Workflows » How to work with your DAW » Reaper » ARA (Legacy) » Load & Save 

One of the advantages of using the Revoice Pro Link ARA plug-in is that it allows you to save the whole

project using Reaper's commands Open, Save, Save as..  Not only will these commands save and load

Reaper's project data but they will also save and load  the session data from Revoice Pro.

All the ARA data (in this example derived from Revoice Pro's processes and sessions) is stored in

Reaper's project folder, making any project with ARA much more portable and re-editable.
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7.5.5.3. Drag and Drop

Workflows » How to work with your DAW » Reaper » Drag and Drop 

For a general description of using Drag and Drop in Reaper please see: Main rules for drag and drop

audio files.

For Reaper in particular, you will need to press the keys <CMD><OPTION> in macOS  (<CTRL><ALT>

in Windows) before dragging audio from Reaper to Revoice Pro.

Once you have dragged and dropped audio regions from Revoice Pro to Reaper, you can use Reaper's

command "Move Items to Source Preferred Position" to spot the audio region to its original timecode.

You access this command in the Item->Item Processing sub-menu.
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7.5.6. Logic Pro

Workflows » How to work with your DAW » Logic Pro 

In addition to the stand-alone methods for transferring audio between Logic Pro and Revoice Pro, or

using the basic AU Link plug-in, there are two methods that allow faster and more versatile ways of

working.

From v3.3 of Revoice Pro and 10.3 of Logic it's possible to use a faster method of capture that takes

advantage of Logic's Selection-Based Processing. The Revoice Pro plug-in is applied directly to specific

regions in Logic, and processed audio is transferred back to Logic using drag and drop. 

From version 4.3 of Revoice Pro and version 10.6.1 of Logic it also possible to use the new

RevoiceProLink AU (ARA) plug-in to link tracks in Logic to tracks in Revoice Pro. Audio is immediately

transferred from Logic to Revoice Pro, with optional automatic process creation, and the processed

audio immediately replaces the source audio in Logic.

It is important to note that currently ARA in Logic Pro only works on Apple Silicon macs

running in Rosetta 2.

An AU-based monitor plug-in is included with Revoice Pro that, once installed, allows you to hear audio

playback from Revoice Pro through the DAW's audio outputs. It also lets Revoice Pro optionally lock to

the DAW's playback with sample-accurate sync. This lets you check processed audio "in place" with

DAW audio and video before you transfer it from Revoice Pro back to the DAW.

Previous        Next

Topics in this section:

Selection-based Processing

RevoiceProLink AU (ARA) plug-in

Related topics:

Setting up Revoice Pro Monitor plug-in AU

Latest information on Revoice Pro with Logic Pro
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7.5.6.1. Selection-based Processing

Workflows » How to work with your DAW » Logic Pro » Selection-based Processing 

With Selection-Based Processing, a Revoice Pro plug-in is applied directly to a region or regions in

Logic, rather than via a channel-strip insert, enabling specific audio regions to be captured quickly. This

is simply used to capture audio from Logic into Revoice Pro. To get the processed audio back in to Logic

it's necessary to use the drag and drop method. 

Normally, with Selection-Based Processing, the plug-in processing is applied to a copy of the region

concerned, so that the original is still available, but in the steps described in this section we show how

you can capture the audio without creating a copy of the region. (See https://support.apple.com/en-

gb/HT207467 for further details of how it works.)

Bar Beat Position
If you are using the Bar Position plays at SMPTE setting in Logic's File > Project Settings >

Synchronisation options you need to set the same offset value in Revoice Pro's settings panel before

exporting any audio from Logic.

https://support.apple.com/en-gb/HT207467
https://support.apple.com/en-gb/HT207467
https://support.apple.com/en-gb/HT207467
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Topics in this section:

Capturing audio

Transfer audio back to Logic
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7.5.6.1.1. Capturing audio

Workflows » How to work with your DAW » Logic Pro » Selection-based Processing » Capturing audio 

With Selection-Based Processing it's easiest to capture one Logic track's audio regions to one (RVP)

track at a time. You can, though, shift-click to select multiple regions in Logic to be transferred to the

selected RVP track.

Once audio is captured to tracks in RVP, you will need to manually create your own processes in RVP,

then return the processed audio to Logic.

In Logic Pro choose Selection-Based Processing from the Functions menu.

A list of "A" and "B" plug-ins applied to the selection is shown. Hold down the plug-in selector below the

"A" heading and select Revoice Pro Link AU > Mono from the list of plug-ins shown.



Revoice Pro 5 Manual Publication8

298

If you can't see the RVP AU Link plug-in window, click on the plug-in settings selector of the RVP plug-in

button shown in the Logic plug-ins list to display it, as shown below:



Revoice Pro 5 Manual Publication8

299

Make sure that you have a suitable RVP destination track selected (Audio 1 shown above). (Enable

Capture does not have to be turned on, as it does for capture using the real-time AU Link plug-in as a

channel insert.) See AU Link plug-in.)

Select an audio region in Logic Pro. 

Click Apply at the bottom right of the Selection-Based Processing control panel.
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To avoid creating a copy of the original regions in Logic, Undo Selection Based Processing from the

Logic Pro Edit menu.

In Revoice Pro, the captured region should now be shown on the track selected. (You don't have to play

audio in Logic in order to capture it, in this case.)
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If you need to capture additional regions, or regions from other tracks, select the relevant regions in

Logic, choose a suitable RVP destination track in the RVP Link plug-in window, and click Apply again in

the Selection-Based Processing control panel.

Previous             Next 
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7.5.6.1.2. Apply a Process in Logic Pro

Workflows » How to work with your DAW » Logic Pro » Selection-based Processing » Apply a Process

in Logic Pro

Continuing from the previous topic, we can repeat the same steps to capture more audio. We have

already captured Lead Vocal 1 into Audio 1 of our Revoice Pro session. We will apply a Match process,

and use this audio as our Guide track. To capture our dub:

· Click the Revoice plugin in the 'A'column of Selection-Based Processing to open the

Revoice plugin window.

· Change the destination track to Audio 2.

· Select the regions that will be our Dubs. In this case, the three BV regions. If selecting

multiple regions, they must be on the same track.
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Now our Revoice project has the Lead Vocal 1 region on Audio 1 and the BV regions on Audio 2.

Creating a New Process

Next, select the audio that will be our Guide, in this case Lead Vocal 1. It's audio waveform will turn light

grey to indicate it is selected. Right click in the Process Control Track and select Match Timing / Pitch /

Level.
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This will open the New Process Window shown below. Revoice has made a few default selections for

us, and generally these settings will work well.

· Initial Inpurt Start & End is set to Selected Audio, meaning that the process will apply to

our entire range of audio that we selected earlier.

· Audio 1 has been assigned to Guide, and Audio 2 has been assigned to Dub. If these

need to be changed, use the 'Add >>' and '<< Remove' buttons.

· Output is set to 'Automatic' so that Revoice will create a new Audio track for our aligned

output audio.



Revoice Pro 5 Manual Publication8

305

Click Create New Process at the bottom of the window, or hit the N key to create the process.
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We can see the new Process in the above image. Because the audio regions we are aligning have a

significant amount of space between them and the Guide track is very long, we need to enable

SmartAlign to achieve proper alignment. To do this, open the Process Control Panel by clicking the

small arrow on the blue Match process bar. This opens the Process Control Panel shown below. Select

the checkbox beside SmartAlign to enable it, shown in the red box below.
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Revoice will now re-process the audio with our changes, and properly align the output audio

automatically. We can see in the below image that our output audio on Audio 2 [OUT] is now properly

aligned and ready for transfer back to Logic.



Revoice Pro 5 Manual Publication8

308

Previous             Next

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.



Revoice Pro 5 Manual Publication8

309

7.5.6.1.3. Transfer the audio back to Logic

Workflows » How to work with your DAW » Logic Pro » Selection-based Processing » Transfer the audio

back to Logic 

Once you have processed the captured audio tracks appropriately in Revoice Pro, you will need to

return the processed audio to Logic Pro.

Using drag-and-drop, hold down the SHIFT and OPTION (Mac) / SHIFT and CTRL (Windows) keys on

the keyboard, then drag the processed audio region from Revoice Pro and drop it onto the desired target

location in a Logic Pro track. (For more detailed description of the key and mouse sequence see Drag-

and-drop export.)

 dragged to...

Previous             Next
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7.5.6.2. AU (ARA) Link plug-in

Workflows » How to work with your DAW » Logic Pro » AU (ARA) Link plug-in 

When working with Revoice Pro (RVP) and Logic Pro (Logic), the ARA version of the AU Link plug-in

has the following advantages:

· Immediate transfer of audio between the DAW and RVP.

· Keeps the names and timings of all linked audio events. 

· RVP remains synchronised with all linked audio regions. For example,  if you change the starting

time of an audio region in Logic, the corresponding audio region in RVP will move to the new

starting time.

· Linking the output of any process in RVP to an audio region allows immediate replay in Logic of

RVP's processing.

· Load and saving of projects allows subsequent editing of previous work.  

Inserting the Link plug-in
On each Logic track to be processed by RVP, insert the RevoiceProLink AU (ARA) plug-in as the first

(top) Audio FX in any track inserts:

· In Logic's Track area inspector for the track concerned, press the Audio FX button.
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· In the menu that appears, select: Audio Units > Synchro Arts > RevoiceProLink AU (ARA) >

Mono.

(If you have already used the RevoiceProLink (ARA) plug-in, you may also be able to select it

immediately from the Recent list at the top of the menu.)

Once selected, you will see the Revoice Pro Link plug-in control window (below). At the top are the

standard plug-in controls. (Detailed information about header controls is available in the Logic Help

system.)

If Revoice Pro is not running, you will see the below plugin window. Click the Start Rv on the right side of

the plugin window.
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Once Revoice Pro is running, the plugin window will look like the below image.

Opening and showing Revoice Pro
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There is a button in the plug-in window that enables you to Start RVP if it is not already open, or to Show

RVP if it is open and you want to reveal its session window:

Plug-in control window
Once an RVP session is open, you will see the audio capture functions in the Link plug-in control

window, which are described in detail in the following sections. Essentially, audio from Logic has first to

be captured by RVP, a process created in RVP (plug-in Functions can do this automatically), after which

the processed audio is automatically rendered (transferred) back to the Logic track, replacing the source

audio.

Previous             Next

Topics in this section: 

Capturing audio from Pro Tools using the link plug-in

Apply a Process

Transferring the audio back to ProTools using the link plug-in
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7.5.6.2.1. Capturing audio

Workflows » How to work with your DAW » Logic Pro » AU (ARA) Link plug-in » Capturing audio 

From Revoice Pro (RVP) 4.3, the AU (ARA) Link plug-in has a number of capture modes to choose

from, in a drop-down menu labelled Mode. The controls lower down the plug-in control window will

change depending on the mode selected.

· Capture Only: only captures audio to a selected RVP track (requiring you to set up your own

RVP processes)

· Capture & Make Match/Doubler/Adjust: captures audio to selected RVP tracks and creates a

new RVP process using the selected Preset.

If you only want to capture audio, and create your own processes in RVP, select Capture Only from the

drop-down Functions, then select some source audio in the Logic track. (Selected audio can be more

than one region, but must consist of complete regions.)

· Processed audio always automatically replaces the selected source audio in Logic, so you may

need to create a copy of the source audio if you are using Doubler processes. In the case of

Match, processed audio will automatically replace the Dub selection.

· ARA mode requires that some audio is played before Capture, in order to synchronise the ARA

database. The Auto play before Capture option (shown yellow - turned on - below) ensures this

happens automatically. If this option is turned off, you may need to press play in Logic before

capturing new audio.

· Press Capture Audio.
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· Now go to RVP and Apply a Process. 

Capture audio and create a process
automatically
The description below refers to capture of audio, and the automatic creation of a Match process. Similar

points apply when using the Doubler process, but only one Logic track is captured.

Before Capturing Guide and Dub audio for Match, make sure that the RevoiceProLink AU (ARA) plug-in

is inserted as Audio FX in both Guide and Dub tracks.

· From the Mode drop-down menu, select Capture & Match Timing / Pitch / Level.

· Select a suitable RVP preset from the drop-down Preset menu.
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· Select the audio in Logic to be used as the Guide. (Selected audio can be more than one region,

but must consist of complete regions.)

· In either plug-in window (Guide or Dub track's), click Capture Guide (the orange 2 arrow shown

below). This will send the selected audio to the Revoice Pro (RVP) Session.
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· Select the audio in Logic to be used as the Dub.

· Click Capture Dub in the plug-in window (orange arrow 4 in the plug-in window above) to load

the Dub audio into RVP.
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A Match process track is automatically created in the RVP session, with the preset settings you chose.

Processed audio automatically replaces the selected Dub audio in Logic.

Depending on the characteristics of the Guide and Dub tracks, the output audio may be misaligned. If

this is the case, open the Revoice Pro window and click on the arrow on the left side of the blue Process

bar to open it's Process Control Panel. Here, you can select SmartAlign shown in the red box below to

automatically fix any alignment issues.
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7.5.6.2.2. Apply a Process

Workflows » How to work with your DAW » Logic Pro » AU (ARA) Link plug-in » Apply a Process 

If the plug-in capture mode was set only to Capture Only, you will now need to go to the RVP session

and create your own RVP processes using the detailed instructions described in the Processes section.

With any of the other Link plug-in capture modes, a Revoice Pro process is created automatically after

the audio has been captured from Logic.

You can optionally ignore, inspect, or audition the processing that has taken place in the Revoice Pro

session. However, nothing further has to be done in the Revoice Pro window.

Detailed aspects of the various RVP Processes are described in Processes.

If you do need to change the detailed processing settings, you can open the Process Control Panel

(Match, Doubler or Adjust, depending on the capture mode in question) by selecting the Revoice Pro

window and, with the Process Control Blocks selected, press P to open the Process Control Panel. Then

change the settings and press the Space Bar, if necessary, to re-process and audition the audio. If it is

OK, you can optionally save the new settings as a Preset for the next process or simply go to the next

step.

You can also change the RVP Preset in the RVP Process Control Panel. The processing will change

accordingly and the result returned to Logic. (Any changes made to the RVP Preset selection in the

Logic plug-in control panel will not affect the result after audio is first captured, so any changes have to

be made in RVP.)

Previous               Next 
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7.5.6.2.3. Load & Save

Workflows » How to work with your DAW » Logic Pro » AU (ARA) Link plug-in » Load & Save 

One of the advantages of using the Revoice Pro Link ARA plug-in is that it allows you to save the whole

project using Logic Pro's commands Open, Save, Save as..  Not only will these commands save and

load Logic Pro's project data but they will also save and load the session data from Revoice Pro 4.

All the ARA data (in this example derived from Revoice Pro's processes and sessions) is stored in Logic

Pro's project folder, making any project with ARA much more portable and re-editable.
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7.5.7. FL Studio

Workflows » How to work with your DAW » FL Studio

Previous             Next
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7.5.7.1. Capturing Audio

Workflows » How to work with your DAW » FL Studio » Capturing Audio

Workflows » How to work with your DAW » FL Studio » Capturing Audio 

A VST Link plug-in can be inserted into each DAW track, and there is no limit to how many

Link plug-ins can be inserted in the DAW. This means one or more tracks can be captured

at the same, which can greatly speed up your workflow.

Once audio is captured to tracks in RVP, you will need to manually create your own

processes in RVP.

In FL Studio, add the Revoice Pro Link VST plugin to your Guide track and your Dub track.

For this guide, we will use the below two tracks.

Lead Vocal GUIDE will function as our Guide track.

Double Vocal DUB will function as our Dub track. This track will be aligned to our Guide

track.

Add the Revoice plugin to both tracks. In your Mixer, add the plugin by clicking an empty

effects slot as shown below.
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Then choose 'More Plugins'
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In the window that appears, find the Revoice Pro Link VST plugin and select it. You can

search with the search bar at the bottom of the window to find it more quickly.

This will instantiate the plugin and open the plugin window as shown below. Click 'Start Rv'

in the top right corner to open Revoice.
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Revoice has started and contains some default untitled tracks, as shown below. 

Rename Audio 1 and Audio 2 by clicking the track names. We'll rename them to match our

Guide and Dub tracks, in this case Lead Vocal GUIDE and Double Vocal DUB respectively.
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In the Link plug-in windows, select the destination track. The link plugin on your GUIDE

goes to the track we just renamed to match our Guide, and the link plugin on your DUB

track goes to the track we renamed to match our Dub.

Now click 'Enable Capture' to arm the plugin for audio capture. You can shift+click Enable

Capture to turn it on for all plugins at once.
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Line up FL Studio's play head to the start of the audio you wish to transfer and

start playback. All of the tracks that have Capture enabled will begin transferring the

captured audio to the selected tracks in Revoice Pro.

An elapsed time indicator will show a running total of the duration of the audio captured as

shown below.

When all of the audio to be captured has been played, stop playback. The capture

operation will stop and the captured audio will appear in the selected tracks in Revoice

Pro.

When capture is over, all the Capture switches will automatically toggle off so you don't

accidentally restart a capture. But, if you do, Revoice Pro will show overlapping audio via a

warning indicator at the right of the screen and a yellow line under the area of overlapping

audio.

Previous       Next
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7.5.7.2. Apply a Process

Workflows » How to work with your DAW » FL Studio » Apply a Process

Applying a Process in Revoice Pro

In this example we are going to use a Match (see Match Process for more details) to align the Dub

signal Double Vocal DUB to the Guide signal Lead Vocal GUIDE.

First, in Revoice Pro select the Guide signal (Lead Vocal GUIDE) in the first audio track by clicking the

waveform area. The audio waveform will turn light grey to indicate it is selected.

Next, right click in the Process Control track and select Match Timing / Pitch / Level. This will open the

New Process Window.
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Below we can see the New Process window that opens upon selecting Match Timing / Pitch / Level.
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Revoice has made a few automatic choices for us, and for standard use these defaults will typically work

well.

· Our Initial Input Start & End is set to Selected Audio, meaning that his process will apply

to all audio within the selected region.

· Revoice has also selected Lead Vocal GUIDE as our Guide track, and Double Vocal DUB

as our Dub track. We can use the 'Add >>' and '<< Remove' buttons to change this if

needed.

· Our output is set to Automatic. With this setting, Revoice will create a new track for our

output aligned audio.

Click the 'New Process' button or press the N key to add the Match...

..., which generates the following output on track Double Vocal DUB [OUT].To audition the quality of the

aligned output in Revoice Pro, press the key E and press the space bar.

Use drag and drop or Export Audio functions in Revoice Pro to return processed audio from Revoice Pro

to the DAW.
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7.6. Revoice Pro Link Plug-ins

Workflows » Revoice Pro Link Plug-ins 

Revoice Pro Link plug-ins offer an alternative and somewhat more generic method to transfer audio to

and from DAWs. In some cases they may be slower than the DAW-specific or stand-alone methods, but

they may be better able to deal with the audio from more complex sessions.

There are three versions:

· Audio Suite/AAX – for Pro Tools only

(AAX for Pro Tools 11 and above, Audio Suite for Pro Tools 10 and below). This is the only Link

plug-in version that can currently transfer audio back from Revoice Pro to a DAW (Pro Tools).

· AU - for Logic Pro (Mac) and other AU-compatible applications.

· VST3 - for Cubase, Nuendo, Reaper, and other VST3-compatible applications.

Operation of the Link plug-ins with other DAWs using the above plug-in interfaces is often possible, but

depends on the full specification of the plug-in interface being implemented by the DAW manufacture.

Revoice Pro Link Switch

To transfer audio using any of the Link Plug-ins to Revoice Pro, the Revoice Pro Link Switch must be

ON (green as shown left) in the destination Revoice Pro Session window.

Otherwise, the Link plug-ins will display an error message.

Only one Revoice Pro Session can have this switch ON at a time.

Next 
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7.6.1. AU

Workflows » Revoice Pro Link Plug-ins » AU 

An AU Link plug-in can be inserted into each DAW track, and there is no limit to how many Link plug-ins

can be inserted in the DAW. This means one or more tracks can be transferred at the same, which can

greatly speed up your workflow.

The AU Link transfer operates like a "real-time" bounce to disk and therefore will take as long as the

selected audio plays. This might be efficient, if transferring several tracks to Revoice Pro (RVP) at the

same time. An alternative to consider (particularly with longer files) is using a faster-than-real-time

export or "bounce" of audio files containing the desired tracks, and then dragging these files into

Revoice Pro.

The examples in this section use Logic Pro as the DAW, but the AU plug-in should also work with other

DAWs that use AU plug-ins.

We recommend that you name the tracks in the Revoice Pro Session to help identify the source of the

transferred audio. In the example below, we've left the Revoice Pro Tracks named Audio 1, Audio 2 and

Audio 3.
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DAW Setup
Make sure you check in the Revoice Pro View > Settings window (shown right), that Revoice Pro's DAW

Timecode Offset / SMPTE Time is set to the same Offset as the Logic Pro File > Project Settings >

Synchronization... options. Logic normally sets this by default to 1 hour, which we also do in Revoice

Pro. The Time display will show the actual corresponding running time, based on the Timecode Rate.

The DAW setting does not affect performance with AU plug-ins.

Inserting the Link plug-in
On each Logic track to be processed by RVP, insert the RevoiceProLink AU plug-in (it does not have to

be the first in the list, but any plug-ins before it will have an effect on audio transferred to RVP):

· In Logic's Track area inspector for the track concerned, press the Audio FX button.
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· In the menu that appears, select: Audio Units > Synchro Arts > RevoiceProLink AU > Mono. 

(If you have already used the RevoiceProLink AU plug-in, you may also be able to select it immediately

from the Recent list at the top of the menu.)
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· Once selected, you will see the Revoice Pro Link plug-in control window (below). At the top are

the standard plug-in controls. (Detailed information about header controls is available in the

Logic Help system.)
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· Repeat this insert operation on all the tracks that you want to transfer to RVP (you will need to

set appropriate destination track numbers on all tracks, see next section).

Opening and showing Revoice Pro
There is a button in the plug-in window that enables you to Start RVP if it is not already open, or to Show

RVP if it is open and you want to reveal its session window:

Plug-in control window
Once an RVP session is open, you will see the audio capture functions in the Link plug-in control

window, which are described in detail in the following sections. Essentially, audio from Logic has first to
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be captured by RVP, processes are applied manually in RVP, then the processed audio is transferred

back to Logic.

Revoice Pro Link Switch

To transfer audio using any of the Link Plug-ins to Revoice Pro, the Revoice Pro Link Switch must be

ON (green as shown left) in the destination Revoice Pro Session window.

Otherwise, the Link plug-ins will display an error message.

Only one Revoice Pro Session can have this switch ON at a time.

Next

Topics in this section: 

Capturing audio from Logic using the link plug-in

Transferring the audio back to Logic when using the link plug-in

Using Revoice Pro with Logic Pro X
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7.6.1.1. Capturing audio from Logic using the link plug-in

Workflows » Revoice Pro Link Plug-ins » AU » Capturing audio from Logic using the link plug-in 

An AU Link plug-in can be inserted into each DAW track, and there is no limit to how many Link plug-ins

can be inserted in the DAW. This means one or more tracks can be captured at the same, which can

greatly speed up your workflow.

Once audio is captured to tracks in RVP, you will need to manually create your own processes in RVP,

then return the processed audio to Logic.

· In the Link plug-in window of the first track to be transferred, select the destination track in

Revoice Pro. Click the destination track drop-down (orange arrow 2) to reveal a list of the track

names in Revoice Pro, then from this list select the required track. The example below shows

the selection of track Audio 1.

· Repeat the plug-in insertion steps (see previous topic) and destination track selection for each

Logic Pro track that contains audio to transfer.

· Make sure Enable Capture (orange arrow 3) is pressed in all Link plug-in windows for tracks to

be transferred.
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· Once pressed (capture turned on), the button will show Stop Capture indicating that the plug-in

is ready to capture audio to RVP. 

· ALL Capture switches in visible Link modules can be toggled ON or OFF by holding down the

SHIFT key and by clicking any Enable Capture switch. 

· Line up Logic Pro's play head to the start of the audio you wish to transfer and start the Logic

Pro playback. All of the tracks that have Capture enabled will begin transferring the captured

audio to the selected tracks in Revoice Pro.

· An elapsed time indicator will show a running total of the duration of the audio captured as

shown below.

· When all of the audio to be captured has been played, stop the Logic Pro playback. The capture

operation will stop and the captured audio will appear in the selected tracks in Revoice Pro.

· When capture is over, all the Capture switches will automatically toggle off so you don't

accidentally restart a capture. But, if you do, Revoice Pro will show overlapping audio via a

warning indicator at the right of the screen and a yellow line under the area of overlapping audio.
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Next 
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7.6.1.2. Transferring audio back to Logic when using the link plug-in

Workflows » Revoice Pro Link Plug-ins » AU » Transferring audio back to Logic when using the link

plug-in 

Use drag and drop or Export Audio functions in Revoice Pro to return processed audio from Revoice Pro

to the DAW.

Next
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7.6.2. VST3

Workflows » Revoice Pro Link Plug-ins » VST3 

A VST Link plug-in can be inserted into each track, and there is no limit to how many Link plug-ins can

be inserted in the DAW. This means one or more tracks can be transferred at the same time, which can

greatly speed up your workflow.

Because of the way VST3 plug-ins work, this transfer operates like a "real-time" bounce to disk and

therefore will take as long as the selected audio plays. This might be efficient, if transferring several

tracks to Revoice Pro at the same time. An alternative to consider (particularly with longer files) is using

a faster-than-real-time export or "bounce" of audio files containing the desired tracks, and then dragging

these files into Revoice Pro.

Revoice Pro Link Switch

To transfer audio using any of the Link Plug-ins to Revoice Pro, the Revoice Pro Link Switch

must be ON (green as shown left) in the destination Revoice Pro Session window.

Otherwise, the Link plug-ins will display an error message.

Only one Revoice Pro Session can have this switch ON at a time.

Next

Topics in this section:

Capturing audio from Cubase using the link plug-in

Transferring the audio back to Cubase when using the link plug-in
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7.6.2.1. Capturing audio from Cubase using the link plug-in

Workflows » Revoice Pro Link Plug-ins » VST3 » Capturing audio from Cubase using the link plug-in 

Here we can see an Ableton Live session with 4 vocals tracks in Arrangement view.

 

To begin, instantiate the Revoice Pro Link (VST-3) plugin on the track that has the audio region you

would like to work with. In this case, we will add the Revoice Pro Link plugin to LEAD VOX 1 and LEAD

VOX 2. We can see the plugin selected in the above image on the left side. Once the plugin is added as

an Audio Effect, the plugin window will open. If Revoice Pro is not yet running, we will see the below

window. Click Start Rv in the top right.
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Below, we can see what the plugin window looks like once Revoice is running. In this case, we have

also added the plugin to LEAD VOX 2.

For each track, assign the Destination track in the Revoice Pro plugin window. This determines where

that audio will go in Revoice. Above, we have selected Audio 2.
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Now we can click Enable Capture on both plugin instances. The button will change to 'Stop Capture'

written in red. The plugin is now armed and ready to receive the audio to send to Revoice Pro.

Once we have added a Link plugin on each track as required, set it's destination track to the

corresponding track in Revoice Pro, and Enabled Capture on each plugin, we are ready to begin

capturing the audio. We can now position the playhead of our DAW just before the audio regions we

want to capture, and hit Play. This process occurs in realtime, and all audio regions that we would like to

work with in Revoice Pro must be played while the Plugins on their respective Link plugins are Capture

Enabled.

Once playback has completed, stop your DAW playback, and click Stop Capture on each plugin. You

should have something similar to the below window in Revoice Pro. In this case, the tracks are stereo,

as Ableton Live always exports stereo tracks.
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Now we can work with the audio as usual in Revoice Pro, applying the necessary processing.

Once processing is complete, use the Export audio options discussed in Export audio from Revoice

Pro to transfer your processed audio back to your DAW.

Next
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Next topic
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7.6.2.2. Transferring audio back to Cubase when using the link plug-in

Workflows » Revoice Pro Link Plug-ins » VST3 » Transferring audio back to Cubase when using the link

plug-in 

Use drag and drop or Export Audio functions in Revoice Pro to return processed audio from Revoice Pro

to the DAW.

Next
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7.7. Stand-alone operation

Workflows » Stand-alone operation 

One of the simplest ways of using Revoice Pro is in "stand-alone" mode. This can be DAW-independent

and relies on directly importing and exporting audio files to and from the program. 

Steps:

· Import or transfer audio to Revoice Pro

· Process the audio in Revoice Pro and check it

· Export or transfer the audio from Revoice Pro

You can also use Revoice Pro with a DAW in this mode by "bouncing" audio from the DAW into files and

then importing them into Revoice Pro. When processed, tracks can then be exported from Revoice Pro

and loaded back in to the DAW. Alternatively, audio can usually be dragged and dropped from Revoice

Pro directly to the DAW.

Next 

Topics in this section:

Import audio files to Revoice Pro

Bouncing audio from DAWs

Process in Revoice Pro

Export audio files
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7.7.1. Import audio files to Revoice Pro

Workflows » Stand-alone operation » Import audio files to Revoice Pro 

In stand-alone mode audio is normally imported to Revoice Pro tracks using dra and drop. Simply drag

the audio file(s) from your computer's file system onto a track in Revoice Pro. 

Dragging and dropping directly from a DAW is more complicated, and only works with certain systems.

See DAW-specific operation.

If using this method, we recommend using the BWF (Broadcast Wave File format) because these files

contain correct timecode information. If BWF format is not available, use .wav format.

Topics in this section:

Spotting audio to specific times

Main rules for drag and drop audio files

Adding audio files to specific tracks

Below we show an example of dragging and dropping two files into Revoice Pro, assuming Auto Spot is

turned on.

Drag two selected files into Track 1 waveform area:
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After "drop", files with timecode will appear at the correct timecode.

Plus, each track is auto named from first dragged filename.

Next 
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7.7.1.1. Spotting audio to specific times

Workflows » Stand-alone operation » Import audio files to Revoice Pro » Spotting audio to specific

times 

If audio files being dragged into Revoice Pro have valid and useful timecode stamps, then the Revoice

Pro Spot Files switch can be enabled to place the audio at those timecodes in Revoice Pro.

To enable Auto Spot to Timecode, click Tracks in the Revoice Pro menu bar, and select Spot Files > to

Original Timecode as shown below.

There are a number of alternative Spot Files options, including spotting to the play head or cursor

position.

To disable any of these auto spot functions select them again in the menu, or select a different one.

Next
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7.7.1.2. Main rules for drag and drop audio files

Workflows » Stand-alone operation » Import audio files to Revoice Pro » Main rules for drag and drop

audio files 

· If dragged waveforms have a timecode stamp, and Auto Spot options described above are

turned off, a window (shown right) will open showing the file name and timecode start and ask if

you want to place the waveform start at the original timecode, the user timecode, at the play

head, at the drag location, or at a specific position entered in the box.

( .aiff files do not contain a timecode stamp.)

· There is an option to apply your selection to any further files during that import.

· If you drag more than one file, the tracks will be populated downward from the first track you

drop into.

· If you drag more files than there are tracks in Revoice Pro, enough new tracks will automatically

be created and populated by the audio files.

· You can also drop audio into the space below the last track and the required number of new

tracks will be added automatically.

· AUTO Track Naming. The first time you drag an audio file into a track, that track will be given the

file's name. This can save much time labelling tracks.

· Each Revoice Pro session's sampling rate and resolution (bits per sample) are set and fixed

automatically to the settings of the first audio signal imported into the session. After that, Revoice

Pro will offer to resample any non-matching audio file that is imported, to match that session's

sampling rate and resolution.

· If the audio to be loaded is a multichannel file, channels can be split into individual mono tracks

by selecting Split Audio Channels in the Tracks menu shown below.
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· For multichannel audio files, selecting Show Only Channel 1 Audio in the Tracks menu only

displays audio waveforms from Channel 1 of the file. This defaults to OFF.

 

Next 
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7.7.1.3. Add Audio Files

Workflows » Stand-alone operation » Import audio files to Revoice Pro » Add Audio Files 

Audio files can also be added to specific tracks in Revoice Pro.

This function is accessed from the contextual menu obtained by RIGHT CLICKing on any track.

The audio file thus loaded will go to a location determined by the same rules as for drag-and-drop files.

Spot to specific times also works for this method.

Next
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7.7.2. Process in Revoice Pro

Workflows » Stand-alone operation » Process in Revoice Pro 

Once the audio is loaded in Revoice Pro, the waveforms can be processed (using one of the

application's Processes) and/or edited. 

Initially, you will normally send the processed audio into one or more Revoice Pro output tracks.

By default, Revoice will create the output tracks for you automatically, but you can specify output tracks

in the New Process Window.

You then will need to transfer the processed output audio back to your DAW.

Next

Related topics:

Processes
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7.7.3. Export audio from Revoice Pro

Workflows » Stand-alone operation » Export audio from Revoice Pro 

Once you have processed your audio in Revoice Pro you will need to export it. In stand-alone operation,

audio is exported as files, or output files can usually be dragged and dropped directly from output tracks

onto a destination (e.g. the filing system or a DAW track).

Next topic

Topics in this section:

Export Audio function

Drag and drop export

Next
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7.7.3.1. Export Audio function

Workflows » Stand-alone operation » Export audio from Revoice Pro » Export Audio function 

Processed audio tracks can be exported as audio files from Revoice Pro. If necessary these can then be

loaded into a DAW. 

· Revoice Pro tracks are automatically named when exporting.

· Entire tracks can be selected, or the start and stop area exported can be defined by setting a

Playback Range.

· Multiple exported files can be dragged together to the DAW at one time.

· Most DAWs will place each dragged Revoice Pro track into one of the DAW's tracks.

· If these tracks are NOT initially at the correct timecode when dragged in, a single command in

the DAW will usually be sufficient to place each imported audio track at the correct timecode.

To define the exported region see: Defining an audio export range

When ready to export audio from Revoice Pro, select the File menu in Revoice Pro and select Export

Audio as shown in the Mac menu (left) or Windows menu (right). Alternatively use CMD E (Mac) / CTRL

E (Windows).

 

Either the small or extended version of the Export Audio As... window will appear with the small version

shown directly below. Clicking the control indicated by the red arrow will switch the view from the small

to the extend version shown in the next picture, and vice versa.
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The extended version of the Export Audio window shown below allows more options for finding folders

and devices and displaying file information.

For the rest of this example, we will show how to export a track from the Revoice Pro Session shown

below.
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With the above session, when Export Audio is selected, the (small) Export Audio As ... window similar to

that shown right will appear.

Note that no tracks or options are selected yet.

The destination folder is shown as "My Session". This can be changed as appropriate.

We will next look at track selection and the auto file naming system.

In the picture below, we have selected track 3.



Revoice Pro 5 Manual Publication8

365

The names of the files that will be created are shown in the "File Name" column. These have been

automatically named by combining the Track Name and the default Save As: prefix name "Audio".

In addition, the number of channels contained in each file is shown.

We can make the name of the file more relevant by changing the "Prefix" name in the Save As window.

In this case, we have changed it to "MyPrefix" and the Files names are automatically changed to include

this prefix as well.
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Note that the option "Export Selected Playback Area" is NOT checked, so all of the audio in the selected

tracks will be exported. The time range of export is shown following the "Export Starting at ...." message.

Saving the files
When all the options and file names are set as required, click SAVE. The named audio files will be

saved into the directory shown in the "Where" window.

Importing the files into your DAW
· Once the files have been output, they can be located in the destination folder

· Go to the directory you selected for the output, and drag ALL the files exported from Revoice Pro

to the desired destination tracks in the main editing window of your DAW.

· The audio tracks should populate your DAW’s tracks but might be at the wrong timecode. (Most

DAWs will create additional tracks if necessary for each file being dragged in.)

· Once the tracks are dragged in, they may need moving to the correct time code using the Spot

commands for specific DAWs. (Some DAWs will apply that correction to all selected imported

files simultaneously.)
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Next
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7.7.3.1.1. Defining an audio export range

Workflows » Stand-alone operation » Export audio from Revoice Pro » Export Audio function » Defining

an audio export range 

If we select the option Export Selected Playback Area, as shown below, we can see that the time range

being output is now modified to only include the audio within the Playback Range (defined by the yellow

bar at the top of the Session (blue in RP 4)).

Lastly, if we select the option "Save selected tracks as a [N] channel file", where N will be the total of the

number of channels in all the selected files and one file will be saved. In the example below - there are 4

mono tracks, so a 4 Channel file will be saved. If there were 4 stereo tracks, an 8 channel file would be

saved.
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Note that not all DAWs would be able to use such multi-channel files.

Next 
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7.7.3.2. Drag and drop export

Workflows » Stand-alone operation » Export audio from Revoice Pro » Drag and drop export 

Processed audio can be exported either to your filing system or to a DAW using drag and drop.

This approach is intuitive, quick and will probably work with most DAWs.

Select Revoice Pro's window with the processed audio.

Hold down the SHIFT and ALT (Mac) / SHIFT and CTRL (Windows) keys on the keyboard.

(Do not press the mouse first or you might move the waveform.)

Left click on the processed waveform and keep holding down the LEFT mouse key.

The white (.wav) document symbol shown at the right should appear.

You should now release the keyboard keys (for compatibility with some DAWs).

Keeping the LEFT mouse button held down, drag the document icon either to your filing system or a

track in your DAW. Release the LEFT mouse button.

On a DAW the waveform will go to a position near where you "dropped" it, but not necessarily to the

correct start timecode. If that's the case, the next step will move it to the correct start timecode.

Use your DAW's "Spot", "Move to Original Timecode" or equivalent function to snap the dragged audio

to the correct timecode.

See Spot commands for specific DAWs for information about the above point 6.
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7.7.3.2.1. Spot commands for specific DAWs

Workflows » Stand-alone operation » Export audio from Revoice Pro » Drag and drop export » Spot

commands for specific DAWs 

 

 

Illustrated Example: "Spotting" audio dragged from Revoice Pro in Pro Tools to correct timecode

DAW Command Notes
Cubase / Nuendo After dragging in audio to DAW track,

select the Cubase Edit menu that
shows "Move to", and select "Origin”
option.

You can also set and use a quick key
command.
For example:
Set keys to
ALT SHIFT O.

Logic Select the menu that shows “Move to
Recording Position”  (or “Move Region
to Original Recording Position”) and
click that option. 

You can also use the corresponding
key command, default assignment:  
SHIFT-CMD-R

Pro Tools RIGHT CLICK dragged audio and
chose "Spot" from pop-up menu. This
will bring up the "Spot Dialog" box.
Click the "Original Time Stamp"
selector and press OK.
(See pictures below)

Set "Auto-Spot" (if available) in Options
menu.

Other Editors Look for similar commands to "Spot" or
"move audio start to timecode stamp".

 

a) Processed audio from Revoice
Pro is dragged into Pro Tools track
in bottom track
 

b) Pro Tools Spot function is
selected
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Next
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c) In Pro Tools "Spot Dialog"
window, select "Use Subframes", if
available.
d) Select "Original Time Stamp"
Dialog and click OK

e) Processed audio snaps to correct
position.
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8. Processes
Toggle navigation

Revoice Pro 4.3 Help
·

· Contents

· Index

· Search

The heart of Revoice Pro are its Processes. These are the algorithms that modify and display your audio

signals and its features. These processes will create an output in a separate Revoice Pro track.

The three main ones are:

· Match Process

o Automatically, gives a target audio signal (Dub) the selected timing, pitch and/or

loudness characteristics of a "Guide" audio signal. Match processing is powered

by the most advanced version of VocALign and other unique technology.

· Doubler

o Instantly creates natural-sounding double tracks from one input signal. It can also

provide creative time and pitch modulation effects.

· Adjust

o Provides fast and easy-to-use manual and automatic tools to change the time,

pitch, vibrato and level of voice and monophonic instrument recordings with

unmatchable quality and transparency.

NOTE: There is also an Adjust Region process that will modify a selected Region of the input signal and

and the processed results will replace the input signal. A new separate output track will not be created if

an Adjust Region process is used.
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Other Processes

The following process are rarely used and can be enabled in the settings menu if needed by checking

the box beside 'Show additional processing options'

The additional processing options are:

· Volume

o Allows individual signal level values to be added and adjusted to create a modified

level control contour

· Analyser

o Offers a graphical representation of short-term signal spectrum and a spectrogram

display.
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This section of the manual describes how to use each of the processes in detail.

It also explains a number of the Basic Process functions that are common to all Processes.

Topics in this section

Basic Process functions

Match Process

Adjust

Doubler

Analyser

Volume

Related topics

Audio setup, monitoring and playback

Workflows

Manually adjust timing, pitch and level

Next
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8.1. Basic Process functions

Processes » Basic Process functions 

A number of functions and features are common to all of Revoice Pro's Processes.

Topics in this section

New Process window

Changing input and output tracks

Process Control Track

Process Control Panel

Process versions

Process presets

Deleting or renaming a Process or its output

Display of editing strength

Time-varying automation

Next
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8.1.1. New Process window

Processes » Basic Process functions » New Process window 

You can apply a Process to any audio that has been loaded into Revoice Pro. The precise steps and

options available are set out in the individual Process sections of this manual.

If you do not see the New Process window (shown in the image at right), then you need to open it. There

are two ways to do this.

1) Right click in any Process Control Track and select 'Match Timing / Pitch / Level' or 'Doubler'.
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2) Make sure the Revoice Pro session window is selected and press the B key on your keyboard. This

will open the New Process window as shown. Pressing the B key again will close it - but it is generally

more efficient to leave this window open.

In this window you can select which audio will act as the Input(s) and set the track(s) to which the

processed Output(s) will go.

Revoice Pro automatically preselects all of the drop down menu items in the New Process window,

based on previous settings or its best guess as to the most relevant settings. You should always check

its selections and change them as required.

You can also decide whether or not multiple processes are created (see Related topics below).

You can change the Initial Input Start and End (see "Setting a Process Control Block" below)

You can also change the Process in this window by selecting it from the drop-down menu at the top.

Pressing New Process at the bottom (or pressing N key) will run the Process concerned with the

parameters selected.
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PreviousNext

Related topics:

Changing input and output tracks

Process Control Track

Setting a Process Control Block

Process Control Panel

Process versions

Next

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.



Revoice Pro 5 Manual Publication8

381

8.1.2. Changing input and output tracks

Processes » Basic Process functions » Changing input and output tracks 

When creating a new process, Revoice Pro will automatically create new tracks for the output of a

process unless the user specifies otherwise. Generally speaking, this means that the user will not need

to change any options regarding output tracks, but certain assignments will need to be made for the

input tracks in a process.

Any automatically created output track will have the pan and volume values of the original track. For

Match this means the Dub track, for Doubler this means the original track.

Output track names will start with a short descriptor of the process used: Match for Match processes or

Dblr for Doubler processes.

When creating a Match process:

In order to create a Match process, you must assign one guide track, and one or more dub tracks. In the

example below, we have opened a New Process window and selected Match Timing / Pitch / Level as

our process. In the 'Tracks' box we can see our four tracks available to be assigned as guide and dub

tracks.
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By selecting a track in the 'Tracks' panel on the left side and clicking the topmost 'Add' button, we can

assign a track as our Guide. Here we have assigned LEAD VOX 1. We can select further tracks and

assign them as our Dub tracks by clicking bottom 'Add' button beside the 'Dub Tracks' panel. 
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Tracks in the Guide Track or Dub Tracks panel can be removed by selected them and clicking the

'Remove' button for the corresponding panel.

A Match Process will then create new tracks in Revoice Pro with the processed audio. One new track

will automatically be created for each Dub track.
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When creating a Doubler process:

When creating a Doubler process, the input and output tracks can be assigned from their respective

drop-down menu in the New Process window. Revoice Pro will automatically assign the seleced track as

the input and use 'Automatic' for output. The 'Automatic' option will create a new track and name it

"Dblr:(Input track name)"
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In the below example, running our Doubler process has created a new track. Lead Vox 1 was selected

as our input and output was set to 'Automatic' as in the above image.
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Next

Related topics:

New Process window

Process Control Track

Setting a Process Control Block

Process Control Panel

Process versions
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8.1.3. Process Control Track

Processes » Basic Process functions » Process Control Track 

The Process Control Track is a very important element of the Revoice Pro user interface. This horizontal

track, located at the bottom of each audio track in Revoice Pro, is used to indicate:

· When a Process is being applied to a track.

· To what portion of a track a process is being applied.

· The type of processing applied.

· Whether the track is a match, dub, doubler, input, or output.

We can see the Process Control Track in the below image indicated by the two red arrows. The Process

Control Track runs along the entire length of the bottom of the track.

In the below image, we've applied a Match process to LEAD VOX 1. We used LEAD VOX 1 as the

Guide, and HARM 1 as the Dub. The Guide and Dub tracks now each have a Process Control Block

(indicated by the red arrows) on their respective Process Control Tracks.
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Each Process Control Block shows you at a glance:

1. The Tracks and locations (start, stop and duration) of the input signals to a process;

2. The Type of process, Name and Role in the Process (e.g. Match:Name-Guide, or Match:Name-

Dub);

3. The process's selection status: selected (blue) or not selected (gray).

4. A button that opens the Process Control Panel   (or press P on keyboard);

5. For Match, a Process Lock button   that, when enabled, will stop further automatic

processing from taking place. This is to stop any optional manual edits from being overwritten.

Next

Topics in this section: 

Setting a Process Control Block

Displaying overlapped Process Control Blocks

Related topics:

New Process window

Changing input and output tracks

Setting a Process Control Block

Process Control Panel
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Process versions
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8.1.3.1. Setting a Process Control Block

Processes » Basic Process functions » Process Control Track » Setting a Process Control Block 

New Process Control Block
We first describe how to set the time range of any processing. 

There are three options available to set the initial time ranges used when creating a New Process,

thereby creating Process Control Blocks that cover the selected range.

1. Use the range of Selected Audio (light grey) to set both the start and end

2. Use the range of a Playback Range to set the start and end

3. Or use the Mouse Cursor position to set the starting point of a short range which can be

adjusted later

Which of the above methods are displayed in the drop down menu under Initial Input Start & End (in the

New Process window) changes dynamically, and depends on what is already selected, or is available for

use. If the New Process window is open, the  automatically range option selected will depend on

whether an Audio waveform, or a Playback Range was the last item selected.
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Selected Audio: this will only appear if some audio is selected. If the desired waveform isn't shown

selected, left click the waveform and it should turn light grey. In some cases, you will need first to RIGHT

CLICK on it to bring up the menu showing Edit Audio and select that option first and then make sure the

audio is selected.

Selected Playback Range: see Playback Range for information about how to set these. If no Playback

Range has been created, then this option will not appear.

Mouse Position: RIGHT CLICK in a Guide or Dub Process Control Track where you want the Process

Control Blocks to start, and follow the New Process procedure. You can then adjust the end and

possibly the start of the Process Control Blocks as required. 
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Adjusting Process Control Blocks
Most of the following applies mainly to Match, but you can also adjust the blocks in the other Processes.

The most common reasons for adjusting are to:

· Set the process start closer to just before the actual start of the audio signal (for example to

exclude digital silence)

· Avoid extraneous audio just before or just after the end of the audio you want to process.

Sometimes the audio referenced by Process Control Blocks does NOT start or end exactly at the same

point of the timeline. This is allowed and expected, which is why the two blocks are independently

adjustable.

The Match process, for example, measures the noise floors of signals, so it is usually ideal to try to have

around 0.25 seconds of background audio before the actual signal of interest starts. But the processing

will generally work even if this isn't the case.

It is also critically important to make sure the range of the Dub Process Control Blocks in Match extends

through the full extent of the Dub audio signal. This is because it provides the audio that is modified to

become the Output.

In contrast, the Guide Process Control Block can stop before the end of the Guide audio. This can

sometimes help avoid including the effect of unwanted audio effects such as reverberation or noises at

the end of the Guide signal. When a Guide stops before the Dub does, the selected Guide parameters

will be used to modify the Dub until the Guide has run out, and then the remaining unmodified Dub will

be attached to the end of the modified audio.

There are three simple ways to adjust the input Process Control Blocks. Before adjusting a Process

Control Block, it must be selected (green) which can be done with a left click inside either of the the

Input Process Control Blocks.

In each method below, the Guide and Dub blocks can be independently adjusted. However, if you hold

down the SHIFT key, both Guide and Dub blocks (Match) will be adjusted at the same time.

The three methods are:

If you position the cursor at the start (or end) of a Process Control Block , the cursor will change to the

Forward- (or Back-) pointing cursor. This cursor indicate that the selected start (or end) can be dragged
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left or right with a left click held down. If the SHIFT key is pressed before LEFT CLICKing, then both the

Guide and Dub Process Control Blocks' selected ends will move together.

 

If you position the cursor inside a Process Control Block (away from the start and end), the cursor will

change to the hand cursor as shown in yellow circle below, indicating that the Block (or Blocks) can be

dragged with a left click held down.

In the image below, the Dub Process Control Block has been dragged to the left.

If the SHIFT key is pressed before left clicking, then both the Guide and Dub Process Control Blocks will

move together.

Moving Process start to playhead
Position the playhead where you want a Process Control Block to start or stop, and then RIGHT CLICK

either Input Process Control Block and use the pop-up menu shown below to set the start (or end) of the

selected process to the playhead position. In the example below, the Guide Process Control Block was

clicked.
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After clicking, the Guide Process Control Block start will move to the Playhead as shown below for this

example.

To make both the Guide and Dub blocks move together, hold down the SHIFT key before RIGHT

CLICKing on the Guide or Dub Process Control Block and after selecting Set Selected Process Start to

Playhead both Guide and Dub blocks will move as shown below for this example.
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The same procedure of positioning the Playhead at the end of a section, RIGHT CLICKing on a Match

input and selecting Set Selected Process End to playhead while holding the shift key will set the end of

the process inputs.

Unless background processing is turned on, remember to Run the process after making any of these

changes, which is most easily done automatically by pressing the Space Bar.

Next

Related topics:

New Process window

Changing input and output tracks

Process Control Track

Process Control Panel

Process versions
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8.1.3.2. Displaying overlapped Process Control Blocks

Processes » Basic Process functions » Process Control Track » Displaying overlapped Process Control

Blocks 

As shown in the example above, generally, because each signal or sections of a signal can act as an

input to an unlimited number of processes, Process Control Blocks can overlap each other and

sometimes become hidden.

When this occurs, the user can select and display a "hidden" Process Control Block in one of two ways:

1. Left clicking a processes' Output signal waveform will also select and reveal that processes'

Input Process Control Block(s) (Guide and Dub for Match or single Input for other processes).

2. RIGHT CLICKing a Process Control Track (in this example, the The Syncettes - High Vox) will

pop-up a window that displays all the processes that are positioned where the user clicked.

Selecting its name from the list will "pop it to the top of the stack" of processes, making it visible

on the screen, and show it as selected. In the example shown right, 2 APTs and 1 Doubler use

the Guide section shown and the second Match "...Mid Vox-Guide" has been selected and is

shown selected in the Process Control Track i.e. at the top of the "stack".
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Next
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8.1.4. Process Control Panel

Processes » Basic Process functions » Process Control Panel 

There are three ways to open a Process Control Panel:



Revoice Pro 5 Manual Publication8

399

(You may need to make sure that the correct Process has been selected if Process Control Blocks

overlap.)

1. If a Process Control Block is selected (blue), pressing the P key will open the Control Panel

(shown right) for the selected Process (this is the fastest method)

OR

2. Left click on the Control Panel button in either the Guide or Dub Process Control Block.

3. RIGHT CLICK on the Output Track of the Process concerned and use the contextual menu to

select Processname > Settings.

The Process Control Panels differ somewhat depending on the Process. 

For details see the individual Process topics.

If the Pinned control is turned ON, the "pinned" panel will stay open. Multiple "Pinned" panels can

remain open for comparison, but the Control Panel for the selected process will have a green-tinted

name bar at the top.

To close the panel, either press the P key, or click the "X" button top left in the Control Panel, or click the

button (once or twice - depending on what has been previously selected).

Next

Related topics:

New Process window

Changing input and output tracks

Process Control Track

Setting a Process Control Block

Process versions

Adjusting Match settings

Adjusting Doubler settings

Modifying Ajdust settings
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8.1.5. Process versions

Processes » Basic Process functions » Process versions

Multiple versions of a Process can be saved and the resulting audio from each saved setting rapidly

compared. 

Note also that if a track is copied then all versions of a process associated with it will be copied too.

Saving a Process version
Once you have settings of a process you want to use for comparison, in the Process Control Panel use

the purple Compare drop-down to select Save Version, after which it will appear listed as A, B, C, etc,

depending on what has already been saved.

 

If you change any process parameters after saving a version, the version letter shows an asterisk

appended:

 

This can be saved again, as above, resulting in a new version with a new letter.
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Comparing Process versions
To compare saved versions, either select one using the drop-down Compare menu or use the Q key on

the computer keyboard to switch rapidly between successive versions.

Deleting a Process version
The currently active version of a process can be deleted using the contextual menu accessed by right

clicking the relevant process control track.

You can also delete the current version using an option in the Compare menu of the Process Control

Panel.

Next

Related topics:

New Process window

Changing input and output tracks

Process Control Track

Setting a Process Control Block

Process Control Panel
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8.1.6. Process presets

Processes » Basic Process functions » Process presets 

The Process Presets system is very important to understand and use. Its main functions are to:

· Save and quickly load named combinations of settings that work well in achieving certain results.

· Allow the same settings to be loaded automatically without having to repeatedly open the control

panels.

User defaults (created by using Preset dropdown "Save As User Default Preset") are shared between

Revoice Pro Sessions and running instances of Revoice Pro.

Presets can only be removed from the lists by manually deleting the Preset file (with the same name as

shown as the menu list) from the directory in which they reside. 

Choose a Preset
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In the New Process window you can choose an existing Preset from Factory Presets, User Presets and

Shared Presets (if they have been created). However, you cannot create or modify Presets within this

menu. You can only create or modify Presets from the individual Process Control Panels.

When you first create a Process, if you do not change the Preset selection when you run the process,

Revoice Pro will use the Factory "Default" Preset. This may or may not give the results you want.

There are some existing Factory Presets that you can use as a starting point, which have self-

explanatory names. 

As you use Presets, they will show up in Recent Presets.

You can also choose Presets in the Process Control Panel (next section).

Create a Preset
Open the Process Control Panel.
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Factory Presets can't be modified, but you can load one, and either save it as the User Default Preset, or

modify it and save as a new Preset that you can name.

Clicking the Presets button that appears in a Process Control Panel  will bring up the menu shown right

with Saving options. (If no User Presets have been saved, that entry would be greyed out, similarly to

Shared Presets as shown.) 

Recent Presets will show the last five selected presets, with the oldest selection at the bottom of the list.

 

Save As User Default Preset saves the current settings instantly as the User's Default Preset without

opening any other window. That setting will be used in all further processing until a different Preset or

setting is selected.

You can experiment and create your own settings by changing the sliders in the Process Control Panel

for that process. These settings will remain active and be saved for that process only.
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To save one of your own settings as a Preset, select Save as User Default Preset and/or Save As

Preset in order to reuse it.

Give each setting you create and save as a preset a distinctive and helpful name, for example, as shown

below "Closer Time and Pitch" and that name will appear next time you open the User Preset menu list.

Next
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8.1.7. Deleting or renaming a Process or its output

Processes » Basic Process functions » Deleting or renaming a Process or its output 

Deleting a Process or Process Version
If a Process in a track or its output is not wanted, they can all be deleted together by RIGHT CLICKing

on the unwanted Guide, Dub or Output Control Block and selecting from the pop-up menu shown right:

Delete Selected Process.

To delete only the currently selected Version of a Process, select Delete Selected Process Version.

Renaming a Process

If you wish to rename the variable part of a Process name that is automatically created, RIGHT CLICK

on the Guide, Dub or Output Control Block and select Rename Process from the pop-up menu. This will

also relabel the relevant segment in its Output Track.
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Type the new name into the highlighted field displayed and press the Enter key.

Normally, you will not need to rename processes.

Next
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8.1.8. Display of editing strength

Processes » Basic Process functions » Display of editing strength 

In the Match and Adjust processes, Revoice Pro tries to do as little processing as possible. When it does

process a signal, it displays an indication of the relative amount of processing that has been applied

along the audio waveform. This will help you focus your attention when you listen for the changes. 

As shown right in red oval, small block-shaped markers at the bottom of the track waveform display, vary

in their brightness depending on the  amount of editing that has been done to the waveform above each

block. Lighter means more processing. Dark means none. 

You can turn this display on and off in the Revoice Pro Preferences window using Show Editing Strength

as in the picture below.
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Next
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8.2. Match Process

Processes » Match Process

The Match process is one of the major unique features of Revoice Pro. It aims to transfer performance

characteristics of one audio signal onto one or more other signals. It works in four basic steps.

1. The Match process first determines the timing relationship between key features of a Guide and

a Target (Dub) audio signal using improved Synchro Arts' VocALign® technology

2. Next, the process measures performance-related features (such as timing, pitch, vibrato and

level) of both the Guide (which usually has certain preferred performance characteristics) and

the Target.

3. User-selected Guide performance features are transferred to the Target audio to create a new

Modified Target signal with the selected Guide features.

4. The transfer process usually includes the timing alignment, so Guide's features are incorporated

at precisely the correct places along the Target. However, this is an option.

Features
· SmartPitch allows the user to work with Dub signals that are a combination of both unison and

harmony parts. Users have the option to:

o Match All To Guide - Align all pitch to match the guide (current behaviour)
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o Match Unison Only - Align all pitches to match the guide when the pitches are

close together and ignore anything else. This will match unison sections but not

process any harmony notes.

o Match Unison & Tune Non-Unison - Align all pitch to match the guide when the

pitches are close together and apply 100% tuning to anything else.

· The "tightness" of the transferred feature can be controlled to allow natural acceptable

differences to pass through unchanged.

· Optional user-inserted "Protected Regions" allow selected sections of the Target signal to be left

unchanged.

· "Process-based" monitor switching, via single keys, provides instant comparison of inputs and

outputs one or two signals at a time.

· The effects of any changes made to Match control panel parameters will be immediately visible

(after rendering) in the displayed output graphics of pitch, level and waveform traces.

· The automatic Match processing can be followed by (or replaced by) manual editing of the

output features.

· Match Pitch processing settings can be made time-varying.

· Multiple Dub signals can use the same Guide and be efficiently processed at the same time.

· SmartAlign improves alignment when silent gaps exist in long clips, only aligning where

necessary.

· Manual sync point can be used to set specific times where sync should align.

Next 

Topics in this section:

Match: step-by-step introduction

Match: detailed operation

Related topics:

Online video introductions or tutorials

Workflows

Basic Process functions

Editing signal waveforms

Audio setup, monitoring and playback

Adjust functions
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8.2.1. Match: step by step introduction

Processes » Match Process » Match: step by step introduction 

Setting up a new Match process and creating and hearing the output signal can take as few as two key

strokes and uses a New Process window that can remain on screen.

If Revoice Pro has automatically correctly selected the right process, the right input and output tracks

and processing range, then all the user has to do is press the N key on the keyboard to create the new

process, followed by the Space Bar to render the output and start playback.

Next

Topics in this section:

Before applying a new Match Process

Check/change Match settings

Create a basic Match Process

Play and compare the Match output audio

Match Views

Related topics:

Workflows

Match: detailed operation

Basic Process functions

Pro Tools "Quick Match"

Studio One "Quick Match"
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8.2.1.1. Before applying a new Match Process

Processes » Match Process » Match: step by step introduction » Before applying a new Match Process

Loading audio
Before applying a Match process you will need to load Guide and Dub audio tracks into Revoice Pro,

following one of the methods described in Workflows. There are options for importing audio files directly,

and various methods that work quickly and easily with specific DAWs.

To hear the Revoice Pro outputs, you will also need to have set up Revoice Pro's audio monitoring.

This section assumes that suitable Guide and Dub signals are already loaded in Revoice Pro and that

either the Guide or Dub audio waveform is selected (i.e. light grey) following being loaded.

· One way to cut down keystrokes when using Revoice Pro, is to load entire tracks of audio into

Revoice Pro and then process these in sections, working from the start towards the end. 

· Alternatively, you can load audio in shorter, phrase-length sections, particularly if the signals

differ so much that Revoice Pro cannot process the entire tracks successfully. What is most

efficient will always depend on the signals' similarities and your preferred workflow.

· Another way is to load the whole of the Guide into Revoice Pro, then the Dub in manageable

sections.

· If necessary you can use Revoice Pro's basic waveform editing tools to split long lengths of the

loaded audio waveforms into sections but it is not the most efficient approach.

Tips for effective Match processing
· Processing can sometimes be applied to the whole length of the audio at once, but it depends on

the content of the tracks, the gaps between audio energy and basic structure and energy of the

signals. In some cases, slightly different steps might be needed for longer signals or entire files.

· For efficient Match processing, and while you are getting used to Revoice Pro processes, it is

sometimes better first to try processing sections of the Guide and Dub that are much less than a

minute long, and you can later experiment with longer (or shorter) sections as the procedure
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becomes more familiar. One way you could do this is to load portions of the Guide or Dub signal

waveforms together in sections say between 30 to 60 seconds and process these sequentially.

· Processing sections that are less than minute in length also helps you to check the audio

carefully as you proceed through it. 

· You can use carefully positioned Match Process Control Blocks to process phrases or segments

of the Dub and Guide together and output the processed audio as you go. This also allows you

to set the start and ends of Guide and Dub Match Inputs to be different as required.

Next

Related topics: 

Match: detailed operation
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8.2.1.2. Check/change Match settings

Processes » Match Process » Match: step by step introduction » Check/change Match settings 

If you do not see the New Process Window (shown in the image below), then you need to open it. There

are two ways to do this.

· Right click in any Process Control Track and select Match Timing / Pitch / Level.

or

· Make sure the Revoice Pro session window is selected and press the B key on your keyboard.

This will open the New Process window as shown below. Left click the Selected Process drop

down to select Match Timing / Pitch / Level. Pressing the B key again will close the window - but

it is generally more efficient to leave this window open.
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Revoice Pro automatically preselects all of the drop down menu items in the New Process window. We

briefly explain each drop down option used in this first example.

· Selected Process: is correctly set to be a Match process. (It will be what was previously selected

until you change it).

· Initial Input Start and End: Selected Audio uses any audio selected and shown in light grey in a

session track, from start to end. Alternatively, if a Playback Range has been set, it can be used

for the new process. These options are discussed in more detail in Setting a Process Control

Block.

· Presets: you can change the Match process settings before creating the process. If nothing is

changed, then the current User Default Preset (or, if that's not selected, the Factory Default) will

be used. You can choose from one of the provided Factory Presets in the Presets drop-down

menu as a good starting point for processing typical programme material. (See Process

Presets.)

· Process Group: this Process can be made part of a Process Group if required, but "No Process

Group" is the default.

· Inputs: choose the audio tracks containing Guide and Dub respectively. See Changing input and

output tracks for more detail about this menu item.

· Output: Output will default to 'Automatic' and will create a new track when applying the process.

The majority of the time, you should leave this set to automatic. If needed you can click the drop

down to specify an already existing track.

· Number of processes: it is possible to apply multiple processes to the same Guide, each creating

a new Dub track. See Creating multiple Match processes for more detail.

Next
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Related topics: 

Match: detailed operation

Changing input and output tracks

Process Presets

Process Control Track

Playback Range
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8.2.1.3. Create a basic Match Process

Processes » Match Process » Match: step by step introduction » Create a basic Match Process 

Since the settings are set up correctly, we can specify our Guide and Dub tracks by clicking their

respective 'Add >>' buttons.

First select your Guide track in the list of available tracks on the left side:

Then we can select our Dub track and click the lower 'Add >>' button. If we had multiple Dubs to be

aligned with the same guide, we could add them as well. See Creating multiple Match Processes for

more.
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When you have added both your Guide and Dub tracks, your New Process window should look like the

below image:
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We can now create and run the Match Process. Simply left click the New Process button at the bottom of

the New Process window or, if Revoice Pro is the selected program, press the N key (shortcut) on the

keyboard.

In this example, creating the New Process will insert the blue (selected) Guide and Dub Process Control

Blocks (shown in the picture below with names Match:LEAD VOX 2-Guide and Match:LEAD VOX 2-

Dub) into the Process Control Tracks (below each corresponding audio waveform). These Blocks show

where the processing will start and end for each input signal.
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A red line will also appear in the Output track (Audio 3), showing where the output audio of the process

is ready to be rendered. However, if background processing is turned on the Energy of the Guide and

Dub will be shown in blue and orange in Tracks 1 and 2 respectively, and the output audio will be

rendered immediately and appear in Audio 3 (along with the pitch trace). The yellow trace over the blue

Guide energy shows how well the time-aligned Dub energy is being matched to the Guide Energy

pattern.

If the input audio, output audio, or range settings do not seem correct, the user can use CMD Z (Mac) or

CTRL Z (Windows) to remove the Process, then change the setting, and re-create the process with the

corrected settings. 

Match Process Control Panel

To inspect and change the audio processing settings in the Match Process Control Panel, if the Match

process Output, Guide or Dub process control track is selected (blue), press the P key on the keyboard

(or the "open" arrow  in the Guide or Dub Process Control Blocks) to open the Control Panel as

shown below. 
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Make any required adjustments (details are given in Adjusting Match settings) and the audio will be

reprocessed. Press P again (or the close button) to close the panel.

Next
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Related topics: 

Match: detailed operation

Adjusting Match settings

Process Control Track

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.



Revoice Pro 5 Manual Publication8

425

8.2.1.4. Play and compare the Match output audio

Processes » Match Process » Match: step by step introduction » Play and compare the Match output

audio 

By default, the output audio will already have been rendered and pressing the Space Bar will start

playback of audio, and you can skip the next paragraph. 

If a red line still shows above the output track), the Match process needs to be rendered before it can be

played. Then press the Space Bar on the keyboard. This will start playback through the soloed tracks. 

You can save time by soloing the output track(s) you will want to hear before playing. To Solo the

track(s) with:

· The "Aligned" Output (in Track 3 -"LEAD VOX 2 [OUT]") on its own - press the A Key.

· The "Aligned" Output with the Guide (in Track 1) - press the E key.

(These and other process dependent track solo keys can also be pressed while playing audio.)

In the track named LEAD VOX 2 [OUT], the light grey shows the output audio waveform, and the various

lighter blocks and lines show the time-adjusted output measurements from the pitch measurement

system.
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Quite often, the above steps will provide a satisfactory result with little or no further effort, apart from

transferring the output audio to your DAW or a file.

If the results are unsatisfactory, you may need to adjust Match settings, refer to Match problem solving,

or do some manual editing of the output track attributes in order make things sounds as you want them

to.

Next

Related topics: 

Match: detailed operation

Export audio from Revoice Pro

Playback range
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8.2.1.5. Match Views

Processes » Match Process » Match: step by step introduction » Match Views 

The Match process contains a large amount of information that can be shown in each track as audio,

energy, pitch and level. Moreover, what is shown in each track depends on the role of the audio in the

Match process, i.e. whether the track holds the Guide, Dub or Output.

To see and inspect the Match's information more easily, a set of Match View Controls has been added in

Revoice Pro 4.  

This lets the user turn on only the information (described by each label) next to the on/off switch that

provides the right assistance to understand the main features of each signal.

For example, in the image below, the Match View Guide, Dub and Output Pitch switches are on and the

others are off. The Pitch traces are shown in the same colour as their ON switch surround.

Pitch switches that are ON also show the "non-pitched" audio in light blue.
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In the image below, on Energy is ON, showing the Guide energy in blue, the Dub energy in Orange, and

the Aligned Dub energy in Yellow over the top of the Guide's energy.

How well the yellow trace fits with the blue profile will quickly show if the signals are aligned in time and

where they are not aligned.
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Lastly, below, we show the Level switch ON, showing the dB values along the signal. 

In addition, we also have selected dB in the drop down menu above the Guide track's display control to

the right of the guide track at the top. This shows a dB scale on the left.
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Adjusting the displayed traces' heights and locations
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Clicking on the drop down menu at the right top of each track will bring up

the selector shown right to choose what display trace can be controlled in height and/or position.

The selected traces (except for energy) can me moved up and down in the window with the vertical

slider to the right of the track.  The pop-up slider controls the height. Energy displays can only be

increased or decreased.

Holding down shift key, while moving the popup slider applies the changes to all displays of the same

feature.

"Set Automatically" means that the display will

change according to what feature is selected in the pop up menu obtained by RIGHT CLICKing in a

track. An example is shown right. Selecting Edit energy will turn on the Energy displays.

Next
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8.2.2. Match: detailed operation

Processes » Match Process » Match: detailed operation 

This section gives more detailed instructions and information for the Match Process, its operations and

settings.

If you don't understand the basic principles of Match yet, you should read the Match overview and

Match: step-by step guide.

For details of functions common to all Processes see Basic Process functions. This explains a number

of the points mentioned below.

When setting up a Match process, you need to specify:

1. That the "Selected Process" is a Match process

2. Which tracks contain the Input Guide and Dub shown in the "Inputs" selector.

3. If needed, you can specify an output. Revoice defaults to 'Automatic' and this will setting will

cover the majority of use-cases.

4. What are the time ranges of the Guide signal and the Dub signal

5. What are the Match process settings (Process Control Panel)

6. Whether you want to process more than one Dub at the same time with the same settings.

Revoice Pro chooses these settings for you automatically when you have done the same processing

previously, and when you set a Playback Range or create new tracks.

IMPORTANT: There are, though, many times that these settings will need to be altered.

In addition, using the Adjust functions (particularly Adjust Region) the time and pitch of Lead and

Harmony Guide tracks can be modified first in Revoice Pro for creative or corrective purposes. 

The advantage of doing this in Revoice Pro is that modifications to Guide tracks will be automatically

passed along to other tracks using the Guides' timing or pitch information.

Next
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Topics in this section:

Adjusting Match settings

Creating multiple Match Processes

Process Groups

Creating time-varying pitch processing settings

Match: advanced techniques

Related topics:

Workflows

Match Process

Match step-by-step introduction

Basic Process functions

Editing signal waveforms

Audio setup, monitoring and playback

Manually adjust timing, pitch and level
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8.2.2.1. Adjusting Match settings

Processes » Match Process » Match: detailed operation » Adjusting Match settings 

To adjust the Match settings after creating a Match Process, you you need to make sure you have

selected the correct Match Process before you open its Match Control Panel. That means you must

have selected either the Match Output audio, the Dub Process Control Block, or the correct Guide

Process Control Block (where there are more than one Match Process Control Blocks in a stack). Refer

to Process Control Panel for more information.
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Press P key to open the Control Panel as shown right. 

You can repeatedly try other Presets or modify the parameters in the Control Panel and listen to the

result. 
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The Match Control Panel can remain open and, while signals are playing, you can adjust controls and

the process will be applied.

Time-varying automation can be applied to some Process parameters.

Match Panel Controls

Presets (shown top right with "Factory Defaults") allows you to select Factory or  your own previously

saved "User" settings, and to save your own User Preset settings.

There is also a Compare function to compare saved versions of a Process, and a Pinning control to

keep this Process Control Panel open (while opening other Control Panels).

For Match Processes there is a Process Lock button (shown locked red in the picture below) below the

Compare and Presets section. This fulfils the same function as the lock button on the Process Control

Track, and will stop further automatic processing from taking place. This is to stop any optional manual

edits from being overwritten.

The pitch range of automatic processing is set in the Processing section below Automatic Transfer and

Dialog/Music mode switches. This is explained in the next topic.

Advanced Algorithm – this function tries to preserve the envelope of source audio during pitch correction.

Try ON if you hear unwanted artefacts. (Default OFF.)

Hi Res Mode – this function edits the signal at a higher resolution, and can reduce artefacts in pure

signals. For higher pitched signals try ON if you hear unwanted artefacts. (Default OFF.)

Each of the controls shown has a "pop-up" explanation which will appear shortly after hovering the

mouse pointer over a slider control or parameter display box. Further details of controls and what you

might be able to do with them are given in the table below.

Control Description

AUTOMATIC
TRANSFER

· If Lock icon OFF, all processing below is available. 
· If Lock icon ON (Red), turns all further automated processing off.
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Timing · ON = Transfer Guide's timing to Dub automatically but obeying the
Tolerance and Alignment settings.

· OFF = The Guide features of Pitch or Level, if ON, will be transferred to
the Dub at the correct timing but without modifying the Dub's timing.

· Include Pitch Variations = Uses audio pitch as well as energy envelope to
effect time alignment of Dub. Useful when energy variations alone are not
clear enough to be effective, such as in legato music lines.

· SmartAlign = enables effective alignment of audio that has large gaps (of
silent content) in Guide or Dub. (There is a separate set of Match Presets
that function in the same way as the basic Presets, except with
SmartAlign enabled.)

Other Timing
Controls  · Alignment - Choose desired time-alignment flexibility

· Tolerance - (Tight/Loose) sets maximum allowed offset in timing
difference.

· Protect Transients - Reduces possible distortion effects. (Default: ON)
· Max Shift - Reducing values restricts the maximum time shift from its

original position allowed for the Dub audio. 
(Default: no Limit)

· Soft Limiting for Shift- Introduces a more flexible boundary for the Max
Shift setting. (Default: ON)

Alignment Setting Main characteristics
Lowest Flexibility Alignment is least flexible, creates fewest edits. Sound

quality may be best.
Low Flexibility  Alignment is not very flexible, creates fewer edits.

Sound quality may be better.
Normal Flexibility
(Default)

Try this first as it works
best in most cases, balancing good alignment with
moderate editing.

High Flexibility Alignment is the most flexible and allows more editing,
which may
compromise sound quality

Maximum Compression Tries to match the Guide by time compressing the
aligned audio as much as possible.

Maximum Expansion  Tries to match the Guide by time-expanding the aligned
audio as much as possible

Normal Flexibility + Pitch If energy pattern does not change but pitch in Guide
and Dub change together, this can work in signals with
legato pitch changes.

Pitch · OFF = Guide Pitch will NOT be transferred to the Dub
· ON = Transfer Guide signal's pitch to the Dub (time aligned).

Other Pitch
Controls  

· Tolerance - (Tight/Loose) sets maximum % allowed pitch difference.

· Transfer Strength – Proportion of correction factor transferred. 100%
means use only the Guide's pitch, 0% means use only the Dub's pitch.

· Target Mode (Drop Down menu):
o Nearest Octave – transfer exact pitch but allow natural octave

jumps



Revoice Pro 5 Manual Publication8

438

Related topics:

Pitch range

Playback controls

Playback range

Track mute and solo

Next
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o Absolute – transfer exact pitch
o Relative – pitch change relative to Guide pitch at “phrase” starts
o Monotone – all pitch changed to measured average pitch

· Tuning - Match long term average variation of Dub to Guide's.
o 0% = Keep Dub tuning
o 100% = Apply Guide longer term average tuning to Dub.

· Fit - short term variations of Dub to Guide's (e.g. vibrato) from 0% (not at
all) to 100% exact match. 

· Offset – modify output signal pitch by % shown
· Smooth Jumps in Pitch – (Default ON)

SmartPitch Mode: affects what matched to the Guide track tuning
For details, see SmartPitch

Formants · Linear shift - adjusts the frequency of formant regions up or down to
change the character of e.g. a voice. (Formants are resonant frequencies,
typically of the vocal cavity, which affect the character of the sound. For
example, female vocal formants have a slightly different structure to male
ones.)

Level · ON = Transfer Guide signal level to Dub (time-aligned).
· OFF = Do not transfer signal level

Other Level
Controls

· Tolerance - (Tight/Loose) sets maximum % allowed level difference.
· Transfer Strength – Proportion of correction factor transferred
· Offset – add a constant gain to the Dub level trace.
· Keep Dub's Average Level - modifications are made relative to Dub

average
· Attack – Slew time (smoothing) applied to increases in level changes

(Default = 0.01sec)
· Decay –Slew time (smoothing) applied to decreases in level changes

(Default = 0.03sec)

Display · Energy Band: Display the selected octave-wide frequency band used for
energy measurements that are input to the alignment algorithm.
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8.2.2.1.1. SmartPitch

Processes » Match Process » Match: detailed operation » Adjusting Match settings » SmartPitch

As of Revoice Pro 5, we have added extra functionality to the Pitch Matching technology to better

handle signals with a combination of both unison and harmony. For example, SmartPitch enables the

user to easily work with a Dub track that occasionally sings different pitches to the guide.

SmartPitch is enabled in the Pitch section of the Process Control Panel, accesible with P or with the 

 on the left side of a Process in the Process Control Track.
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Clicking the dropdown menu underneath 'SmartPitch Mode' will allow the user to select from the

following pitch matching modes:
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1. Match All To Guide - Align all pitch to match the guide (default behaviour)

2. Match Unison Only - Align all pitch to match the guide when the pitches are close

together and ignore anything else. This will match unison sections but not process any

harmony notes.

3. Match Unison & Tune Non-Unison - Align all pitch to match the guide when the

pitches are close together and apply 100% tuning to anything else.

In combination with the Scales controls, the user can quickly match, align, and tune parts featuring a

mix of unison and harmony.

Next
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8.2.2.1.2. Pitch range

Processes » Match Process » Match: detailed operation » Adjusting Match settings » Pitch range 

Sometimes it's necessary to adjust the pitch detector range of the Match Process to recognise the full

range of a signal.

In this example with a flute as a Guide track, we have started with a Guide High Frequency pitch

measurement limit set to 600 Hz as shown in  the Processing section of the Match Control Panel below.

This means the Guide pitch measurements stop at 600 Hz and will not find or display notes above this

frequency.

Consequently, this example's pitch display does not yet show any pitches correctly above 600 Hz and,

as a result, there are audible errors in the output.

There are two ways to adjust the pitch range:

1. Use the Match Control Panel and modify the limit values shown (either with the sliders or typing

a value into the frequency display box). This method is quickest when the pitch range limits are

known. OR

2. Use the Track's graphical display to show an adjustable pitch limit display bar and move that up

or down (in pitch) until all the notes or pitch values appear correct. (This method is

recommended when the pitch range is not known because it gives immediate feedback.)

We will continue to use the flute example to show how to do both of these.

Method 1: In the Processing section of the Match Control Panel shown above, a new value for the Guide

High Frequency pitch limit (shown in the red box) can be entered in by moving the slider or typing in. Try

entering a higher frequency if the system is not recognising the fundamental pitch of all the notes.

The effect of the new value can be immediately checked by pressing the Space Bar to reprocess the

signal with the new value. The new pitch trace will be displayed and the audio played.
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Below we show before and after using the correct upper limit for the flute signal in question.

Upper limit 600 Hz. (Before correction)

Upper limit 900 Hz (After correction)

One can see all the correct new notes appearing, which are higher in the display and more detailed

structure.

Method 2: In the track display, we can turn on horizontal bars showing the Match's high and low pitch

limits in the Guide and Dub Tracks along with the pitch measurements. To enable the display of these

pitch limit bars, RIGHT CLICK in the Guide or Dub track, select the name of the Match Process being

adjusted (in this example, Match:1) and then select Edit Pitch Limits as shown below.



Revoice Pro 5 Manual Publication8

444

Once that is done, use the mouse wheel or the gray scale offset slider at the right of the track to bring

the upper/lower pitch limit bars into view.

The pitch limit can be adjusted by LEFT CLICKing on the bar, then holding the LEFT mouse button

down, and dragging the bar up or down to the desired position and releasing the mouse button. 

The new pitch trace will be calculated and displayed. By raising (or lowering) the bar until no further new

pitches are displayed, the entire pitch range can be shown as measured correctly.

For low-pitched instruments (such as bass guitar, a similar adjustment can be used to move the lower

pitch limit to as low as 25 Hz. This would allow manual editing for such extreme signal pitches.

Next
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8.2.2.2. Creating multiple Match Processes

Processes » Match Process » Match: detailed operation » Creating multiple Match Processes 

It is possible to generate multiple Match Processes from one Guide and a number of related Dub tracks.

This is an efficient means of creating stacks of vocals or instruments.

When creating multiple Match processes there is one Guide track whose features will be transferred to

multiple Dub track inputs that have been loaded along with the Guide. Each Dub processed creates its

own output.

Multiple Match processes can be created either automatically (using the Number of Processes function

in the New Process window).

Possible applications:
· Instantly tighten the timing and/or pitch of two, three or more recorded versions of a lead vocal

("stacked vocals") to the best "guide" lead vocal (which could be a different singer).

· Instantly create stacks of time-aligned harmony tracks (to one Guide Harmony for pitch and/or

time or to the lead vocal for timing only.

Process Groups link the settings of multiple Match processes, so that changes in one affect all the

others in the same group.

Next

Topics in this section

Multiple Match Processes: automatic

Related topics

Process presets

Adjusting Match settings

Process Groups
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8.2.2.2.1. Multiple Match Processes: automatic

Processes » Match Process » Match: detailed operation » Creating multiple Match Processes » Multiple

Match Processes: automatic 

As of Revoice Pro 5, Revoice's Match process handles multple Match processes and multiple Dub

tracks from the same New Process Window in a more easily understandable way. By assigning one

track as a Guide, and up to 25 Dubs, Revoice can automatically create new Match processes and tracks

for each Dub that needs to be aligned.

Aligning multiple lead vocals

To begin we have a session with four total tracks:

· LEAD VOX 1 will be our guide track.

· LEAD VOX 2, 3 and HARM 1 are our dub tracks that we would like to align to LEAD VOX 1.
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We have selected the LEAD VOX 1 audio region (shown in light grey) and will now create a new process

by right clicking on the process control track and selecting 'Match Timing / Pitch / Level'.

This will open the New Process Window shown below:

To align multiple Dubs to the same Guide track, we will move LEAD VOX 1 to the Guide Track section

by clicking the upper 'Add >>' button. We will move our 3 dub tracks to the Dub section by clicking the

lower 'Add >>' button. Your process window should look similar to the below image:
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We can make any necessary changes to Preset or Process Groups, and then click Create New Process

(or the 'N' key) when we are ready. This will create an output similar to the below image:
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Because we used the default Output setting of 'Automatic' Revoice has created three new tracks to

receive the output of each process. In descending order, we can see:

· LEAD VOX 1 with it's Match Guide processes. There are actually three total processes here, one

for each Dub track. To access them, right click the process and select the process you would like

to modify from the menu. See Displaying overlapped Process Control Blocks for more detail.

· HARM 1, LEAD VOX 2, and LEAD VOX 3: Our Dub tracks, each with their corresponding Match

process.

· Our three newly created output tracks, each labeled with [OUT] in their name. One track has

been created for the output of each Match process.

Next
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8.2.2.3. Process Groups

Processes » Match Process » Match: detailed operation » Process Groups 

When you create one or more Match processes you can add them to a process group.
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Changing the setting or the preset for one process in the group updates the settings for all processes in

the group.
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Group Playback plays only the guide, dub or aligned audio for members of the group. All other audio in

the session is not played. The dropdown menu below the Group name allows you to select what tracks

will be played.
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This mode overrides track solo and mute commands.

You can also add and remove processes from an existing group.

If you delete a group all processes in the group will be deleted. Right click in an empty area of the

process group to display this menu.
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8.2.2.4. Match: advanced techniques

Processes » Match Process » Match: detailed operation » Match: advanced techniques 

This section describes various advanced procedures that can be used to effect better alignment

between Guide and Dub, or to meet challenges that arise in processing using Match.

There may also be times when the processing creates audible artefacts, either in a small or large part of

the signal. These artefacts may arise for a number of known signal-related reasons, which are generally

understandable and fixable. 

Examples of challenges include:

· Localized differences between the Guide and Dub signals as in:

o Vocal "creaks" (where the pitch drops briefly an octave lower or is unmeasurable)

o Phrase or word startup differences (onsets)

o Differences in phrase beginnings or endings being breathy

o Breaths taken between words differently in the two signals

o A word, words or other sound appears in one signal but is absent from the other (this is

quite common in dialog replacement with noises occurring in the Guide track)

· Discontinuous signals: Having short sections of a Dub with silence between each short section

and trying to align this discontinuous signal to a continuous Guide (or vice versa)

· Extra silence at start of signal file: Setting a Match input to start in possibly long stretches of

digital silence before the signal starts can sometimes cause a problem

· Tight cuts at signal starts: Not giving a Match Dub input enough "non-signal" to allow it to be

moved, if required.

· Different or extreme signal pitch ranges

· Legato music lines where energy alone is an insufficient cue for alignment to be done effectively.

Most of these situations are quickly solvable using the automatic tools in Revoice Pro, and are

discussed in this section or in the Adjust section.

If the automatic tools don't solve the problem you may need to manually edit an attribute of the Output

Track, or vary them over time using time-varying automation.
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Tight cuts at signal starts
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Sync Points and offsets

Aligning signals that have limited dynamic range

Adjusting pitch processing

Related topics:

Manually adjust timing, pitch and level
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8.2.2.4.1. Protected areas

Processes » Match Process » Match: detailed operation » Match: advanced techniques » Protected

areas 

When you have located any of the differences between the Guide and Dub signals that are listed in

Match: advanced techniques, editing the audio signals could be tedious and maybe even not help.

For example, if a section of a Guide (say, at a breath) is "non-pitched" and this information gets

transferred to the Dub where there is pitch, this will sound wrong in the Output.

Revoice Pro provides a mechanism for quickly inserting a protective “coating” over a region or section of

the Dub audio that prevents that section from getting Time and/or Pitch modifications. Quite often,

inserting such a Protected Area in the Dub signal to stop it being processed removes the processing

artefacts quickly and makes the output acceptable. This section explains how to do this.

Protected areas - an illustrated example
In the image below, the blue Playback at the top of the screen is positioned so it extends through a

breath (low level audio) seen in the Dub Track Harm 1 (dark grey waveform) that does not occur in the

Guide Track Lead Vox 1 (light grey) where a note is held instead. The problem here is that the pitch in

the guide signal note cannot be sensibly transferred to the breath region, which has no pitch.
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The next image below shows the result once a Match process is inserted with Match settings selected to

process Time and Pitch. In the Output track, the Dub audio has been pulled back into the gap. This

result may sound OK, or not, depending on the audio content.

(The following procedure requires that the Energy View switch is ON in the Match Views Control Panel.

If it is, the display should look similar to the image above.)

In this example, if you want to preserve the breath sound and the pitch just before and after it, setting up

a Protected Area in the Dub signal can be quickly done with the following operations:

1. Make sure the Match Process is selected. If selected, the process will be blue on the Process Control

Track.
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2. Right click in the Dub track display at the position you want the protection to start (before the start of

the gap in this example) and select from the Pop-up menu shown right Add Protected Area. Go to step 4

if you can select this option.

3. If you do not see the option to Add Protected Area, and you see a menu similar to that shown below

left, then right click the Match name ("Match:HARM 1" in this example) and select Edit Energy and let

the pop-up close. Then right click again in the track and the pop-up menu should appear as shown

above right with Add Protected Area option. 

4. Select Add Protected Area and in the follow-on pop-out menu shown below, select whether to protect

the Dub Pitch, Time or both from being changed. We have chosen Protect Pitch and Timing for this

example. 
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5. A short, transparent red Protected Area will be inserted in the Dub track (as shown below) which can

be extended or narrowed by putting the mouse at either side of the range block, left clicking and

dragging either the edges, or if the hand cursor is shown, click in the range and dragging the whole

Protected Area to the required position as shown below. The Protected Area will contain one or two

possible icons: clock (time) or musical notes (pitch) depending on the protection mode selected.

When the audio is processed with the Protected Area, the Time or Pitch features selected for protection

will not be processed in that Dub audio Area. As shown in the Output Track in the picture above at the

bottom, the protected range in the Dub track appears unprocessed in the Output track.
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If you set up a loop with the Playback Range and Loop control, the edges and position of the Protected

Area can be manipulated while listening for the best-sounding join at each end of the region. This is

done by manipulating the Protected Area and then rendering the Output (processing) each time a

change is made to hear when the result sounds most acceptable.

A Protected Area's settings can be changed or the entire Area can be deleted any time. To do this, right

click on the Protected Area and the menu similar to the one below will appear. Simply chose either

Modify Protected Area and reselect the feature to be protected or select Delete Protected Area.

 

Next
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8.2.2.4.2. Tight cuts at signal starts

Processes » Match Process » Match: detailed operation » Match: advanced techniques » Tight cuts at

signal starts 

If a Dub Match Process Control Block has no "room" (i.e. enough "non-signal") to allow the Dub to be

pulled forward (or pushed back) if required for alignment, then the Output audio might sound unnaturally

sped up or time compressed (or stretched).

In this case, move the start of the Match Dub Process Control Block further to the left in time, to allow

movement of the audio without being wrongly compressed or stretched.

Next 

Copyright © 2023 by Synchro Arts Ltd All Rights Reserved.



Revoice Pro 5 Manual Publication8

465

8.2.2.4.3. Gaps of silence in audio waveforms

Processes » Match Process » Match: detailed operation » Match: advanced techniques » Gaps of

silence in audio waveforms 

If an audio signal starts with a long stretch of silence, or there are long or short gaps of silence between

sounds in a long signal, it can sometimes cause problems if it is used as a raw Guide or Dub signal.

Several options are available.

1. In Revoice Pro 4.3 or above, use SmartAlign, which automatically attempts to align audio where

there are large gaps in either Guide or Dub.

2. Silences can be edited out of the signal before it is processed in the DAW or in Revoice Pro.

3. The Match Process Control Blocks can be placed so they do not include or submit the silence to

the Match process.

4. Revoice Pro contains specific mechanisms for "ignoring" digital or low level silent areas of

waveforms which often can be used successfully.

Alternative approaches if not using SmartAlign
Although SmartAlign will be the preferred method in most cases, Revoice provides several alternative

tools for dealing with gaps of silence. They are detailed below.

Signals with long silences before the audio
signal starts
Sometimes, an audio file that is dragged into Revoice Pro has silence for many seconds before the real

audio signal starts. If the Guide and Dub have roughly the same amount of silence in both files before

the audio starts, then if the Match Process Control Blocks both start at the start of the silence, it is likely

to work.

If the result is not right, however, it might be best to move the starts of the both Match Guide and Dub

Process Control blocks to start closer to the start of the actual audio signals.
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If there are different amounts of silence at the start of each, make sure the Guide and Dub Process

Control Blocks have roughly the same amount of silence before the actually audio starts.

Signals with silence between blocks of audio
There are three critical settings you should consider in this situation.

1. Set the Guide and Dub Process Control Blocks to start a little (around 0.25 seconds is recommended)

before the first similar audio that is to be aligned.

(This means the Guide and Dub Process Control Blocks might NOT start at the beginning of the Guide

audio - as the example below will show.)

2. In the Match Control Panel, use the Max Shift slider control (shown below) to reduce the maximum

movement of the audio to around 0.07 to 0.10 seconds (if the audio is similar). Turn OFF the "Soft

Limiting for Shift" switch.
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3. If the audio still does not quite align correctly, try also setting the Match Alignment control to "Lowest

Flexibility", as shown below.
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From Revoice Pro 4 a Match Preset named "Gaps in Dub Slightly Loose Time & Pitch" was added,

which is similar to the more recent SmartAlign function, and can be selected to change the Match

settings described in (2) and (3) above.

Next 
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8.2.2.4.3.1. SmartAlign

Processes » Match Process » Match: detailed operation » Match: advanced techniques » Gaps of

silence in audio waveforms » SmartAlign 

Revoice Pro 4.3 adds SmartAlign as an option in the Timing section of the Match Process settings.

When this option is checked, the system looks for and aligns only matching sections in Guide and Dub

audio, not processing long gaps of silence in either. This can help to avoid the need to break up longer

sections into segments for processing. SmartAlign is enabled in the control panel of a Match process

and is on by default in most of the presets.

Introducing SmartAlign

https://www.synchroarts.com/videos/revoice-pro-4-pro-tools-your-guide-to-getting-started
https://www.synchroarts.com/videos/revoice-pro-introducing-smartalign
https://www.synchroarts.com/videos/revoice-pro-introducing-smartalign
https://www.synchroarts.com/videos/revoice-pro-introducing-smartalign
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8.2.2.4.4. Sync Points and offsets

Processes » Match Process » Match: detailed operation » Match: advanced techniques » Sync Points

and offsets

Match Sync Points enable specific times to be identified at which Guide and Dub should be aligned. This

can be useful where there are particular instances in a long segment where precise alignment is

required, allowing some flexibility in between.

Sync Points are always pairs of points, one in the Guide, one in the selected Dub, shown as green dots

above the waveform display on each track when working correctly, but red if moved to a time when it is

impossible to achieve alignment. In the latter case the aligned output (shown in the third track below)

shows a red dotted line and 'Failed No path found through sync points'.
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The spotlight beam between the upper and lower Sync Points shows the connection between pairs in

Guide and Dub.

Sync offset indicators (vertical blue lines, shown below) move with the mouse pointer when hovering

over tracks to show the corresponding alignment points in Guide and Dub tracks.

TIP: if related Guide and Dub tracks are separated by other tracks in Revoice Pro, you can use the Z key

shortcut to display only the selected Process tracks.

Add a Sync Point
If there is more than one Dub track, select the relevant Dub track first, to which you want the Sync Point

to relate. 
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Right click at the timing point in the Guide where you want to insert a Sync Point, and select Add Sync

Point from the drop-down menu. This adds a pair of Sync Points (one in Guide and one in the selected

Dub), initially at the same time as each other. 

Drag Sync Point dots of a related pair, in either Guide or Dub, to move them in time, to points where you

want the two tracks to align precisely. 

Selecting Automatic Sync Points adds points at suitable times identified by Revoice Pro, which can then

be moved if needed.

Delete a Sync Point
Right click on any Sync Point and select Delete Sync Point from the drop-down menu, to delete

individual pairs of points. Clear All Sync Points deletes all of them.
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8.2.2.4.5. Aligning signals that have limited dynamic range

Processes » Match Process » Match: detailed operation » Match: advanced techniques » Aligning

signals that have limited dynamic range 

If a Guide or Dub signal has insufficient dynamic range for Revoice Pro to use its energy pattern to carry

out an alignment of performances, there is a "Normal Flexibility plus Pitch" option in the Alignment drop-

down of the Match Process Control Panel. This enables the pitch to be taken into account in the

alignment process, which can act as an additional guide when attempting to identify similar points in two

performances.

Revoice Pro 4.3 includes the option to Include Pitch Variations with any other alignment settings, using a

check box in the Timing section of the Match Process Control Panel.
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This is very useful for two voices or instruments creating a similar legato phrase.

 

Next 
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8.2.2.4.6. Adjusting pitch processing

Processes » Match Process » Match: detailed operation » Match: advanced techniques » Adjusting pitch

processing 

Sometimes, after using a process that transfers pitch of very different signals, audible problems in the

output can occur. In these cases, examining the pitch measurement traces of the Input and Output

signals can be very helpful in determining what is causing the problem, and indicating how to correct it.

You may then want to alter the way in which pitch information is automatically processed using the

Match Process Control Panel. In some cases manual editing can be done of the pitch, timing or level of

certain syllables or notes in order to correct them. You can also use time-varying automation to change

some of the Match pitch parameters over the course of a Process Control Block. 

The Pitch section of the Match Process control panel has a number of options for adjusting the way in

which pitch is handled by the algorithm. Most of these are explained briefly when hovering over the

control concerned with the cursor in the application itself, and in more detail in Adjusting Match settings.

https://synchroarts.clickhelp.co/smart/project-revoice-pro-5-manual/time-varying-automation
https://synchroarts.clickhelp.co/smart/project-revoice-pro-5-manual/time-varying-automation
https://synchroarts.clickhelp.co/smart/project-revoice-pro-5-manual/time-varying-automation
https://synchroarts.clickhelp.co/smart/project-revoice-pro-5-manual/time-varying-automation
https://synchroarts.clickhelp.co/smart/project-revoice-pro-5-manual/time-varying-automation
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In this section some detailed aspects of automatic pitch processing are explained in relation to

challenges that can arise with certain types of signal.

Next 

Topics in this section 

Pitch range

Pitch differences or roughness
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8.2.2.4.6.1. Pitch differences or roughness

Processes » Match Process » Match: detailed operation » Match: advanced techniques » Adjusting pitch

processing » Pitch differences or roughness 

Vocal signals with very low or rough pitch, or even bass guitars and flutes can be used successfully as

inputs to Revoice Pro and be automatically aligned or manually tuned.

You can also prevent transferring octave jumps that occur in one signal to another signal that doesn't

have them, and you can ensure that music signals remain in their correct harmonic relationship to each

other, such as at octave intervals.

You will only know that you have a problem if you hear it (e.g. artefacts in the output of a Match, Adjust

or manual pitch adjustment process) or see it in the Revoice Pro displays. 

Avoiding the transfer of rough pitch or octave
jumps
You can "remove" large swings of pitch in a "rough" Guide's pitch trace so that they are not transferred

to a smoother Dub signal in the Output. In other words, you can "fool" the pitch measuring system into

not creating pitch measurements that will result in artefacts in the Dub. You can do this by adjusting the

Guide's upper and/or lower pitch limits in the Match Control Panel:
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You can also drag the blue pitch limit lines on the pitch display, to exclude the extremes of pitch that you

might see in the Guide trace, (moving the Highest Freq limit shown below). 

The Smooth Jumps in Pitch mode can also be used to iron out abrupt changes in pitch during the

transfer process.
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Guide and Dub at different pitches
Sometimes a Dub signal will have been be sung or played at a different pitch to a Guide (say an octave

apart, or a minor third apart). If you want to transfer performance features of a Guide to such a Dub,
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while retaining their relative pitch separation, you will need to set the Pitch Correction switch to the

correct mode.

Offset can be used to introduce an artificial constant tuning offset into the Output Track (say to shift it by

a minor third musically).

The way these modes work is:

· Pitch correction rule (Drop Down menu):

o Nearest Octave – transfer exact pitch but allow Guide and Dub to keep existing octave

separations

o Absolute – transfer exact pitch

o Relative – pitch change relative to Guide pitch at “phrase” starts
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o Monotone – all pitch changed to measured average pitch

Next
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8.3. Doubler

Processes » Doubler 

The Doubler process creates natural-sounding double tracks in seconds from vocal or monophonic

instrument tracks. It can take as few as three steps to do this.

Features
· Provides controls for modifying timing variations, formants, and vibrato.

· Inputs and outputs can be mono or stereo.

· Stereo input signals can have independent channel controls or the channels can be phase

locked.

· Supports extreme parameter variations to create special effects.

· Comprehensive preset system.

Next

Topics in this section:

Doubler: step-by-step introduction

Doubler: detailed operation

Related topics:

Online video introductions or tutorials

Workflows

Basic Process functions

Editing signal waveforms

Audio setup, monitoring and playback
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8.3.1. Doubler: step-by-step introduction

Processes » Doubler » Doubler: step-by-step introduction 

Setting up a new Doubler process and creating and hearing the output signal can take as few as two key

strokes and uses a New Process window that can remain on screen.

If Revoice Pro has automatically correctly selected the right process, the right input and output tracks

and processing range, then all the user has to do is press the B key on the keyboard to create the new

process, followed by the Space Bar to render the output and start playback.

Next

Topics in this section:

Before applying a new Doubler Process

Check/change Doubler settings

Create a basic Doubler Process

Process and play the Doubler output audio

Related topics:

Workflows

Doubler: detailed operation

Basic Process functions
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8.3.1.1. Before applying a new Doubler Process

Processes » Doubler » Doubler: step-by-step introduction » Before applying a new Doubler Process 

Loading audio
Before applying a Process you will need to load audio tracks into Revoice Pro, following one of the

methods described in Workflows. There are options for importing audio files directly, and various

methods that work quickly and easily with specific DAWs.

You will also need to have set up Revoice Pro's audio monitoring. This will enable you to hear the

Revoice Pro outputs.

This section assumes that suitable signals are already loaded in Revoice Pro and that the input

waveform is selected (i.e. green) following being loaded.

· To cut down keystrokes when using Revoice Pro, we generally recommend the user loads entire

tracks of audio into Revoice Pro and then processes these in sections, working from the start

towards the end. This generally works very effectively.

· That isn't to say that the user shouldn't load audio in small sections if they prefer, or use the

Doubler to process an entire input track. These choices depend on the signals and the user's

comfort with their own workflow.

Next 
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8.3.1.2. Check/change Doubler settings

Processes » Doubler » Doubler: step-by-step introduction » Check/change Doubler settings 

Let's start with a simple example session with one short mono audio signal ("Lead vox") shown below

and create a mono Double of that audio. However, the techniques to be described will also work for

larger sections or even an entire track.

In the picture, the input audio is shown as "selected" (in light grey), which is how it would be immediately

after loading it. The New Process window is shown open at the right.

If you do not see the New Process window (shown in the image above on the right), then you need to

open it. There are two ways to do this.

1) RIGHT CLICK in any Process Control Track and select New Doubler.

2) Make sure the Revoice Pro session window is selected and press the B key on your keyboard.  This

will open the New Process window as shown above. Left click the Selected Process drop down to select
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Doubler. Pressing the B key again will close the window - but it is generally more efficient to leave this

window open.

The drop down menu items in the New Process window are usually set to a default or whatever they

were set to when last changed. We briefly explain each drop down option used in this first example, in

which none of these settings will need changing.

Selected Process: is correctly set to be a Doubler process.

Initial Input Start and End: the New Process window has correctly chosen the Selected Audio (which is

the audio shown in light grey) from start to end. Alternative options for setting this can be found in

Setting a Process Control Block.

Presets: you can change the Doubler process settings before creating the process. If nothing is

changed, then the current User Default Preset will be used. You can choose from one of the provided

Factory Presets in the Presets drop-down menu, as a good starting point for processing typical

programme material. Alternatively you can select the "Default" setting. (See Process Presets.)

Inputs: the Input is currently set to the track Lead Vox, into which the source audio has been loaded.

Output: Automatic (default) selects the output track for you, creating a new track as needed. It maintains

a relationship between input and output tracks even if they are moved. Alternatively, you can manually

choose an existing output track using the drop-down menu.

Number of Processes: it is possible to create multiple output tracks using this option. Output signals and

processes will be automatically labelled with a unique sequential number for easy identification (for

example Dblr:Lead vox, Dblr:Lead vox(2), ... Dblr:Lead vox(n)).  

IMPORTANT NOTE: All doubler outputs created from Multiple Processes will initially have the same

settings and will sound the same. If you want to hear different treatments, after multiple doublers have

been created, open the Process Control Panel for each of those doubler outputs and change the

parameters to a different setting from the other doubler outputs. 

Next 
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Related topics: 

Doubler: detailed operation

Changing input and output tracks

Process Presets

Process Control Track

Playback Range
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8.3.1.3. Create a basic Doubler Process

Processes » Doubler » Doubler: step-by-step introduction » Create a basic Doubler Process 

Since the settings are set up correctly, we can now run the Doubler Process. If Revoice Pro is the

selected program, simply left click the New Process button at the bottom of the New Process window or

press the N key (shortcut) on the keyboard.

 

In this example, two things are visible: Firstly, a blue (selected) Process Control Block labelled "Dblr:"

has been inserted in the Process Control Track below track 1. Note this is the length of the previously

selected audio (and the audio is no longer shown selected). This shows where the processing will start

and end.

Secondly, an Output track has been created, labelled "Lead Vox 1", containing an audio clip "Dblr:".

If background processing is turned on the output audio will be rendered immediately. If not, a red line will

show above the audio and pressing the space bar to PLAY will render the audio.

To inspect and change settings in the Doubler Process Control Panel, make sure the Doubler Input

Control Block is selected (blue), and the Session window is active, press the P key on the keyboard (or

the "open" arrow in the Guide or Dub Process Control Blocks) to open the Control Panel as shown right.

Make any required adjustments and then press P again (or the close button) to close the panel.
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Next 

 

Related topics: 

Doubler: detailed operation

Modifying the Doubler Process controls

Process Control Track
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8.3.1.4. Process and play the Doubler output

Processes » Doubler » Doubler: step-by-step introduction » Process and play the Doubler output 

If background processing is turned on, the output audio will already have been rendered and pressing

the Space Bar will start playback of audio, and you can skip the next paragraph. 

If a red line still shows above the output track), the Doubler process needs to be rendered before it can

be played. Then just press the Space Bar on the keyboard. This will start playback through the soloed

tracks. 

You can save time by soloing the output track(s) you will want to hear first.

· To solo the Output (in Track 2 -"Output 1") on its own - press the A Key.

· To solo both the Output signal and the Input (in Track 1) - press the E key.

· To solo the Input signal (In Track 1) on its own, press the G key.

Normally, the doubler output should ALWAYS be played with the input to hear the effect correctly.

(These and other process dependent track solo keys can also be pressed while playing audio.)  

Quite often, the above steps will provide a satisfactory result with little or no further effort, apart from

transferring the output audio to your DAW or a file.

You can alternatively use a Playback Range to highlight time periods of the audio to be Doubled, rather

than relying on automatically selected audio.

 

Next

Related topics: 

Doubler: detailed operation

Export audio from Revoice Pro

Playback range
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8.3.2. Doubler: detailed operation

Processes » Doubler » Doubler: detailed operation 

This section gives more detailed insights into the Doubler Process, its operations and settings.

If you don't understand the basic principles of Doubler yet, you should read the Doubler overview and

Doubler: step-by step guide. 

For details of functions common to all Processes see Basic Process functions. This explains a number

of the points mentioned below.

When setting up a Doubler process, you need to specify:

1. That the "Selected Process" is a Doubler process

2. Which track is the Input

3. Which track the Output should go to

4. What is the range of the Input signal

5. What are the Doubler process settings (Process Control Panel)

Revoice Pro chooses these settings for you automatically when you have done the same processing

previously, and when you set a Playback Range or create new tracks.

There are, though, many times that these settings will need to be altered.

In addition, using the Adjust functions, the time and pitch of Lead and Harmony Guide tracks can be

modified first in Revoice Pro for creative or corrective purposes. The advantage of doing this in Revoice

Pro is that modifications to Guide tracks will be automatically passed along to other tracks using the

Guides' timing or pitch information.

Next

Topics in this section:

Adjusting Doubler settings
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Related topics:

Workflows

Doubler

Doubler: step-by-step introduction

Basic Process functions

Editing signal waveforms

Audio setup, monitoring and playback

Manually adjust timing, pitch and level
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8.3.2.1. Adjusting Doubler settings

Processes » Doubler » Doubler: detailed operation » Adjusting Doubler settings 

To adjust the Doubler settings, open the relevant Process Control Panel by selecting the Doubler's

Process Control block or the Doubler output and pressing the P key. 
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You can repeatedly try modifying the parameters in the Control Panel and listening to the result. The

Doubler control panel can remain open, the controls adjusted and processing run while signals are

playing.
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Time-varying automation can be applied to some Process parameters.

Related topics:

Playback controls

Playback range

Track mute and solo

Time-varying automation

Presets allow you to use Factory or previously saved settings, and to save your own settings.

There is a Compare function to compare saved versions of a Process, and a Pinning control to keep this

Process Control Panel open.

Pop-up explanations
Each of the controls shown has a "pop-up" explanation which will appear shortly after hovering the

mouse pointer over a slider control or parameter display box, so the controls won't be described in this

User Guide, with the exception of the Channel controls.

Channel controls
Doubler can operate in mono or stereo. The Settings panel shows the settings that will be applied to one

or both channels, depending on what is selected in the Channel Controls section.

If you change the number of Output Channels to 2 (using the adjacent drop down menu) the panel will

display slightly different controls (lower image at right). You will also see the number of channels in the

output track switch to two, but the audio in the new second channel will not be generated until the

process is run and renders it.

Mono Inputs: you can select 1 or 2 output channels. With two output channels, a selector control

appears to choose which channel's settings are displayed and adjustable.

https://synchroarts.clickhelp.co/smart/project-revoice-pro-5-manual/time-varying-automation
https://synchroarts.clickhelp.co/smart/project-revoice-pro-5-manual/time-varying-automation
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Stereo Inputs: you can select one or two output channels. With a stereo input and 2 channel (stereo)

output you have the further option of phase locking the editing in the two channels. i.e. the editing will be

done the same in both channels. 

Lock Phase: ON - When the processing is run, only the Settings shown (when either Channel 1 or 2 is

selected) will be applied to process both Output channels and the editing will keep the channels phase-

locked. i.e. If Channel 1 is selected when processing, then the Channel 1 Settings will be applied to

process both input channels. Similarly, if Channel 2 is selected when processing, then the Channel 2

Settings will be applied to process both input channels.

(Normally set to ON when the left and right signals are very similar. Can be set to OFF if the left and

right signals are very different to each other.)

Auditioning and adjusting the two output
channels
To audition the Left Output channel and adjust its Settings: Pan the Output signal track left (in the

Session's Track Control Panel) and select Channel 1 in the drop down under Selected Settings in the

Doubler Control Panel shown above. The setting controls will then be for for Channel 1 (which is output

to the left).

To audition the Right Output channel and adjust its Settings: Pan the Output signal track right (in the

Session's Track Control Panel) and select Channel 2 in the drop down under Selected Settings. The

settings controls will then be for Channel 2 (which is output to the right).

To hear the left or right outputs with the input, solo both Input and Output tracks (which can be done with

the E key).

To hear the Left and Right Output signals together, move the Pan control back to the centre.

Next
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8.4. Adjust

Toggle navigation

Revoice Pro 4.3 Help
·

· Contents

· Index

· Search

Processes » Adjust 

The Adjust Process facilitates precise manual time and pitch editing of audio signals. These Time and

Pitch Warping functions are independent versions of those otherwise available as an output of the Match

Process. 

For general use, we suggest using the Adjust Region, discussed further in the next topic here and in

detail in Manually adjust timing, pitch and level.

Features
· You don't have to prepare audio in other external time and pitch editing programs. Instead, do

these adjustments comfortably and quickly within Revoice Pro. 

· Play other tracks along with the track you are adjusting while in a loop to audition your changes

in context.

· Time and/or pitch changes to Guide or Input tracks will be passed automatically into the outputs

of all processes using these inputs. So dependant audio tracks will always be in time and in sync

instantly.

· The editing tools allow, for example, pitch blocks to be split into smaller sub-blocks, for more

precise control over pitch; for previously split blocks to be rejoined, for the boundaries between

blocks to be smoothed, and for contours to be drawn manually.

Typical applications
Some of the main uses for manually editing signal features (pitch, timing and level) are quite common

and include:
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· Improving or altering the pitch and/or timing of tracks that will be used as Guide tracks in Match

processes.

· Correcting or altering the pitch of a harmony track before using it as a Dub input to a Match

process that will have only its timing aligned to the Guide. The output of this Match process can

then become a harmony Guide track for correcting double tracks of this harmony part.

· Manually adjusting the pitch and time of a solo vocal or any voice recording that is not being

used with any other vocal track.

· Making minor adjustments to the features in the output of a Match process.

Methods for time and pitch warping
· The Adjust Region Process - in which the adjustments are made in same track as the input

audio for only one selected Region, and the output is heard adjusted "in place" instead of the

input. This is meant for making large and small corrections or creative changes to the timing and

pitch of voice and monophonic instruments to create perfected lead, harmony, ADR or voice

over parts.

· The Adjust Process - which can be any length as set in the Process Control Track - and can

include anything from part of one region to spanning multiple regions. The output of the Adjust

process is sent to a designated output track where the adjustments are made. The input track is

left unchanged.

· The output of a Match Process can also be manually adjusted with the same techniques, but the

Match's automated processing should be locked first to ensure that the manual adjustments do

not get removed.

The Time and Pitch Adjust selection and modification tools work pretty much the same for these three

methods in that user adjustments work on the same type of displays of graphic elements (pitched notes,

transitions, non-pitch blocks and added Time Warp points) within the track containing the output.

Adjusted tracks' audio can be used independently and sent back to the DAW. But what's more powerful

and unusual is they can also provide "perfected" Guide tracks for Match functions (to tighten any existing

"loose" double tracks automatically), and/or as the inputs to Doubler functions.

Since many of the Adjust timing, pitch and level editing functions are available in multiple processes, the

details of this are covered in a separate section: Manually adjust timing, pitch and level
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Next

Topics in this section:

Adjust Region: step-by-step introduction

Adjust Process: step-by-step introduction

Related topics:

Manually adjust timing, pitch and level
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8.4.1. Adjust Region: step-by-step introduction

Processes » Adjust » Adjust Region: step-by-step introduction 

The Adjust Region function is one of Revoice Pro's most useful tools for making creative and/or

corrective time and pitch adjustments "in place" (i.e. the output is directly created in the same track as

the input, so the input is replaced by the desired output). As of Revoice Pro 5, the Adjust Region

incorporates new workflows from our RePitch software.

Adjustments made to an Adjust Region will also cause tracks that use this signal as an input to

reprocess the output to follow the time and pitch changes in the changed input (if the process is set to do

that).

Creating an Adjust Region

In one track, select one (or multiple audio waveform regions in the same track) as shown in light grey at

the right. Right click in the track with the selected regions and select the 'Adjust Pitch / Timing / Level'

menu item in the pop-up menu window.
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Once the region (or regions) have been processed, we can see Pitch Traces in blue and white, with

yellow Transitions between some of them.

If the pitch contours do not appear in the track window they are probably outside the range of notes

visible in the track window. Move the Pitch Range control (shown below) up and down (by selecting it

with the mouse or by centering the mouse in the track and rotating the mouse scroll wheel) until the pitch

contour lines appear in the track window. (Also see Seeing pitch information)

Right click in the track concerned to see the menu right. You will see the available Adjust functions,

which in this example is just one, Adjust:BG Vox 5(14). Although normally the editing choice is set

correctly, if required, select the name of the Adjust function then one of Edit Time & Pitch, Edit Level,

Edit Pitch Limits or Edit Shift of Formants to display that Adjust Region's editable features. If there are

multiple Adjust regions listed, only one can be selected at a time from the left hand part of the menu.
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In order to do detailed editing of timing, pitch and level, see Manually adjust timing, pitch and level

To Remove the processing in an Adjust Region, right click in the region which has the Adjust Region

and select Remove Adjustments as shown selected at the bottom of the menu below.

To see and change the Settings for each Adjust Region, select the Adjust Region of interest and then

either press the P key, or right click the Adjust Region and select Settings from the sub-menu related to

the Adjust process concerned, and the Adjust Control Panel should appear.



Revoice Pro 5 Manual Publication8

506

If you want to temporarily bypass the Adjust processing you have done, to compare the original audio,

press the comma (,) key and the audio will turn light grey and the pitch traces will dissappear to indicate

that the processing has been bypassed. A red bypass warning is shown. Press comma again to revert to

the processed audio.
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Next

Related topics:

Adjust Process

Manually adjust timing, pitch and level

Export audio from Revoice Pro

Playback range
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8.4.2. Adjust Process: step-by-step instructions

Processes » Adjust » Adjust Process: step-by-step instructions 

An Adjust Process uses the input from one track, but unlike an Adjust Region, it can be any length and it

creates an output that is sent to a designated track where the time, pitch and other adjustments are

made. The input audio is left unchanged.

Adjust Processes are set up in the same way as Match and Doubler processes, so their range is

determined by the extent of the Adjust Process Control block in the Process Control Track - and can

include any range from just part of one region to spanning multiple regions and silence section.

If you want to have the the adjusted audio in the same track as the input (such as for getting Guide or

Doubler inputs corrected "in place"), then Adjust Region should be used instead of the Adjust Process.

Next

Topics in this section:

Before applying a new Adjust Process

Check/change Adjust settings

Create a basic Adjust Process

Modifying Ajdust settings

Edit and  play the Adjust output audio

Related topics:

Workflows

Basic Process functions
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8.4.2.1. Before applying a new Adjust Process

Processes » Adjust » Adjust Process: step-by-step instructions » Before applying a new Adjust Process 

Loading audio
Before applying a Process you will need to load audio tracks into Revoice Pro, following one of the

methods described in Workflows. There are options for importing audio files directly, and various

methods that work quickly and easily with specific DAWs.

You will also need to have set up Revoice Pro's audio monitoring. This will enable you to hear the

Revoice Pro outputs.

This section assumes that suitable signals are already loaded in Revoice Pro and that the input

waveform is selected (i.e. green) following being loaded.

· To cut down keystrokes when using Revoice Pro, we generally recommend the user loads entire

tracks of audio into Revoice Pro and then processes these in sections, working from the start

towards the end. This generally works very effectively.

· That isn't to say that the user shouldn't load audio in small sections if they prefer, or use Adjust

to process an entire input track. These choices depend on the signals and the user's comfort

with their own workflow.

Next 
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8.4.2.2. Check/change Adjust settings

Processes » Adjust » Adjust Process: step-by-step instructions » Check/change Adjust settings 

We will first show an example creating an Adjust Process using two selected and separated audio

regions as shown below. 

For details of functions common to all Processes see Basic Process functions. This explains a number

of the points mentioned below.

When setting up an Adjust Process, you need to specify:

1. That the "Selected Process" is an Adjust process

2. Which track is the Input

3. Which track the Output should go to

4. What is the range of the Input signal

5. What are the Adjust process settings (Process Control Panel)

Revoice Pro chooses these settings for you automatically when you have done the same processing

previously, and when you set a Playback Range or create new tracks.

There are, though, many times that these settings will need to be altered.

If you do not see the New Process window (shown in the image below on the right), then you need to

open it. There are two ways to do this.

1) Right click in any Process Control Track and select New Adjust Timing / Pitch / Level.

2) Make sure the Revoice Pro session window is selected and press the B key on your keyboard. This

will open the New Process window as shown below. Left click the Selected Process drop down to select

Adjust. Pressing the B key again will close the window - but it is often more efficient to leave this window

open.

Revoice Pro automatically preselects all of the drop down menu items in the New Process window. We

briefly explain each drop down option used in this first example, in which none of these settings will need

changing.
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Selected Process: is correctly set to be an Adjust process.

Initial Input Start and End: the New Process window has correctly chosen the Selected Audio (which is

the audio shown in grey) from start to end. You could alternatively use a Playback Range to highlight

time periods of the audio to be processed, rather than relying on automatically selected audio.

Further options for setting this can be found in Setting a Process Control Block.

Presets: You can change the Adjust process settings before creating the process. If nothing is changed,

then the current User Default Preset will be used. You can choose from one of the provided Factory

Presets in the Presets drop-down menu, as a good starting point for processing typical programme

material. Alternatively you can select the "Default" setting. (See Process Presets.)

Inputs: the Input is currently set to Lead Vox, to which the source audio has been loaded.

Output: Revoice will use 'Automatic' by default, creating a new track for the output of the process as

required. If you have already created a track and wish to select it, you can choose it from the drop-down

menu.

Next
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8.4.2.3. Create a basic Adjust Process

Processes » Adjust » Adjust Process: step-by-step instructions » Create a basic Adjust Process 

Click the New Process button (or press the N key on the keyboard) and the Adjust:1 Process Control

Track 1 will be created to match the selected audio range and normally the initial Output audio will

normally be created in the selected Output track as shown below.

If a red line appears in track 2 "Audio 2" it means background processing is not enabled and the line

shows where the Adjust Process Output will go. In this case, press Space Bar to process and play the

audio. 

Once you see the output appear in the Output track (in "Audio 2" as shown in picture below) you can:

1. Inspect and change settings in the Adjust Process Control Panel,

2. Begin processing time, pitch etc. in the Adjust Output track as described in Manually adjust timing,

pitch and level.

 

Next 
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8.4.2.4. Modifying Ajdust settings

Processes » Adjust » Adjust Process: step-by-step instructions » Modifying Ajdust settings 

To adjust the Adjust Region settings, open the relevant Process Control Panel.

To do this, first make sure the correct Adjust Output, or the Adjust Input Process Control Block is

selected (blue), and the Session window is active. 
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Then press the P key on the keyboard (or the   arrow in Adjust Process Control Blocks) to open the

Control Panel as shown right. Make any required adjustments and then press P again (or the close

button) to close the panel.

You can repeatedly try modifying the parameters in the Control Panel and listening to the result. The

control panel can remain open, the controls adjusted and processing run while signals are playing.

Presets allow you to use Factory or previously saved settings, and to save your own settings.

There is a Compare function to compare saved versions of a Process, and a Pinning control to keep this

Process Control Panel open.

The Adjust Control Panel
Each of the controls shown has a "pop-up" explanation which will appear shortly after hovering the

mouse pointer over a slider control or parameter display box, so the controls won't be described in detail

in this User Guide.

Most of the settings in the top area of this control panel (shown right) have been described in Adjusting

Match settings.

Separation of Musical Notes contains the following controls, which do not normally require modification.

· Threshold - The change in pitch needed to restart a new note boundary.

· Smoothing - The factor applied to create smooth pitch contours.

· Min. Length - For pitch values to be made into a note, they must be within the pitch threshold for

this minimum length of time.

Transients  contains the following controls:

· Sensitivity - sets the tightness of the detected transients (rapid onsets) in the audio

· Voice - sets the process specifically to handle voice signals

· View transients - displays faint purple vertical lines where transients (rapid onsets) have been

detected in the audio

Formants
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· Linear shift - adjusts the frequency of formant regions up or down to change the character of e.g.

a voice. (Formants are resonant frequencies, typically of the vocal cavity, which affect the

character of the sound. For example, female vocal formants have a slightly different structure to

male ones.)

Basic main editing of the Output's time, pitch, level, etc. is described briefly next. Detailed editing

following Adjust processing is described in Manually adjust timing, pitch and level.

Next 

Related topics:

Playback controls

Playback range

Track mute and solo
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8.4.2.5. Edit and play the Adjust output audio

Processes » Adjust » Adjust Process: step-by-step instructions » Edit and play the Adjust output audio 

Further information on Adjust editing is given in Manually adjust timing, pitch and level.

While making adjustments to the Output track, pressing the Space Bar will play the rendered audio. 

If you want to temporarily bypass the Adjust processing you have done, to compare the original audio,

press the comma (,) key and the audio will turn light grey to indicate. A red bypass warning is shown.

Press comma again to revert to the processed audio.

You can easily solo the output track(s) you want to hear.

· To solo the Output on its own - press the A Key.

· To solo both the Output signal and the Input - press the E key.

· To solo the Input signal on its own, press the G key.

(These keys can be pressed while playing audio.)

If background processing is turned on, the output audio will be rendered instantly and the Space Bar will

play audio. 

If background processing is off, and a red line still shows above the output track), the Match process

needs to be rendered before it can be played. Consult the rendering and background processing

preferences for details.

Continue to edit the Output audio until you are satisfied with the results.

 

You can use this Output track as an Input to other processes and also, if required, transfer the Output

audio to your DAW or a file.

Next 
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Related topics: 

Manually adjust timing, pitch and level

Export audio from Revoice Pro

Playback range
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8.5. Analyser

Processes » Analyser 

The Analyser displays a spectrum analysis of the chosen audio signal. It can be useful in identifying

important features of signals, discovering where the dominant energy lies, and in analytical processes

such as forensics. It is not used for processing in Revoice Pro. 

It is hidden by default, but can be enabled in the Settings menu. To enable the Analyser, check the

'Show additional processing options' option.

Next 
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Topics in this section:

Creating an Analyser Process

Using the spectrum analyser
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8.5.1. Creating an Analyser Process

Processes » Analyser » Creating an Analyser Process 

Before we can create a new Analyser Process, we need to make sure that 'Show additional processing

options' is selected in the Settings menu.

Press B to open the New Process window (unless it is already open) and select Analyser in the Selected

Process drop down at the top, or right click on a track's Process Control bar below the track, and select

New Analyser.
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Make sure the input audio channel is the one you want to analyse, then press the New Process button at

the bottom of the New Process window, or N on the keyboard.

Nothing will appear at first, except a blue bar in the process control track, showing the presence of an

Analyser process.

Click on button to open the Process Control Panel (or press P on keyboard).

The Analyser control panel will appear showing a red graph of the sound level (vertical axis) at different

frequencies (horizontal axis).
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Next
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8.5.2. Using the spectrum analyser

Processes » Analyser » Using the spectrum analyser 

The simple spectrum analysis display shown in the process control panel above shows the short-term

frequency spectrum of the signal at the current play head position. It will change as you move the play

head, either while audio is playing, or while you scrub replay or move the play head position.

In order to create an Analyser Process, 'Show additional processing options' must be checked in the

Settings panel.
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The Analyser process can display a spectrogram that represents the spectral density of the audio signal

over the duration of the process in question (governed by the process start and end times).

Adjust the Spectrogram Intensity control to affect the visibility of this, superimposed on the audio track in

question. In the picture below it is superimposed at 100%, so the audio underneath has been made

invisible.
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In a spectrogram the horizontal axis represents time, the vertical axis represents frequency, and the

intensity of colour represents the amplitude. Here you can see a brighter band that shows the dominant

pitch in the vocal track analysed rising towards the middle, then falling in steps.

You can scroll up and down this spectrogram using the mouse wheel to see different parts of the

frequency range. For example, by scrolling upwards on the above display it is possible to see the higher

harmonics evolving over time:

By pressing P or clicking the arrow button on the left side of our Analyser process shown below, we can

open the Analyser control panel.

In the Analyser control panel, we can see a display showing the relative power of each frequency at the

moment selected by our playhead. The frequencies will dynamically adjust on playback.
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Next
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8.6. Volume

Processes » Volume 

The Volume Process makes possible simple automated level adjustments by creating an Output Track

whose level varies according to a volume profile on the Guide Track.

The Volume Process has no Process Control Panel.

It is hidden by default, but can be enabled in the Settings menu. To enable the Volume Process check

the 'Show additional processing options' option.

Next 
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Topics in this section:

Volume: step by step introduction

Related topics:

Online video introductions or tutorials

Workflows

Basic Process functions

Editing signal waveforms

Audio setup, monitoring and playback
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8.6.1. Volume: step by step introduction

Processes » Volume » Volume: step by step introduction 

Setting up a new Volume process and creating and hearing the output signal can take as few as two key

strokes and uses a New Process window that can remain on screen.

If Revoice Pro has automatically correctly selected the right process, the right input and output tracks

and processing range, then all the user has to do is press the N key on the keyboard to create the new

process, followed by the Space Bar to render the output and start playback.

Next

Topics in this section:

Before applying a new Volume Process

Check/change Volume settings

Create a basic Volume Process

Adjusting Volume control points

Related topics:

Workflows

Basic Process functions
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8.6.1.1. Before applying a new Volume Process

Processes » Volume » Volume: step by step introduction » Before applying a new Volume Process 

Loading audio
Before applying a Process you will need to load audio tracks into Revoice Pro, following one of the

methods described in Workflows. There are options for importing audio files directly, and various

methods that work quickly and easily with specific DAWs.

You will also need to have set up Revoice Pro's audio monitoring. This will enable you to hear the

Revoice Pro outputs.

This section assumes that suitable signals are already loaded in Revoice Pro and that the input

waveform is selected (i.e. green) following being loaded.

· To cut down keystrokes when using Revoice Pro, we generally recommend the user loads entire

tracks of audio into Revoice Pro and then processes these in sections, working from the start

towards the end. This generally works very effectively.

· That isn't to say that the user shouldn't load audio in small sections if they prefer, or use the

Volume Process to process an entire input track. These choices depend on the signals and the

user's comfort with their own workflow.

Next
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8.6.1.2. Check/change Volume settings

Processes » Volume » Volume: step by step introduction » Check/change Volume settings 

Note that in the Revoice Pro Session shown, the second track has already been labelled Output, (which

will be the destination for the Volume Process output); the track containing the Input audio is labelled

Audio 1. In the picture, the input audio is shown as "selected" (in light grey), which is how it would be

immediately after loading it. The New Process window is shown open at the right.

If you do not see the New Process window (shown in the image above on the right), then you need to

open it. There are two ways to do this.

1) RIGHT CLICK in any Process Control Track and select New Volume.

2) Make sure the Revoice Pro session window is selected and press the B key on your keyboard.  This

will open the New Process window as shown above. Left click the Selected Process drop down to select
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Volume. Pressing the B key again will close the window - but it is generally more efficient to leave this

window open.

Revoice Pro automatically preselects all of the drop down menu items in the New Process window. We

briefly explain each drop down option used in this first example, in which none of these settings will need

changing.

Selected Process: is correctly set to be a Volume process. (It will be what was previously selected until

you change it).

Initial Input Start and End: the New Process window has correctly chosen the Selected Audio (which is

the audio shown in green) from start to end. Alternative options for setting this can be found in Setting a

Process Control Block.

Presets: there are no Presets except the Default for the Volume Process.

Inputs: the Input is currently set to the track Audio 1, into which the source audio has been loaded.

Output: the second track, Output, has been selected. (It will be automatically set to the latest new audio

track that was created in the session.)

Next

Related topics: 

Changing input and output tracks

Process Presets

Process Control Track

Playback Range
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8.6.1.3. Create a basic Volume Process

Processes » Volume » Volume: step by step introduction » Create a basic Volume Process 

Since the settings are set up correctly, we can now run the Volume Process. If Revoice Pro is the

selected program, simply left click the New Process button at the bottom of the New Process window or

press the N key (shortcut) on the keyboard.

The result of doing this is shown right.

 

In this example, two things are visible: Firstly, a blue (selected) Process Control Block labelled

"Volume:1" has been inserted in the Process Control Track below Audio 1. Note this is the length of the

previously selected audio (and the audio is no longer shown selected). This shows where the processing

will start and end.

Secondly, in the Output track, the Volume processed Output signal has been rendered. (If background

processing is turned on the output audio will be rendered immediately. If background processing is not

turned on, and a red line still shows above the output track, the Volume process needs to be rendered

before it can be played.)

Press the Space Bar to play the rendered audio. 

Quite often, the above steps will provide a satisfactory result with little or no further effort, apart from

transferring the output audio to your DAW or a file.

You can alternatively use a Playback Range to highlight time periods of the audio to be Volume

Processed, rather than relying on automatically selected audio.

 

Next

Related topics: 

Process Control Track

Export audio from Revoice Pro

Playback range
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8.6.1.4. Adjusting Volume control points

Processes » Volume » Volume: step by step introduction » Adjusting Volume control points 

In order to set Volume control points in the "automation" control track follow these steps:

Select dB on the track display selection on the right of screen. You can move the scale up and down

with the vertical slider and expand the range of display with the “pop up” control next to the display

selector showing “dB”.

There is a fine teal line at the top of the first track’s waveform. That’s your Volume control – like an

automation display.
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You can add control points where the value will change by left clicking at any point along the line.

Alternatively, points can be added by right clicking anywhere in the audio track concerned and selecting

Modify Values > Add Value from the contextual menu, as shown below.

 

Next
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9. Manually adjust timing, pitch and
level
Manually adjust timing, pitch and level 

In this section, we will look at the main displays and controls for editing the timing, pitch and level of:

· An Adjusted Region

· An Adjust Process Output

· A Match Process Output

The analysis, graphical tools and processing used to make adjustments in the first three of these

processes are largely the same and relatively simple to use.

Next
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9.1. User Interface for Manual Adjustments

Manually adjust timing, pitch and level » User Interface for Manual Adjustments

Once you have enabled 'Adjust Time / Pitch / Level' on an audio region, several new user interface

elements will appear to provide you with some new information and controls. These elements are labled

in the below image.

Note: when making manual pitch adjustments, you may need to zoom into the audio region to clearly

see the below UI elements. See Seeing pitch information for more detail.

Note Blocks: The blue rectangles are Note Blocks. They show individual notes that Revoice has

detected. Their horizontal position indicates the start and end of the Note Block or it's location in time,

and the vertical position indicates it's current average pitch or tuning. Note Blocks provide a number of

controls when moused over. These controls are discussed in detail in Note Block Controls

Pitches: Along the left side of the edit window, we can see a vertical column of note names or pitches.

To the righ of each note or pitch is it's corresponding Pitch Lane. When a Note Block is centered inside

one of these Pitch Lanes, it is in tune. The note names being displayed will correspond to the chosen

Scale for tuning as discussed in the Scales section.
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Pitch Lanes: These horizontal stripes line up with one of the note names on the left side of the edit

window. They help indicate whether a given Note Block is in tune. 

Pitch Trace: The white Pitch Trace inside of a Note Block indicates the precise fluctuations in pitch of a

given signal. There are a variety of tools available to modify and control Pitch Traces. These tools are

discussed in Pitch Modification Tools.

Transition: The yellow trace indicates a Transition between notes. Although their pitch cannot be

adjusted, they can be adjusted left and right in time just like Note Blocks. See Time Modification Tools

for more details.

Next
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9.2. Enabling Adjust Time / Pitch / Level

Manually adjust timing, pitch and level » Enabling Adjust Time / Pitch / Level

To enable Adjust Time / Pitch / Level, right click on the audio region that you would like to adjust and

select 'Ajdust Time / Pitch / Level' from the context menu.

You can also select the audio you would like to Adjust and press the W shortcut key.

In the below example, we have already loaded two audio tracks into Revoice Pro.

By right-clicking the audio region for Lead Vox 1, we can open the context menu and select 'Adjust Time

/ Pitch / Level'.
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We are now able to directly adjust the time, pitch, and level of the audio region. The controls for doing so

are described throughout the rest of this section. In the below image, we have zoomed in on the Lead

Vox 1 track to better see the result of selecting 'Adjust Time / Pitch / Level'.

Next
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9.3. Note Block Controls

Manually adjust timing, pitch and level » Note Block Controls

Note Blocks in Revoice have a number of controls available depending on the position of the

cursor. Both pitch and time modification tools are available when mousing over note blocks.

Pitch modification tools are available on the top half of the note block. Time modification tools are

available in the bottom half.

The following two sections discuss the pitch and time controls.

Pitch Modification Tools

Time Modification Tools

Next
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9.3.1. Time Modification Tools

Manually adjust timing, pitch and level » Note Block Controls » Time Modification Tools

· Moving Note Blocks

· Lengthening and Shortening Notes

· Modifying Groups of Notes

· Modifying Timing at Transitions

· The Warp Point Tool

· Flexing Time with Warp Points

· Add and Remove Warp Points

· Speed Ramps

Note Blocks have a number of time modification controls accessed by clicking in the bottom half of a

note block. Additionally, groups of selected note blocks can be time warped together directly from the

note block controls.

To read about the pitch modification tools, please see the previous section on pitch modification tools.
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The below functions are discussed in detail in their corresponding sections following the overview table.

Mo
ve
No
te
Blo
ck

Click and hold on the bottom half near the centre of a note block, then drag left or right to
move the note block in time.
Surrounding transitions and sibilances will move accordingly.
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Moving Note Blocks
To move a note block click in the centre of the block, in the bottom half, and drag left or right. The cursor

will change to a left-and-right arrow cursor .

Adj
ust
No
te
Blo
ck
Le
ngt
h

Click and hold on the bottom half of the note block at the right or left edge. Drag left or
right to lengthen or shorten the note block.
Surrounding transitions and sibilances will move accordingly.
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In the above image:

· The orange line shows the selected note block that will be moved. Surrounding notes and

transitions will be adjusted as required.

· The green line indicates a sibilance, which will note be stretched or warped, only moved in time.

By holding the ALT or option key, the sibilance will be allowed to warp.

· The vertical dotted lines show the limit of horizontal movement, typically where another note

begins.

Lengthening and Shortening Notes
To lengthen or shorten a note block, click and hold on the left or right edge of the note block in the

bottom half of the block. The cursor will change to a left or right drag cursor  which can be used to

lengthen or shorten the note. Surrounding note blocks will adjust accordingly, and sibilants will move

with their connected note blocks.
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In the above image: 

· The solid vertical line shows the selected end point that we will be adjusting.

· The dotted vertical line to it's right delineates the limit, or furthest the note can be adjusted. This

typically corresponds with the start point of the following note.

Modifying Groups of Notes
The above timing controls work with groups of selected notes as well. To begin, click and drag as normal

to select a group of note blocks.
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By clicking and the left or right side of note block, we can adjust the relative lengths of all blocks in the

group. The blocks will warp around the adjustment made at the selected point.

Befor
e
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Note blocks can also be moved in groups by clicking as before in the centre bottom half of one of the

note blocks in the group.

As before:

· The orange line shows are selected notes.

After

By dragging left, note blocks to the left of the solid vertical line have been compressed, and to the
right have been stretch. Sibilant sounds are still marked by green lines, and have been moved
rather than warped.
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· The vertical dotted lines to either side show the limits of our movement.

· Dragging left or right will move the notes in time as a group and without any warping.

Modifying Timing at Transitions
Interesting, useful and creative modifications can be created by changing the timing of a transition and

the audio following it (or leading into it). 

Below we show positioning the cursor at the junction of a transition and the following audio (in this case).

If we simply drag the cursor forward, the transition gets shorter (and faster) and the audio in

the following Note Block stretches, as shown below. The user can experiment with this to get an idea of

the effects this can generate.
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The Warp Point Tool
The Warp Point Tool provides a quick way to drop anchor and flex points, with visible lines showing their

location in the signal.

Warp points are automatically populated at the beginning and end of each note block, and are used to

power the Note Block time modification tools discussed above. If you add or remove warp points with the

warp point tool, they will be taken into account when using the Note Block time modification tools.

For general use, you will not need to modify the automatically generated warp points. If you find that

changing timing with Note Blocks is not working as you would like, the Warp Points controls described

below will allow for further control.

The picture below shows a typical view once the Warp Point tool is selected with the (period) . key.

The warp points have a triangle at the bottom of the Main Window and a line running to the top of the

Main Window - so you can see precisely where it is in the signal. 
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Flexing Time with Warp Points

Click and drag anywhere on the vertical white line indicating a warp point. The surrounding audio and

note blocks will flex, and sibilant sounds will be moved rather than flexed.
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Add and Remove Warp Points

With the warp point tool selected:

· Add: Shift+click in a blank space over a note block to create a new warp point

· Remove: Shift+click a warp point anywhere on the vertical white line to remove it

· Reposition: Option+click a warp point anywhere on the vertical white line. The line will

turn yellow to indicate it is selected, now drag left or right to reposition a warp point

Speed Ramps
Even more creative control is available, because the red horizontal lines seen with red squares on the

Warp Points are actually speed controls. 

When you hover over or near the square you will get a cursor like this:    

Moving that square on the flexing Warp Point up will not move either Anchor points, but will go from a

speed of 1.0 (when the line is horizontal) to a higher or lower speed in that section depending on

whether the line slopes up (going faster) or down (going slower)

Experimenting for a short while with these tools will make these brief descriptions make more sense.

Other Warp Point Facts

You can insert as many Warp Points as you want, but it is always recommended if you are not at the

start or end of the signal and you want to not change the timing of the start or end, to keep a Start Warp

point and an End Warp points as anchors.

Next
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9.3.2. Pitch Modification Tools

Manually adjust timing, pitch and level » Note Block Controls » Pitch Modification Tools

Note Blocks in Revoice have a number of controls available depending on the position of the

cursor. Both pitch and time modification tools are available when mousing over note blocks.

Pitch modification tools are available on the top half of the note block.

This portion of the manual discusses pitch modification controls. Time modification controls are

discussed in the next topic in this manual.

Control Points

Note blocks in RePitch provide several quick controls via the Control Points which appear around a note

block when moused over or selected.

https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools
https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools
https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools
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Click and hold one of the blue control points and then drag vertically to change the corresponding

parameter.

· Drift on the left

· Level Change in the middle

· Pitch Correction on the right

Mouse Over Selected

Drift
A Drift control is inside the Center Note Tool menu as described in Tools and Quick Keys.
The Drift control point will quickly change this parameter. Click and drag vertically to increase
or decrease the pitch drift. 

Level
Change

Click and drag vertically to quickly increase or decrease the level of the note block with a gain
range of -10dB to +10dB.

Pitch
Correction

Click and drag vertically to change the amount of pitch correction applied in percent, from 0%
to 100%.
This control modifies the Pitch Correction slider percentage in the Centre Tool described
above.
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Dragging Notes Up and Down in Pitch

If the user clicks in the top half near the center of the Note Block, the up/down cursor

 appears. The Selected Notes can be dragged either continuously in pitch or in semi-tone steps when

holding Option and dragging.

Drag continuously or in semi-tone steps
Pitch Blocks can be dragged vertically to change pitch either continuously or in semi-tone steps.

· Click and drag for Continuous pitch changes

· Hold Option (Alt on Windows) and click and drag for Semi-tone step pitch changes

Double clicking Notes
Double clicking a Note Block will apply 100% pitch correction to that Note Block. The Note Block centre

will be moved to:

· The nearest Selected Scale Note frequency if Snap is ON or

· To the nearest Chromatic note if Snap is OFF.
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Modulation Control 
This control reduces or expands the range of the note's pitch variation.

Clicking and holding on the grey box centered just above the note block brings up the downward

pointing arrow  as shown below, which can be dragged down to reduce the modulations or upward

to expand them.

In the picture below, the Modulation control point has been dragged downward, and has reduced the

note's modulation range as can be seen by comparing the resulting pitch in white with the original pitch

trace in gray (the less visible curve within the blue note box).
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In addition to expanding the pitch modulations, the Modulation control can be used to flatten the note

range (to make it monotonic) or, it can also gradually invert the pitch pattern as the control is dragged

further downwards. 

Pitch Edit Cursors Overview

Note
Pitch

Place the cursor in the top half of the note block. Click and drag to move the pitch
up and down continuously.

Hold the Option key (Alt in Windows) while dragging to drag in semi-tone steps.

Modulatio
n

Place the cursor over the grey modulation box above the center of the note block.
Click and drag vertically to reduce or exaggerate pitch modulations.
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Editing Transitions
Transitions from one Note Block to another are shown in yellow, as seen below:

There are two ways transitions can be manipulated. One of these uses Time Modification and is shown

in the next Chapter here.

The other uses the Pitch Block control points as described below and does not modify timing.

Selecting the transition will show the Level Change control point as described above, and the transition

can be dragged up and down to modify it's tuning.

The drag locations will affect the transition block like a normal note, but there will be differences in

results that will vary from case to case depending on the slope of the transition and how the pitch curve

is shaped in the notes it connects.

https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools/a/h2_273956105
https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools/a/h2_273956105
https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools/a/h2_273956105
https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools/a/h2_273956105
https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools/a/h2_273956105
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Actions on a Range of Selected Notes
The following instructions provide very useful actions, some on Key Commands.

We explain first how to make a selection and then explain the available commands.

Three ways to make a selection in main window

1. To select a small range of visible objects- click and drag a box around items

2. To select a larger range and include all items in range - (vertically and horizontally)

a. Select first item in range

b. If last item is off screen, use the Overview or Navigation tools to view the last item you

want in the range

c. Press SHIFT key and click last item in selection.

3. To select ALL- press CMD A (mac)  or simply [A]  (because some DAWs use CMD A)

For Windows, press [A] or CTRL A
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9.4. Seeing pitch information

Manually adjust timing, pitch and level » Seeing pitch information 

In order to see analysed or processed pitch information clearly in Revoice Pro Tracks, some

adjustments to the display may be needed. The topics in this section explain some ways of seeing pitch

information more clearly. These mostly relate to Match, but some may be relevant when looking at other

results.

In the Output of an Adjust or Adjust Region Process you can't control what attributes are displayed. Only

the pitch blocks and contours are shown.

With Match, on the other hand, by turning on the Guide, Dub and Output pitch displays using the Match

Views control you can inspect:

· What the pitch contours look like and what the frequency ranges are

· Where the Dub and Guide signal pitch contours are different and might cause problems

· What happens when Match's pitch processing parameters are adjusted to be more tolerant of

differences.

Match Process Control Blocks need to be selected for these displays to work.

Next 

Topics in this section:

Improving pitch information display - summary

Lower the energy displays

Bring the pitch traces into view

Pitch range

Alter the display to show pitches
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9.4.1. Improving pitch information display - summary

Manually adjust timing, pitch and level » Seeing pitch information » Improving pitch information display -

summary 

In the Match example below, most of the Revoice Pro 5 Match Views (shown in the menu at right) are

ON. As we can see in the below image, there is too much information, making the interface difficult to

read.

Note that Match Process Control Blocks need to be selected for all the following to work. The traces

visible in each track may depend on which of the attributes Timing, Pitch and Level are selected for

processing in the Match Process Control Panel.

Each of the following steps is optional, and depends on what you want to see. The following sections

give further detailed explanations of the use of the controls.

1. The Energy traces can be simply removed by clicking the Match View "Energy" switch to OFF,

which is shown in the image below.

  

2. The Energy traces can be lowered by selecting "Energy" in the Guide or Dub pop-up menu,

holding down the SHIFT key and using the sliders to reduce the height of the Blue and Orange

areas (not shown in next image). Further details.
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3. The Audio in all the tracks can be removed as well, by selecting "Audio" in the pop-up display

menu (say in the Guide track) and (using the SHIFT key to apply the change to all the tracks)

lowering the waveform energy to the lowest level desired. (In the example below, it has been

lowered to a flat line).

4. The vertical sliders at the right of each track showing "Pitch" in pop-up selector can be moved to

raise or lower the pitch trace to enclose or be centred on the vertical white lines showing where

the pitch range is in the track's window. Further details.

5. The scaling of the pitch traces can be adjusted individually as well using the slider control in the

pop-up.

6. The upper and lower range of the Pitch detector for the Guide and Dub (shown by thick

horizontal blue lines) can be increased or decreased to ensure the pitch is being measured

accurately over its entire range. Further details.

7. The Output or Input tracks can be expanded to full height to examine finer details of the pitch

traces. Further details.

Doing the above can result in a cleaned up display similar to that shown below with all the Guide, Dub

and Output pitch traces shown clearly (and the blue high pitch limit bar at the top of the guide track). 
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An overview of the pitch trace range and pitch detector limits of the process are shown below in the right

hand scroll bar if pitch or pitch limits are currently being edited. This can act as a navigation aid when

trying to scroll and scale the display window so as to see the traces and limits concerned. The white

line(s) in the centre of the scroll bar shown here represent the ranges where pitches have been

detected, while the blue lines show the pitch limits of the process in relation to the currently scrolled and

scaled display. If the white line touches the blue pitch limits, it would be advisable to increase or lower

the appropriate pitch limits in the Match Control Panel for that track. 

Next
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9.4.2. Lower the energy displays

Manually adjust timing, pitch and level » Seeing pitch information » Lower the energy displays 

The Match Energy displays (shown in blue and orange) can interfere with the pitch trace's visibility. You

can reduce these displays.

To do this, left click on the Guide or Dub's track Display's Scaling Selector (showing "Pitch" in the image

below at the top right) to bring up the list of display scaling options.

From this menu, select 'Energy' shown in blue below.

Click the Scale Display button immediately left of the 'Energy' option we have just selected. This will

bring up a slider that can be used to increase or decrease the vertical size of the Energy Display.



Revoice Pro 5 Manual Publication8

568

In the below image we have lowered the slider, and we can see that the Energy display has been

reduced vertically.

If the SHIFT key is held down while moving the slider, the scaling will be applied to all the tracks with

Energy displays.

When the slider reaches the bottom, the Energy displays will be reduced to a minimum.

Next
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9.4.3. Bring the pitch traces into view

Manually adjust timing, pitch and level » Seeing pitch information » Bring the pitch traces into view 

If the pitch trace of a signal is not visible or partly visible, left click that track's Display's Scaling Selector

and select Pitch as shown top right in image below.

Left click the gray Pitch Scale Offset control (shown below selected by the mouse cursor) and move it up

or down (or use the mouse wheel when the cursor is hovering in the track display) to bring the pitch

trace into view. If the SHIFT key is held down at the same time, the same offset will be applied to all the

tracks). This action does not change the pitch of the signal, it only slides the range of pitches displayed

in the window.

Next
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9.4.4. Alter the display to show pitches

Manually adjust timing, pitch and level » Seeing pitch information » Alter the display to show pitches 

To scale the pitch trace(s) (i.e. display more or fewer pitch values) for example, to see more detail and

have the note grid displayed, left click the Scale Display button (make sure the Selector is showing

"Pitch") as shown below.

This will pop-up the Scaling Slider (shown right) for adjusting the vertical scale of the Pitch display as

shown being adjusted below. In the Pitch mode, as the Scaling Slider is increased, when there is

enough room, the horizontal note dividers will appear as shown below.

If zoomed in more, the note names will appear as shown on the left. You might need to adjust the scale

offset control (shown selected above) again to get the display fully shown.

To get increased resolution and display height you can expand the Guide (or Dub) to the full height of

the Revoice Pro window by clicking on the "Show/Hide" full height button in the Track Controls to the left

of a track.
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This allows you to scale the display to see the note names better as well.

The image below shows the track being displayed in a full height window.

Next 
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9.4.5. Full height display of features

Manually adjust timing, pitch and level » Seeing pitch information » Full height display of features 

We recommend left clicking the Full Height Track toggle switch shown in the picture below to achieve

more detailed display.

To return to the multi-track display, left click the same "Show/Hide Full Height" button.

 

Next
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9.4.6. Tuning Preview

Manually adjust timing, pitch and level » Seeing pitch information » Tuning Preview 

When pitch blocks are moved by dragging an audible tone will be generated corresponding to the

fundamental pitch of the audio at the mouse pointer position. This is mixed in with any other audio that

may be playing at the time.

This function — "Enable Tuning Preview" — can be turned off in the Preferences control panel.

The replay level of the tuning preview can be adjusted using the selector drop-down in the transport

area of the main display, as shown below. The master volume control below this affects whichever

parameter is selected in the drop-down (master volume or tuning preview).

Next 
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9.5. Scales

Manually adjust timing, pitch and level » Scales

In Revoice, the user can select a scale to limit the available notes during pitch correction. Revoice can

detect this scale itself, but the user can also set a scale manually. Scales also allow for a variety of Pitch

Grids outside of the standard 12 Tone system.

To have Revoice detect the scale automatically, select an audio region that has 'Adjust Time / Pitch /

Level' applied and press D or right click the audio region and select the 'Detect Scale' menu item from

the context menu.

Manually Selecting a Scale

To access the Scales menu, click the dropdown menu in the bottom right hand corner of the Revoice

main window.
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Clicking on this button will reveal a menu containing a few scales, and a 'Scales...' option shown below

in blue:

Clicking on 'Scales...' will open the Scales Settings Menu shown below.
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Its main purpose is to let you add and delete scales in the Active Scales list, and also select the

scale whose name and notes will be displayed in the Main Window and will provide the note frequencies

that automatic tuning (snapping) will use as targets for the detected notes to be moved towards.

You will also be able to choose the Chromatic scale or a detected ("Measured") scale after audio is

captured.

The Tuning Reference will default to the standard A4 = 440hz but may be adjusted up or down with the

slider as needed.

The Pitch Grid drop down will allow you to select a number of systems other than 12 Tone Equal

Temperament tuning.

The Active Scales portion of the menu allows the user to add scales to the list of scales that appears in

the Scales pop-up menu. We recommend keeping scales you use frequently available in this list.
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By choosing a key or tonic note and scale type from the drop down menus, and then clicking 'Add', we

can add a scale to the list. Below, we've added a D Harmonic Major scale.

Note: click Save before closing this window, otherwise any changes will not be applied.

Once we have clicked save, we now have D Harmonic Major available in our Scales... pop-up menu in

the bottom left of our Revoice window.

Clicking on "Chromatic" or any other scale name that appears in that menu, will set the Scale in the

Scale Display window and show the selected scales' notes in the left border of the RePitch window.
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Snapping to a selected Scale

When a Scale has been selected, Revoice can snap it's pitch correction to only notes within the selected scale. To

do so, the user must first make sure the Snap toggle is on. The Snap button is located directly left of the Scales...

menu.

Any selected Added Scale can be used to have detected notes snapped to its allowable scale note centers.

When the Snap switch is ON: There are four commands or controls that will snap or move note blocks to the

nearest Selected Scale note centers 

1. Double click a single note or one note in a group of selected notes

2. Use the Center Notes Tool on one or more selected notes

In (3) and (4) below - you can use the Right Click Menu, which contains these commands:

3. Select one or more notes and use the Right Click menu to select Pitch Correct Selected Notes to 100%

4. Use the Right Click menu to choose Select All Notes and Pitch Correct to 100%

If Snap switch is OFF, all of the above commands will show the scale notes, but since ALL notes are allowable, it

will snap to a Chromatic scale.

A Note on the Note Display resembling a Piano Keyboard

If  you look at the light/dark = allowable vs not allowable notes display (which we and other pitch
modifying products have) you need to click the SNAP control ON to see (and use) the Allowable
(light) notes.

Displays that look like a piano keyboard are only exactly like a piano keyboard if you have a C
Major Scale selected in RePitch.

In tuning programs, that pattern moves off the C if the tonic changes, but if it is still a major scale,
the pattern will look like the piano keyboard, but it obviously starts start on a different tonic.
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The main point of the Light/Dark pattern is showing allowable notes.
So, for non-major scales (even in C) the pattern will no longer look like a piano keyboard. 
In RePitch, If you have "Chromatic" selected (or the SNAP control OFF), all the notes are
allowable, so there will be no dark notes.
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9.6. Tools and Quick Keys

Manually adjust timing, pitch and level » Tools and Quick Keys

If the Quick Key for a tool is pressed a second time, it will turn the tool OFF and turn the Selector Tool

back ON.

The Main Tools and their Quick Key commands are:

Tool
Description

Selector Shortcut: O          
This is the main tool for selecting and manipulating the audio.
A range of audio can be selected by either:

· "lassoing" the range, or
· clicking one pitch block as the start point, then navigating down to

the timeline to your endpoint, pressing SHIFT and then clicking the
final end point.

Center
Notes

Shortcut: K             
If one or more Notes are selected, when this tool is clicked, the Center Note controls will
appear.

Note that one control is a Drift Control as well as the "Correction" control to center the
Note block.
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Tool
Description

Draw    Shortcut: D       
The pitch can be drawn and redrawn in the Main Window where
there is voiced audio.
TIP: Turn the Draw tool OFF before double clicking to place the Playhead and start
playback.

Cutter  Shortcut: I     
This will present a red line at which note blocks will be Split (i.e. separated) when the mouse
is clicked.
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Tool
Description

Shaper Shortcut: V
The shaper tool will add shape points to the pitch trace to allow for fine pitch manipulation.
This tool is great for controlling or modifying vibrato, or changing the pitch trace while
maintaining the original character of an artist's voice. Shape points can be added in both the
Level and Pitch windows.

· Click on the pitch trace with the shaper tool to add a shape point.
· Hold and drag left and right to reposition a shape point.
· Hold and drag vertically to increase or decrease the pitch modulation.
· Click and hold + option for a tilt movement.
· Double click to remove a shape point.

The Shaper tool also functions in the Level screen. This usage is explained in the Level
Modification Tools section.

The above image shows four shape points. The green points act as anchors
and the yellow point is the selected point that is being edited.

Shape Point Groups

Click and drag to select multiple shape points and create a group. Grouped
points turn white and will move together. Shape point groups must be
continuous.



Revoice Pro 5 Manual Publication8

585

Tool
Description

Groups of Shape Points can be deleted by right-clicking a note block and selecting 'Delete
Shaper Tool Group'. This will delete all shape points on the note block.

TIP: It can be helpful to create a shape point at the beginning and end of a pitch trace
before you begin editing.
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force break text

Next

Tool
Description

Warp
Point 

Shortcut: .

· Shift Click   to create a Warp Point.
· Shift Click   on existing Warp point line to delete the Warp

Point.

NOTE: Two warp points are needed to anchor the range start and end, and the warp
point
that will be manipulated needs to be placed between the anchors.
Once a Warp point is created, its position can be moved without processing by
holding down
ALT/OPTION and dragging the warp point line.
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9.7. Level Modification Tools

Manually adjust timing, pitch and level » Level Modification Tools

Level mode allows for fine control of signal level or amplitude in Revoice. It is accessed by pressing the

L hot key when an audio region that has had Adjust Pitch / Timing / Level enabled.

When in Level mode the user is shown a trace of level measurements of the different elements of

pitched signals, unpitched sounds and even noise floors. This trace is presented against a vertical axis

of dBs and also contains the waveform. The segments of the traces can be moved up and down to

control the level. 

Additionally, many of the note block controls discussed in the Time Modification Tools section of this

manual are still available in the Level view.

For quick changes to level, use the middle control point underneath the note block when in the Pitch

mode. Control points are discussed in more detail in the Pitch Modification Tools section.

The Level Control Screen
· The Level screen is selected by pressing L key on keyboard when you have an audio region

selected, and that region has 'Adjust Time / Pitch / Level' enabled. Pressing L key again will

toggle back to the Pitch mode.

https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools
https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools
https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools
https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools
https://synchroarts.clickhelp.co/smart/project-repitch-1-3-user-guide/time-modification-tools
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·

As an example, below is a sample of the pitch display for a range of a signal. Notes are shown in the

scale at the left.

Next the picture below is the Level screen of the same section, accessed by pressing the L key.
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In the Level screen above:

The purple blocks at the higher level typically show the waveforms of voiced (or pitched) sounds

The light blue blocks at lower levels show where the waveforms are sibilants, breaths, or other noises.

The trace over those blocks shows what the level is, based on the dB scale shown in the left border.

· The user can select any of these blocks containing detailed Level traces and move them up or

down in dB.

In the below example, we have taken the indicated light blue sibilant sounds, and reduced their level as

indicated in the second image. This works as an effective de-esser.
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Levels reduced:
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Fine control or 3dB Steps

Normal dragging up or down can be continuous (fine control) or in 3dB steps if the ALT (OPTION) key is

held down.

 

Shaper Tool in Level Mode
The Shaper Tool functions as in the Pitch mode, however it now modifies the Level trace, as opposed to

a pitch trace. 

Shortcut: V
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The shaper tool will add shape points to the level trace to allow for fine level manipulation. This tool is

great for controlling or modifying vibrato, or changing the level trace while maintaining the original

character of an artist's voice. Shape points can be added in both the Level and Pitch windows.

· Click on the pitch trace with the shaper tool to add a shape point.

· Hold and drag left and right to reposition a shape point.

· Hold and drag vertically to increase or decrease the pitch modulation.

· Click and hold + option for a tilt movement.

· Double click to remove a shape point.

The Shaper tool also functions in the Pitch screen. This usage is explained in the Pitch Modification

Tools  section.

The above image shows five shape points. The green points act as anchors and the yellow point is the

selected point that is being edited.

TIP: It can be helpful to create a shape point at the beginning and end of a pitch trace before you begin

editing.

Shape Point Groups

Click and drag to select multiple shape points and create a group. Grouped points turn white and will

move together. Shape point groups must be continuous.
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Modifying the Loudness modulations
The same control used for flattening pitch modulation (the control point at the top of the note box) can be

used to reduce or even flatten the level modulations as shown in the two pictures below. In the second

picture, there no longer is any waveform level modulation within the range of the "note" box.
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Such a control may be useful in certain creative or correction situations.

Lastly, small purple dots show where signals are pitched but the measured level is changing quickly.

Next
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10. Keyboard shortcuts and operations
summary
Keyboard shortcuts and operations summary

This section lists groups of all available Quick Keys, also known as Keyboard Shortcuts, and other main

input device (described below as "mouse") commands.

Some commands will be different for the Mac and Windows operating system in which case both will be

shown.

This manual lists the default behaviour of the keyboard shortcuts when the Revoice Pro 3 Shortcut set is

selected.

Terminology and symbols
1. Keyboard letters are shown in the charts in this section as Upper Case (capital letters) to match

what is shown on a keyboard. However, these key commands must be entered as lower case

(not capital letters).

i.e. the SHIFT KEY should never be pressed in a command unless it is explicitly indicated.

2. For the Mac OS, in the charts below:

3. The definition of a "Swipe" operation in a few descriptions below depends on the input device used

(e.g. mouse, track ball, track pad, magic mouse, etc.). For example, a typical mouse "swipe" = Shift with

scroll wheel.

Topics in this section:

Customising keyboard shortcuts

Screen Display and Position Controls

Play, Process and Mixer Controls

Match and Doubler Track Solo Enable Keys

Track Controls

Editing Tool Selector

Operations on Output Pitch, Time, Level values

File Menu Commands

Edit Menu Commands

= CMD
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Tracks Menu Commands

Revoice Pro Menu Commands

Next
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10.1. Customising keyboard shortcuts

Keyboard shortcuts and operations summary » Customising keyboard shortcuts 

This video gives an example of how to customise Keyboard Shortcuts.

Keyboard shortcuts can now be customised using the Keyboard Shortcuts menu shown below.

The following screen will be shown

https://www.synchroarts.com/videos/how-to-create-keyboard-shortcuts
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This manual lists the behaviour of the keyboard shortcuts when the Revoice Pro 3 Shortcut set is

selected.

macOS
To display the keyboard short cut screen Revoice Pro needs to open a network connection. When you

start Revoice Pro you may see the following screen:
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You should press Allow.

Windows
To display the keyboard short cut screen Revoice Pro needs to open a network connection. When you

start Revoice Pro you may see the following screen:

You should press Allow access
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10.2. RePitch Shortcut Set

Keyboard shortcuts and operations summary » RePitch Shortcut Set

In Revoice Pro 5, a RePitch keyboard shortcut set is provided for use when the user intends to do

intensive pitch and time editing via the Adjust Region functionality.

The Repitch keyboard shortcut set can be accessed in the Keyboard Shortcuts menu by clicking the

dropdown menu in the top left.

Please note that this shortcut set does take over some of the keyboard shortcuts used by Revoice Pro 5,

which will not be available when the RePitch set is selected. For this reason, we suggest using this set

only when a more substantial amout of time will be spend making Adjust Region modifications.

Next
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10.3. Screen Display and Position Controls

Keyboard shortcuts and operations summary » Screen Display and Position Controls 

Next
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ACTION DESCRIPTION MAC Keys Windows Keys
Zoom display time out R or CMD [ R or CTRL [

Zoom display time in T or CMD ] T or CTRL ]

Zoom display time in to show All of session

(This does not work when a Match process is selected)
ALT A
(or Option A)

ALT A

Scrolls pitch display (if any) up and down

Swipe up/down
OR
Mouse Wheel up/down
with cursor in track area
(Disable Track Scroll Wheel
in Preferences disables this)

Scrolls track display up and down

Swipe up/down
OR
Mouse Wheel up/down
with cursor outside track area
(or anywhere, if Disable Track Scroll Wheel
is checked in Preferences)

Scrolls timeline (horizontal scroll bar) right or left Swipe left/right
Step Playhead left to next time-line event Up Arrow
Step Playhead right to next time-line event Down Arrow
Moves Playhead left and reverse plays audio Left Arrow
Move Playhead right and forward plays audio Right Arrow
Move Playhead to start of audio in Session Home
Move Playhead to end of audio in Session End
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10.3.1. Scrolling the display

Keyboard shortcuts and operations summary » Screen Display and Position Controls » Scrolling the

display 

From version 3.1 onwards, the scroll control (mouse wheel, two-fingered vertical swipe, etc) scrolls the

pitch display on a track where this is active. SHIFT-scrolling scrolls the entire track display.

 

Next 
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10.4. Playback, Duplicate and Process Controls

Keyboard shortcuts and operations summary » Playback, Duplicate and Process Controls 

 

Next 
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ACTION DESCRIPTION MAC Keys Windows Keys
Start or Stop Playback and Auto Render
(i.e. run all processes if required) before starting playback

Space Bar

Open or close a selected Processes' Control Panel P
Scrub playback head (left / right) through audio ALT with Swipe

Left/Right
OR
Hold down left
click on Playback
head

CTRL with Swipe
Left/Right
OR
Hold down left
click on Playback
head

Duplicate and Drag an existing Process
Left click in a Process Control Block and hold mouse button down
and drag: This will duplicate all Processing Elements and can drag
Process outline to new positions.

ALT
Left click

CTRL
Left click

Duplicate and drag Audio or Tracks Control Panel
· In Audio waveform:- Render audio (if required) and

start an audio file Drag and Drop operation.
· In Track Control panel:- Copy new track panel (not

audio) under current track or new mouse position.

ALT Shift
Left click

ALT Shift
Left click

Run all Processes (i.e. Render Output audio) CMD R ALT R
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10.5. Match and Doubler Track Solo Enable Keys

Keyboard shortcuts and operations summary » Match and Doubler Track Solo Enable Keys 

* NOTES

1. If [ALT] is pressed with above keys, any other Soloed tracks in Session will not be disabled.

2. Solo Enable Keys also disables Mute (if enabled) on selected track(s).

Next
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Match Process - Solo
Controls for selected Process

Doubler Process - Solo
Controls for selected Process

KEYS

Solo Guide track * Solo Input track * G
Solo Dub track * (no action) D
Solo Aligned (Output) track * Solo Output track * A
Solo Guide and Aligned (Output) tracks * Solo Input and Output tracks * E
Solo Guide and Dub tracks * (no action) F
Solo Dub and Aligned (Output) tracks * (no action) S
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10.6. Track Controls

Keyboard shortcuts and operations summary » Track Controls

Next
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ACTION DESCRIPTION MAC
Keys

Windows
Keys

Add New Track (below last track in Session) Shift
CMD N

Shift CTRL
N

Alter height of ALL tracks together Shift and Drag Track
Dividers

Toggles Track Solo On and Off Left Click

or
Toggles Track Mute On and Off Left Click

or
Toggles Solo Exclusively On and Off
(when On - no other tracks are soloed)

ALT
Left click

or

CTRL
Left click

or

Toggles Solo on numbered Tracks 1, 2, 3,...to 9
Toggles Solo on Track 10

1, 2, 3,... to 9
0

If ALT  is pressed with numeric keys 1 to 0, it provides Exclusive Solo
(no other soloed tracks) for selected track number 1 to 10.

ALT
with 1, 2, 3, ... to 9, 0

If CMD (Mac) / CTRL (Windows) is pressed with numeric keys, it
toggles Mute for selected track number 1 to 10.

CMD
with 1,2,
3,
... to 9, 0

CTRL
with 1,2, 3,
... to 9, 0
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10.7. Editing Tool Selector

Keyboard shortcuts and operations summary » Editing Tool Selector

When editing pitch and time values, such as in Warp or Match process outputs, the following keys select

the various editing tools:

 

Next 
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ACTION DESCRIPTION KEYS
Choose Selector tool O
Choose Cutter tool I
Choose Join tool J
Choose Smooth Join tool M
Choose Draw tool L
Choose Correct Pitch tool K
Choose Warp Point tool .
Switch between Pitch and Level editing (Manual Warp function only) S
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10.8. Operations on Output Pitch, Time, Level values

Keyboard shortcuts and operations summary » Operations on Output Pitch, Time, Level values 

The Match and Adjust processes produce displays of points showing the measurements of pitch, level

and time. These measurement points are often automatically grouped together (for example, as notes)

for ease of manipulation. The operations listed below are for manipulating the displayed measurement

points and groups of points.

 

Next 
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ACTION DESCRIPTION KEYS
Select or deselect points and groups Mouse left click
Creates collection of groups or points starting at the currently
selected point or group to the new clicked point or group.

Shift
Mouse left click

Will stretch or compress the group (or collection). left click and drag Group
Edge

Will move the group (or collection) unless restricted by H or V
locks.

left click and drag
Group Centre

Will tilt the group (or collection) around a (displayed) anchor point (Mac) ALT
Left click and drag Group
Edge
(Windows) left click Group
Edge, then press and hold
CTRL
Then drag Group Edge

Toggle locking/unlocking Horizontal movements of groups or
points (locking stops making time adjustments)

H

Toggle locking/unlocking Vertical movements of groups or points
(locking stops making pitch or level adjustments)

V
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10.9. File Menu Commands

Keyboard shortcuts and operations summary » File Menu Commands 

File Menu Commands

Next
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ACTION DESCRIPTION MAC Keys Windows Keys
Open New Session CMD N CTRL N
Open existing Session from file system CMD O CTRL O
Close selected Session CMD W (none)
Save selected Session CMD S CTRL S
Save selected Session AS ... Shift CMD S (none)
Open Export Audio controls CMD E CTRL E
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10.10. Edit Menu Commands

Keyboard shortcuts and operations summary » Edit Menu Commands 

Next 
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ACTION DESCRIPTION MAC Keys Windows
Keys

Undo Last Operation (where implemented) CMD Z CTRL Z
Redo Last Operation (where implemented) Shift CMD Z CTRL Y
Cut selected Audio CMD X CTRL X
Copy: selected Item(s) including:

· Audio
· Selected process values
· Process control settings
· Time, Pitch and Level control points and groups
· Text

CMD C CTRL C

Copy Selected Process Output Shift CMD OShift CTRL O
Copy All Process Outputs Shift CMD L Shift CTRL L
Paste: selected Item(s) that have been copied using CMD C (as
listed above)

CMD V CTRL V

Paste: Quick Match Shift CMD A Shift CTRL A
Paste: Quick Doubler Shift CMD DShift CTRL D
Paste: Quick Adjust Shift CMD

W
Shift CTRL
W

Delete selected Audio Backspace Delete

Toggle New Process Control Panel
Open / Close

B

Create New Process (using settings in New Process Control Panel
and selected audio).

N
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10.11. Tracks Menu Commands

Keyboard shortcuts and operations summary » Tracks Menu Commands 

Next 
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ACTION DESCRIPTION MAC Keys Windows Keys
Add Audio Track(s) CMD Shift N CTRL Shift N
Show Selected Process Tracks Only Z
Show All Tracks X
Toggle: Show / Hide Processing Displays C
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10.12. Revoice Pro Menu Commands

Keyboard shortcuts and operations summary » Revoice Pro Menu Commands 

Next 
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ACTION DESCRIPTION MAC Keys Windows Keys
Display Preferences CMD , (none)
Hide Revoice Pro CMD H (none)
Hide other programs ALT CMD H (none)
Close Revoice Pro CMD Q ALT F4
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11. Release Notes
Release Notes 

Toggle navigation

Revoice Pro 4.3 Help
·

· Contents

· Index

· Search

This is a detailed list of the changes in Revoice Pro 4 from Revoice Pro 3.3

Minimum Operating system

· maxOS 10.7 

· Windows 7

Plug-ins

· ARA 2 support in VST plug-ins. Works with Studio One 4 and Reaper

· Plug-ins can start the Revoice Pro application. (All except Audiosuite in Pro Tools 10 and earlier)

· If you have more that 2000 ARA plug-ins an a DAW, Revoice Pro may run out of file handles.

(No yet fixed)

· Adding ARA plug-in to a track in Reaper while playing, plug-in is not fully initialized until you stop

playing in Reaper. (Not yet resolved)

General 

· Modified colours for pop-up sliders and playback areas

· Modified Revoice Pro logo on main screen and plug-ins

· Flat Line Audio mode - If you zoom out on Y scale at the last position the audio is replaced with a

line.

Process Control Panels 
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· Default values displayed on control sliders. Pressing the ALT key with the mouse presses sets

the default value.

· Recently Used Presets

Pitch & Level Display 

· Cursor not changing if the track is locked. Fixed

· Initial Pitch and level values displayed in Warp and Match

· Draw Tool - After drawing note average value is recalculated

· Transitions between notes are now draw as continuous lines

· When editing note pitch as you drag below C the wrong octave is displayed. Fixed.

· Pitch Grid - faster drawing of the labels.

· macOS - Gestures - pitch zoom sensitivity reduced by factor of 4

· Don’t draw initial pitch & level values if X zoom is less that 0.0002 - this is to keep the drawing

speed up.

· Original pitch traces now not draw connecting lines between groups.

· Faster pitch/level adio drawing.

macOS - Preferences Window 

· Defaults to a size which is large enough to show the temporary file locations controls.

Session File 

· Faster Save & loading of sessions. Revoice Pro 4 sessions are not backward compatible with

Revoice Pro 3. (Verison 4 will open verison 3 sessions.)

· If version 3 has an untitled document opened, then start V 4 - the auto restore code loads the

untitled version 3 document. If we try and lock the document we get an exception. Fixed

Studio One 3.5

· Changes in Studio One 3.5 copy & paste causes errors - Fixed.

· Support for layers in Studio One 3.5.1 (In copy and paste)

· Studio One Copy/Paster - undo bug fix

Studio One 4 ARA2

· Studio One ARA - use Draw tool - track updates while still drawing may cause flash from

ExportAudio progress dialogue box. Fixed
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· Studio One ARA - use strip silence on audio region - our sync processes repeatedly updates

tracks. - Fixed

Logic Pro X

· Crash in Logic caused by Revoice Pro Link fixed

Pro Tools

· Rare problem with link modules in Pro Tools not connecting to Revoice Pro - fixed.

Tracks & Groups

· Shift click on Show Processes in Track Info applies to all tracks.

· Track Info - you can now change the width of this area

· Group Area - you can now change the width of this area

· Drag and drop importing of word timing files created by https://www.speechmatics.com

· Marker area - New Word from selected Playback Range

· ALT key + vertical scroll wheel will zoom the horizontal axis. (Works well with track balls)

· One or more tracks can now be selected using the mouse and the cmd and shift keys

· Delete multiple selected tracks.

· When in Single track display mode, you can switch between tracks using Shirt + down arrow and

shift + up arrow

· u key - Display only selected tracks. Of one track is selected show in full height mode. If press

with only selected tracks displays switch back to showing all tracks.

· Reduce height of words and process input bars when track height are small.(Process Settings

and lock buttons removed at small heights.)

· New track name dialogue wider text

· Exclusive solo selected track - does not seem to be exclusive. Fixed

· Auto size track heights switch off at 5% of space per track was 10%.

· Y Scale control - Set Automatically option added - this set the Y scale automatically. If you select

one of the other values it is fixed and has to be manually changed.

· Y Axis view areas Time & Pitch label not drawn across two lines - pitch is truncated. Fixed

· Context menu on track group area to show management panel. Panel can be resized.

· Drag and drop tracks to Track groups window to create or add to groups.

· Crash when creating groups if Process Create panel is displayed. Fixed.
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File Menu

· Save Copy In added to file menu, saves a copy of the session and collects all audio files into one

folder.

Help 

· Link to DAW page in Revoice Pro help menu

· New help system, a pdf version of the help is now available.

Warp Process

· Change pitch limit - undo - then re-do caused crash. Fixed

· Edit notes using warp process, change the level, undo the level change, edits are lost. (Need to

store latest editing points when applying level change.) Fixed

· Reset Tool in warp context menu. (Reset Selected Values removed from Modified Values)

· Pitch limits can now be changed part way though a warp process.

· Pitch Limits - If you join pitch limit zones a warning is displayed about edit loss.

· Display New Process - pressing space key causes Crash in warp process Fixed.

· Warp and Match Copy pitch profile - not working - Fixed

· Warp Process - Edit notes just using arrow keys

Left / right moves between notes

Shift + left/right extends the selection

Up / down moves 1 cent

Shift Up / Down 10 cents

ALT Up / Down 1 Semi tone

/ play selected notes 

· Delete warp point under mouse  (Shift ALT D)

· Add warp point at mouse as a keyboard shortcut (Shift ALT A)

· Warp Process - Changed anchor for note edge when editing, allows note envelope height to be

changed without moving the pitch centre. Anchor on pitch centre is now the default.

· Correct Pitch tool controls being displayed with left side off screen - fixed

· Vibrato Warp Points 

· Fixed Warp Points

· Warp point speed ramps

· Erratic behaviours when moving notes and level blocks fixed.

· Copy audio when warp process selected - paste back into RVP causes crash. Fixed
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· Position of Pitch label modified - now defaults to top centre.

· Pitch correction window, losses blue border if you change the pitch threshold in the setting

panel. Fixed

· Correct pitch background colour and frame changed.

Match Process

· Match Tolerance automation curve shows % now in mS

· Match - Pitch offset now in cents +/- 1200 rather than +/1 50% (Which was .5 to 1.5 * frequency)

· Match Music Mode - separates the long term average of the note from the short term variation of

the pitch. This allows the performance to be tuned without effecting the dub characteristics.

· Match Music Mode - pitch is segmented using the same method as the warp process.

· Match Music Mode - pitch correction to grid added to pitch output.

· Match Guide pitch displayed in Dub track (in red)

· Waypoints removed from Match

· Guide / Dub energy display new design

· Match View controls in right properties panel - settings effect all processes. Display and editor

controls removed from process settings panel.

· Preset tool tip - display Preset at the start of the name - Fixed

· Dub pitch sibilance colour is confused with guide pitch - Fixed

· X Fade added to protected area display when protecting pitch.

· User edits lost in the output of a Match if the guide or dub tracks use a Warp process when the

session is loaded from a file. Fixed 

· Match crash if protected area outside process limits

· New presets for Match music mode

Analyser Process

· When Analyser display is selected - cannot change scale - Fixed

Playing

· ctrl+shift+y creates playback range from selected audio and plays from start of area

· ctrl+y creates playback range from selected audio

· Play from current position into play area, on space key. Shift space is the old action.
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· Faster start of playback after you change a processing parameter.

· If playing - try zooming using ALT key + scroll wheel - audio keeps jumping back to start

location. Fixed

Keyboard

· Keyboard shortcuts can now be modified

· Commands to Sole - Exclusive Solo and Mute selected tracks (Commands not assigned to a key

stroke.)

General Bugs

· Copy audio from Revoice, paste back into Revoice crash. Fixed

· Windows - Delete track - then undo delete caused error - Fixed

· Crash when running OS X 10.8 or earlier. Fixed

· Audio display not working when zoomed into waveform Fixed

· Graphic update speed problem found on Retina screens now fixed - Drawing is much faster.

· Volume process bug fixes

Copy Protection

· Support for iLok Cloud

· No longer supports iLok 1
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